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Technical Support
Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. The Technical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, the Technical Support group works with Product Engineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right
amount of service for any size organization

■ Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers software upgrades

■ Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site
at the following URL:

www.symantec.com/business/support/

All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support
Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level

www.symantec.com/business/support/
www.symantec.com/business/support/


■ Hardware information

■ Available memory, disk space, and NIC information

■ Operating system

■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and support contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs or manuals
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Support agreement resources
If you want to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

customercare_apac@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America

mailto:customercare_apac@symantec.com
mailto:semea@symantec.com
mailto:supportsolutions@symantec.com
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Introducing IT Management
Suite

This chapter includes the following topics:

■ About IT Management Suite

■ What's new in IT Management Suite

■ Solutions of IT Management Suite

■ Components of the Symantec Management Platform

■ Where to get more information

About IT Management Suite
IT Management Suite combines client and server configuration management with
IT asset and service management. It promotes effective service delivery and helps
reduce the cost and complexity of managing corporate IT assets. These assets
may include desktops, laptops, thin clients, and servers in heterogeneous
environments running Windows, Linux, UNIX, and Mac. You can manage all of
the features of the suite through a central console on a common platform: the
Symantec Management Platform. This common platform integrates management
functions to accelerate automation for better service, value, and IT efficiency.

IT Management Suite is comprised of the following management capabilities:

■ Server management
The server management capabilities support not only the Windows operating
system, but also the UNIX and the Linux operating systems. In addition, the
same management disciplines are applied to both physical systems and virtual
systems, including both Microsoft Hyper-V and VMware.
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■ Client management
The client management capabilities support Windows and a growing number
of other platforms, including Mac OS and Linux operating systems.

■ IT asset management
IT asset management builds upon solid inventory foundations for configuration
management. It helps you accurately value both your discoverable and
non-discoverable assets, and track your assets and your asset-related
information. You can manage contracts, software license compliance, and
procurement processes as well as the configuration items that are associated
with your assets.

■ Service management
IT Management Suite includes fully featured service management capabilities.
It provides the necessary components for any ITIL-based service management
initiative and covers key functions. These functions include incident and
problem management, change management, self service options, and a service
catalog.

What's new in IT Management Suite
In addition to full server-side 64-bit support, IT Management Suite includes many
new features. The new workflow engine lets you automate human and system
interactions to help you complete the sequential tasks that are required for
efficient service management. Imaging, deployment, and remote control features
are now integrated. The central catalog, the software library, and the new user
views deliver a deeper functional integration. New IT Analytics capabilities and
the central Software Catalog provide greater intelligence.

The following are some of the key new features in IT Management Suite:

■ Intuitive management interface
IT Management Suite 7.1 introduces an improved management interface that
gets you where you want to be faster. The page load times are shorter and are
more responsive. Common concepts such as managing computers, delivering
software, and managing licenses and deployment are consolidated into an
integrated experience. When you click on a computer, resource management
details are immediately visible. Powerful search features help you drill down
and build filters in a short period of time. You can quickly save the searches
for future use. Drag-and-drop functionality lets you select tasks and drag them
to one or more selected computers.

■ Streamlined software management
The Software Catalog interface is streamlined and redesigned. Any software
that is found is stored in the newly discovered list. From this list you can
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quickly determine whether you want to make the identified software a managed
product. If not, you can assign it to unmanaged software. After you identify
software as a managed software product, you can manage all elements of it in
a single interface. Inventory, metering, delivery, and license tracking are all
presented in a single interface.
In addition to improvements in the Managed Delivery interface, the Managed
Delivery feature is more robust. The Managed Delivery feature now separates
the schedule for delivery and the schedule for execution. You can first stage
packages in advance, and then later schedule the execution.

■ Simplified license management
License management and asset management and usage are tightly integrated.
Within the software display is an at-a-glance view of the current deployments
and cost details. These details are based on the current installations and the
purchasing details. A graphic can help you to determine if a software product
is over-deployed or under-deployed, and evaluate its current usage. It gives
visibility into the financial effect of a product. You can see the potential savings
from harvesting licenses, and you can see the cost effect when a product is
over-deployed.

■ Advanced reporting and IT Analytics
The executive dashboard and trend analysis give you a representative view of
your IT assets. Key performance indicators let you measure critical success
factors for your organization and quickly assess trends of how these measures
change over time. You can use ad-hoc data mining to construct pivot table
reports. The reports are based on predefined measures and dimensions. The
functionality allows for easy manipulation of the data so you do not have to
be a SQL expert to access the information you need. Multidimensional analysis
and robust graphical reporting are incorporated to help you arrive at your
answers with very little customization and without waiting.
The MultiCMDB feature provides global IT Analytics reporting across multiple
CMDBs without the need to replicate large amounts of data.

■ Optimized scalability and performance
This release increases the overall scalability of the Symantec Management
Platform. Each Notification Server computer now scales to support more
endpoints than the previous versions supported. The overall goal is to
streamline your implementations by using less hardware. In addition to
numerous improvements in overall performance, the two key changes are to
user interaction and to reporting. With the new management interface, page
loads are significantly improved. The advanced IT Analytics features let you
gain the efficiency of OLAP cubes. The features create faster reporting times
by off-loading report data from the operational database.

■ Microsoft Windows 7 application compatibility challenges addressed
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A key challenge to moving to Windows 7 is that many legacy Web applications
depend on Internet Explorer 6. Symantec Workspace Virtualization includes
a new update that solves this challenge. You can virtualize Internet Explorer
6 directly in Windows 7. This ability lets you concurrently run Internet Explorer
6, 7, and 8. You can also run multiple Java versions on the native operating
system to achieve normal visibility.
This approach enables side-by-side usage, and offers a secure implementation
that is invisible to the user. You can determine which applications should have
access to that specific browser. Users are never prompted to choose a browser.
The correct version automatically opens for them based on policy. This option
helps you move faster and more efficiently to Microsoft Windows 7. Browser
plug-ins such as Acrobat and Flash can be installed into the base or into a
virtual layer. Multiple Java versions can be installed in the base, or in a layer,
and used by a virtual Internet Explorer. Workspace Virtualization automatically
supports any group policy objects that your enterprise may have in place for
Internet Explorer.

■ Built-in process automation
Workflow capabilities are now included so you can automate the processes
that are core to your IT business. In addition to form builders and
drag-and-drop process designer capabilities, you can use the full component
generator capability for access to third-party technologies. These technologies
include HR or finance systems, and the Workflow portal. The Workflow portal
lets you track the overall process as a workflow moves through the various
stages.

■ Migration and deployment enhancements
Deployment Solution is now natively integrated with the Symantec
Management Platform. Consequently, you work with Deployment Solution
and Symantec Management Platform through a single console, database, and
agent. IT Management Suite 7.1 provides many enhancements to the
Deployment Solution console.
The DeployAnywhere capability supports all plug-and-play driver types for
hardware-independent imaging. This addition complements the support for
hardware abstraction layers (HAL), network interface cards, and
mass-storage-controller drivers to provide a complete hardware-independent
imaging solution. Management for the driver database is now available through
the console. You can consolidate driver management because both imaging
and scripted operating system installations consume the drivers in the
DeployAnywhere database.
Ghost imaging supports the familiar style of RapiDeploy multicasting. PC
transplant supports Microsoft Office 2010 (32-bit and 64-bit).
Enhanced Virtual Machine Management capabilities streamline configuration
and extend the virtual machine creation wizard. The wizard can execute any

Introducing IT Management Suite
What's new in IT Management Suite

16



Deployment Solution job as part of the virtual machine creation process. This
ability lets you leverage existing server provisioning jobs and apply them to
virtual server provisioning.

Solutions of IT Management Suite
IT Management Suite includes many solutions and components.

Table 1-1 IT Management Suite 7.1 solutions and components

Solution/ComponentSuite/Platform

Includes the components such as Network Discovery, Notification Server, Symantec
Management Console, and Symantec Management Agent

■ Symantec Workflow Solution 7.1

■ IT Analytics 7.1

Symantec Management
Platform 7.1

■ Asset Management Solution 7.1

■ Barcode Solution 7.1

■ CMDB Solution 7.1

Asset Management Suite 7.1

■ Deployment Solution 7.1 SP1 with a license for 6.9 SP5

■ Inventory Solution 7.1

■ IT Analytics Client and Server Pack 7.1

■ IT Analytics SEP Pack 7.1

■ Out-of-Band Management Component 7.1

■ Patch Management Solution 7.1

■ pcAnywhere Solution 12.6

■ Real-Time System Manager 7.1

■ Software Management Solution 7.1

■ Symantec Endpoint Protection Integration Component 7.1

■ Wise Connector 7.1

■ Workspace Virtualization 7.1

■ Wise Connector 7.1

Client Management Suite 7.1
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Table 1-1 IT Management Suite 7.1 solutions and components (continued)

Solution/ComponentSuite/Platform

■ Deployment Solution 7.1 SP1 with a license for 6.9 SP5

■ Inventory Solution 7.1

■ Inventory Pack for Servers

■ IT Analytics Client and Server Pack 7.1

■ IT Analytics SEP Pack 7.1

■ Monitor Pack for Servers 7.1

■ Monitor Solution 7.1

■ Patch Management Solution 7.1

■ Real-Time System Manager 7.1

■ Software Management Solution 7.1

■ Symantec Endpoint Protection Integration Component 7.1

■ Virtual Machine Management 7.1

■ Wise Connector 7.1

Server Management Suite 7.1

■ Symantec ServiceDesk 7.1

■ IT Analytics ServiceDesk Pack 7.1

Other

See “About IT Management Suite” on page 13.

Components of the Symantec Management Platform
The Symantec Management Platform includes the following core components:

■ Notification Server
The Symantec Management Platform service that processes events, facilitates
communications with managed computers, and coordinates the work of the
other Symantec Management Platform services.

■ Symantec Management Console
A Web-based user interface that lets you monitor and manage Notification
Server and its solutions.

■ Configuration Management Database (CMDB)
The database that stores all of the information about managed computers.

■ Site servers
The Symantec Management Platform can host several types of middleware
components, such as package servers and task servers. The official name for
a middleware component is "site service." Any component that hosts a site
service is known as a site server.

Introducing IT Management Suite
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■ Symantec Management Agent
The software that is installed on a computer to enable Notification Server to
monitor and manage it. After the Symantec Management Agent is installed,
that computer becomes a managed computer.

■ Software Management Framework
An interface that lets you create and manage the software resources that are
in the Software Catalog. It also lets you manage the packages that are in the
Software Library. The Software Catalog page provides a central location for
initiating the software-related tasks that are performed in your organization.

■ Reports
A way to gather automated information. You can view reports for any managed
computer from the Symantec Management Console.

Note: Symantec Management Agent was formerly called Altiris Agent, and
Symantec Management Console was formerly called Altiris Console. The Data
Connector Solution is also now part of the Symantec Management Platform.

Where to get more information
Use the following documentation resources to learn about and use this product.

See “About IT Management Suite” on page 13.

Table 1-2 Documentation resources

LocationDescriptionDocument

The Product Support page, which is available at the following URL:

http://www.symantec.com/business/support/all_products.jsp

When you open your product's support page, look for the
Documentation link on the right side of the page.

Information about new
features and important
issues.

Release Notes

■ The Documentation Library, which is available in the Symantec
Management Console on the Help menu.

■ The ProductSupport page, which is available at the following URL:

http://www.symantec.com/business/support/all_products.jsp

When you open your product’s support page, look for the
Documentation link on the right side of the page.

Information about how
to use this product,
including detailed
technical information
and instructions for
performing common
tasks.

User guides
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Table 1-2 Documentation resources (continued)

LocationDescriptionDocument

The Documentation Library, which is available in the Symantec
Management Console on the Help menu.

Context-sensitive help is available for most screens in the Symantec
Management Console.

You can open context-sensitive help in the following ways:

■ The F1 key when the page is active.

■ The Context command, which is available in the Symantec
Management Console on the Help menu.

Information about how
to use this product,
including detailed
technical information
and instructions for
performing common
tasks.

Help is available at the
solution level and at the
suite level.

This information is
available in HTML help
format.

Help

In addition to the product documentation, you can use the following resources to
learn about Symantec products.

Table 1-3 Symantec product information resources

LocationDescriptionResource

http://www.symantec.com/docs/HOWTO32608Compilation of "how to"
and best practice articles
for IT Management
Suite.

Best practices
Support
Knowledgebase

http://www.symantec.com/business/theme.jsp?themeid=support-knowledgebaseArticles, incidents, and
issues about Symantec
products.

SymWISE
Support
Knowledgebase

http://www.symantec.com/connect/endpoint-managementAn online resource that
contains forums, articles,
blogs, downloads, events,
videos, groups, and ideas
for users of Symantec
products.

Symantec
Connect

Introducing IT Management Suite
Where to get more information

20

http://www.symantec.com/docs/HOWTO32608
http://www.symantec.com/business/theme.jsp?themeid=support-knowledgebase
http://www.symantec.com/connect/endpoint-management


Overview of migrating to IT
Management Suite

This chapter includes the following topics:

■ About this migration guide

■ How to use this guide

■ Recommended reading

■ About product parity between versions 6.x and 7.1

■ About migrating to Symantec Management Platform 7.1

■ About reusing existing hardware to migrate

About this migration guide
This guide is intended to help you upgrade and migrate your infrastructure to
version 7.1.

The guide includes information about the following categories of information:

■ Migration wizard instructions
This release includes a tool that is called the migration wizard. Migration
wizard is designed to automate the gathering of data from your previous system
so you can bring it into your new system. When you run the wizard, it gathers
this data and stores it in a file. After you install version 7.1 you can use the
wizard to import the data in this file into your new system.
See “About data migration” on page 49.

■ Manual data migration instructions
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Some data is not stored in your current installed database. The data migration
wizard is unable to locate and migrate this data. You must manually copy this
data from its previous location to its new equivalent location. After the data
has been moved there may be additional steps you must take to make that data
function in your new environment.
See “About the 6.x data that you must manually migrate to Symantec
Management Platform 7.1” on page 61.

Note: Notification Server was renamed Symantec Management Platform (SMP)
on December 03, 2010. All previously categorized articles and references that are
listed as Notification Server are now found under Symantec Management Platform.
This document lists all Notification Server references for 7.1 as Symantec
Management Platform. It lists version 6.0 of the comparable architectural objects
by their previous names (Notification Server 6.0, etc.)

See “How to use this guide” on page 22.

See “Recommended reading” on page 23.

How to use this guide
This guide is intended to create a plan to migrate your infrastructure to version
7.1. This guide covers specific migration functions you need to follow for migrating
data from older version of Altiris products.

In addition to this guide, you can use the following guides to help you migrate to
IT Management Suite 7.1:

■ IT Management Suite Planning and Implementation Guide 7.1

■ Symantec Management Platform 7.1 MP1 User Guide

■ Solution-specific user guides

See “Where to get more information” on page 19.

Each of the guides plays an important role in the migration process, and this guide
references them and is a complement to them.

Many of the topics in the listed guides are not duplicated in this migration guide.

See “Recommended reading” on page 23.

Overview of migrating to IT Management Suite
How to use this guide
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Recommended reading
Before you start the migration process it is important to create a plan to migrate
your infrastructure to version 7.1.

The IT Management Suite Planning and Implementation Guide v7.1 contains
migration information about prerequisites, infrastructure architecture,
performance tuning, and the installation:

■ Prerequisites
As you develop your migration plan and before you attempt a migration, you
should understand migration concepts. For example, you use the Symantec
Installation Manager to access the migration wizard tool. This tool is made
available to you when you complete a new installation of IT Management Suite.
You can then copy the tool to your previous server to use it to harvest previous
data.
This process works well if you use new hardware to host your new environment.
However, if you attempt to reuse previous hardware, then you must access the
migration wizard tool before you install IT Management Suite. At actual
installation time, your previous Notification Server no longer exists because
it was reconfigured with a 64-bit operating system.

■ Infrastructure architecture
You must determine the best means to upgrade your specific infrastructure.
Infrastructure components can include items such as agents, sub-agents,
package servers, and task servers. The decisions you make for upgrading
infrastructure components are dependent on your specific scenario. The means
that you employ may also depend on the limitations of your IT policies or
limitations of your network infrastructure.
For example, if your organization has many managed computers, you may not
want to immediately enable many management settings during a large agent
migration. By not enabling the settings, you reduce the initial load on your
Notification Server when the agents initially check in and begin the upgrade.
However, after the agents have been successfully migrated, you can then
increase the amount of management operations according to your migration
plan.
You can use your previous 6.x Notification Sever to force managed computers
to report to your new 7.1 Notification Server. However, if your previous
Notification Server is not available at the time you choose to migrate your
managed computers, then you cannot leverage this method of agent migration.

■ Installation
You must complete a new IT Management Suite installation regardless of the
migration path that you choose. IT Management Suite 7.1 requires a 64-bit
operating system, but its previous versions did not run on a 64-bit operating
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system. There is no automated way to upgrade your existing IT Management
Suite 32-bit installation. For example, if you intend to reuse existing 64-bit
capable Notification Server hardware, you must install the 64-bit operating
system first. The IT Management Suite Planning and Implementation Guide
7.1 contains the steps to install IT Management Suite.

You must make similar considerations when you upgrade agents.

See “About this migration guide” on page 21.

See “How to use this guide” on page 22.

About product parity between versions 6.x and 7.1
In IT Management Suite 7.1, some products are replaced or absorbed by another
product, or have a new product name. When you install IT Management Suite,
you must install at least the same equivalent products that you installed on the
6.x Notification Server.

Table 2-1 6.x to 7.1 Product parity

Comments7.1 equivalent product6.x product

Inventory for Network
Devices is now part of
Inventory Solution.

See “About migrating to
Inventory Solution 7.1 with
Symantec Notification Server
Migration Wizard”
on page 70.

InventoryInventory for Network
Devices

Application Metering is now
part of Inventory Solution.

See “About migrating to
Inventory Solution 7.1 with
Symantec Notification Server
Migration Wizard”
on page 70.

InventoryApplication Metering

IT Analytics Reporting Pack
is now part of the Symantec
Management Platform.

Symantec Management
Platform

IT Analytics Reporting
Pack

Overview of migrating to IT Management Suite
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Table 2-1 6.x to 7.1 Product parity (continued)

Comments7.1 equivalent product6.x product

Workflow Management is
now part of the Symantec
Management Platform.

The full Workflow
Management product is part
of the Symantec Platform
installation and is available
to all customers.

Symantec Management
Platform

Workflow

Carbon Copy users are
entitled to pcAnywhere.

pcAnywhereCarbon Copy

Software Delivery is now
called Software Management.

Software ManagementSoftware Delivery

Application Management is
part of Software
Management.

Software ManagementApplication Management

ServiceDesk does not
upgrade or install over
Helpdesk Solution.

See “About migrating from
Helpdesk Solution 6.x”
on page 191.

ServiceDeskHelpdesk

Mobile Management Solution
is not a part of IT
Management Suite 7.1.

Handheld Management users
are not entitled to Mobile
Management 7.1.

See “About migrating Mobile
Management Solution”
on page 187.

See “Further information
about Mobile Management
Solution ” on page 187.

Mobile ManagementHandheld Management
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Table 2-1 6.x to 7.1 Product parity (continued)

Comments7.1 equivalent product6.x product

The VirtualCenter options
that were part of Deployment
Solution 6.9 are now part of
Virtual Machine
Management.

Virtual Machine ManagementVirtualCenter options

Workspace VirtualizationSoftware Virtualization

See “Solutions of IT Management Suite ” on page 17.

About migrating to Symantec Management Platform
7.1

Symantec Management Platform 7.1 requires the Microsoft Windows Server 2008
R2 (64-bit) operating system to host Notification Server. Because Notification
Server 6.x used a different operating system than Windows Server 2008 R2, you
cannot do an automated, on-box upgrade to 7.1.

For more information, see topics on system requirements in the IT Management
Suite Planning and Implementation Guide.

Note: If you have Notification Server 6.x installed on a 64-bit server, you can
install the Symantec Management Platform 7.1 products on that computer.
However, before you install the Windows 2008 R2 operating system, you must
complete specific migration steps. Because some of these migration steps might
not complete successfully, Symantec discourages the reuse of the current server.
For more information about installing the Symantec Management Platform 7.1
products on your current server, see HOWTO32427.

When you migrate to Symantec Management Platform 7.1, you have to create a
new database. However, you can migrate a lot of the data that is in your 6.x
Notification Server Database although some of the migrated data is read-only.
You can also migrate data that is not in the database.

See “About data migration when migrating from Notification Server 6.x”
on page 50.

For more information, see the documents at https://www-secure.symantec.com/
connect/articles/altiris-endpoint-management-migrations-and-upgrades-71.
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Note: Symantec Management Platform 7.1 does not support a mixed mode of
Notification Servers. A 6.x Notification Server cannot communicate with a 7.1
Notification Server.

The migration process consists of the following phases:

■ Prepare
To minimize downtime and ensure success, use the documentation to create
a migration plan for your specific environment. Back up your existing data
and create a test environment for evaluating and validating the entire
installation and migration process. Symantec recommends that you maintain
the test environment for ongoing validation and testing of updates,
maintenance packs, and service packs.

■ Install and migrate
During this phase, you install Symantec Management Platform 7.1 on a
computer running the Windows 2008 R2 operating system. You also migrate
existing Notification Server 6.x data from your previous environment to
Symantec Management Platform 7.1. You may also manually move some
solution-specific data to Symantec Management Platform 7.1.

■ Validate
During the validation phase you confirm that you have set up and configured
the new Symantec Management Platform and solutions according to your
requirements. The migration wizard verifies the success of the data it imports.
However, you should browse to the migrated data such as policies, reports,
and packages and verify their state. After you validate the success of the
installation and data migration, you redirect groups of managed computers
to report to the new 7.1 Notification Server. Once the managed computers
report to the 7.1 server, you use an agent upgrade policy to upgrade their
agents.

About testing IT Management Suite
A test server is recommended when you prepare for upgrades or migrations with
IT Management Suite 7.1 and future versions.

Symantec recommends that you test the migration process, and then familiarize
yourself with the new features of 7.1. Ensure that business functional parity is
met on the 7.1 configuration. Many of the features have changed with 7.1, but the
business functions the tools provide are much greater than with 6.x.

When the migration process is complete, Symantec recommends that you continue
to maintain the test server to test each update, service pack, or maintenance
release that you intend to use in production.
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See “About post migration configuration” on page 28.

See “About validating a migration” on page 28.

About post migration configuration
After you have migrated your data, browse through the product and ensure that
the data is where it is expected to be. Data that gets migrated is available for
different actions, and in some cases for review only.

Take some time to familiarize yourself with the data, and ensure that the product
is configured to get the data that is not migrated.

See “About validating a migration” on page 28.

See “About testing IT Management Suite” on page 27.

About validating a migration
Much of the effort you make to migrate data is in itself a validation. However,
tools are also available to help validate data migration. For example, the migration
wizard has a validation process.

Other types of data need to be validated manually by browsing through the content
in the console.

Many of the migration steps in the solution sections of this document enable both
the configuration and validation of the data. Because validation is often performed
as part of the migration process, this document does not include validation-only
procedures.

See “About post migration configuration” on page 28.

See “About testing IT Management Suite” on page 27.

About reusing existing hardware to migrate
Symantec recommends that you use a new server to migrate to IT Management
Suite 7.1.

Keep the 6.x Notification Server available for a duration that fits the needs of your
organization.

By using a new server, you reduce the downtime that results from re-provisioning
the operating system of the Notification Server computer.

Before you turn off or re-provision your old server, be sure that the new server
meets your business need; otherwise, you may lose data.

Overview of migrating to IT Management Suite
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Keep the old server running so that you can capture any data on it that was not
migrated. Also, by keeping the old server running, you can use it for reporting
and configuration reference.

If you must migrate using the existing hardware that currently houses Notification
Server, you must take the following actions:

■ Thoroughly test the migration process using a test computer to ensure that
you capture the data properly before re-provisioning.

■ Ensure that your business functional needs and requirements are not offline
for lengths of time outside of SLAs

■ Develop a reliable agent re-direct process. You must know the new server name
before you re-provision Notification Server.
The agent migration process involves using 6.x policies and agents settings
to point agents to the new server.
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Migrating Symantec
Management Platform

This chapter includes the following topics:

■ Best practices for migrating to Symantec Management Platform 7.1

■ Important things to know when migrating from Notification Server 6.x

■ Migrating from Notification Server 6.x to Symantec Management Platform
7.1

■ About data migration

■ About the data store file

Bestpractices formigrating toSymantecManagement
Platform 7.1

Before you begin the migration process, you should develop a migration plan. As
you develop your migration plan, you should consider these best practices.

See “About migrating to Symantec Management Platform 7.1” on page 26.

Table 3-1 Best practices for migrating to Symantec Management Platform 7.1

DescriptionBest practice

Before you install Symantec Management Platform 7.1 in a production environment,
create a test environment for evaluating and validating the entire installation and
migration process. Symantec recommends that you maintain the test environment
for ongoing validation and testing of updates, maintenance packs , and service packs.

Use a test environment.
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Table 3-1 Best practices for migrating to Symantec Management Platform 7.1
(continued)

DescriptionBest practice

Use a small group of managed computers as a pilot group to test the migration to
Symantec Management Platform 7.1. During this pilot test, leave the remaining
managed computers supported by the previous version of Notification Server.

Use a pilot test group.

You can redirect 5,000 computers to a single Notification Server at the same time.
After you have successfully redirected a group of computers, upgrade the Symantec
Management Agent and agent plug-ins for that group. To upgrade an agent or an
agent plug-in, you enable the upgrade policy for the agent or the agent plug-in.

Note: If you redirect more than 5,000 computers at a time, disable any policies and
tasks that communicate frequently with the Symantec Management Agent. For
example, disable the inventory, software delivery, and patch policies. Disabling the
policies and tasks prevents the console and Notification Server from being very slow.

See “About redirecting sites and agents to Notification Server 7.1” on page 41.

See “About the Symantec Management Agent upgrade policies” on page 44.

Redirect managed computers
in stages.

Maintain your previous Notification Server computers as a record for historical data,
policy configuration details, and other settings and data.

The following are some examples of when you might remove the old server:

■ After the business functional uses on the old server are matched on the new server.

■ After the data saturation on the new server has the needed depth.

■ When the data in the new Configuration Management Database (CMDB) qualifies
against your regulatory standards.

Keep your previous
Notification Server.

You must install the Symantec Management Platform 7.1 products on a computer
that is running the Windows Server 2008 R2 operating system. Because this operating
system is different from what was required for 6.x, Symantec recommends that you
install the 7.1 products on a new computer.

Note: If you have Notification Server 6.x installed on a 64-bit server, you can install
the Symantec Management Platform 7.1 products on that computer. However, before
you install the Windows 2008 R2 operating system, you must complete specific
migration steps. Because some of these migration steps might not complete
successfully, Symantec discourages the reuse of the current server. For more
information about installing the Symantec Management Platform 7.1 products on
your current server, see HOWTO32427.

Migrate using a new
computer.
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Important things to know when migrating from
Notification Server 6.x

A migration from Notification Server 6.x involves many steps. You should be
careful to complete these steps in the recommended order.

See “Migrating from Notification Server 6.x to Symantec Management Platform
7.1” on page 34.

You should also pay particular attention to the following items to avoid major
problems during the migration process:

■ Required version of Notification Server 6.x
Before you migrate from Notification Server 6.x to Symantec Management
Platform 7.1, you must have Notification Server 6.0 R13 and the latest solutions
installed. If you do not have the latest version of Notification Server 6.x,
upgrade to the latest version. You must also upgrade your 6.x solutions and
the agents on your managed computers. For example, if you have Notification
Server 6.0 R11 installed, you must upgrade to 6.0 R13 before you migrate to
Symantec Management Platform 7.1.

■ Database and server backup
Before you begin the migration, you need to back up the 6.x Notification Server
Database and the 6.x Notification Server. If you encounter problems during
the migration process, you can then revert to these backups. Back up the
Notification Server Database to a secure storage location. Making backups
before major migration steps can provide more granular recovery from any
issues or unplanned outages that might occur during the process.

■ New database requirement
When you install the Symantec Management Platform 7.1 products, you must
create a new database. You cannot run Symantec Management Platform 7.1
against the 6.x database. Schema changes were made to the database to increase
the speed and to unify the structure of the database.

■ Product parity
When you install the Symantec Management Platform 7.1 products, you must
install at least the same equivalent products that you installed on the 6.x
Notification Server. Before you begin the migration, create a list of the 6.x
products that you currently have installed.

Warning: Failure to have minimum product parity can result in the inability
to migrate 6.x data to the 7.1 database.
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Keep in mind that some products have been replaced or absorbed by another
product, or have a new product name as follows:

■ Application Management Solution is now part of Software Management
Solution.

■ Application Metering Solution is now part of Inventory Solution.

■ pcAnywhere Solution has replaced Carbon Copy Solution.

■ ServiceDesk has replaced Helpdesk Solution.

■ Out of Band Management Solution is now part of Symantec Management
Platform.

■ Real-Time System Manager Solution is now part of Client Management
Suite.

■ Software Delivery Solution is now Software Management Solution.

■ Software Virtualization Solution is now Workspace Virtualization.

■ Server name and IP address
Symantec recommends that you give the 7.1 server a name and an IP address
that is different from the name and IP address of the 6.x server.

■ Mixed mode
Symantec Management Platform 7.1 does not support mixed mode. A Symantec
Management Platform 6.x server cannot communicate with a Symantec
Management Platform 7.1 server.

Migrating from Notification Server 6.x to Symantec
Management Platform 7.1

You must install the Symantec Management Platform 7.1 products on a computer
that is running the Windows Server 2008 R2 operating system. Because this
operating system is different from what was required for 6.x, Symantec
recommends that you migrate to a new computer.

For more information, see topics on system requirements in the IT Management
Suite Planning and Implementation Guide.
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Note: If you have Notification Server 6.x installed on a 64-bit server, you can
install the Symantec Management Platform 7.1 products on that computer.
However, before you install the Windows 2008 R2 operating system, you must
complete specific migration steps. Because some of these migration steps might
not complete successfully, Symantec discourages the reuse of the current server.
For more information about installing the Symantec Management Platform 7.1
products on your current server, see HOWTO32427.

When you migrate from Notification Server 6.x to Symantec Management Platform
7.1, you have to create a new database. However, you can use the migration wizard
to migrate much of the data that is in your 6.x Notification Server Database. Most
of the data that the migration wizard migrates is actionable although some of it
is read-only. You can also migrate data that is not in the database.

See “Important things to know when migrating from Notification Server 6.x”
on page 33.

See “About the data that the migration wizard migrates from Notification Server
6.x” on page 51.

See “About data migration when migrating from Notification Server 6.x”
on page 50.

For more information, see the documents at https://www-secure.symantec.com/
connect/articles/altiris-endpoint-management-migrations-and-upgrades-71.

Note: Symantec Management Platform 7.1 does not support a mixed mode of
Notification Servers. A 6.x Notification Server cannot communicate with a 7.1
Notification Server.
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Table 3-2 Process for migrating from Notification Server 6.x to Symantec
Management Platform 7.1

DescriptionActionStep

You must back up the 6.x Notification Server Database
before you begin the migration process. You should also
back up the 6.x Notification Server. If you encounter
problems during the migration process you can then revert
to these backups. Back up the database to a neutral storage
location.

Warning: Before proceeding verify that the 6.x Notification
Server Database and the 6.x Notification Server have been
successfully backed up.

See “Backing up the Notification Server Database”
on page 40.

Back up the 6.x Notification Server
Database and the 6.x Notification
Server.

Step 1

On the 6.x Notification Server, complete the following tasks
in order:

■ Verify the completion of all outstanding tasks and
policies.

■ Document the Windows Server user accounts you have
set up on the 6.x server. You must recreate these
accounts manually on the 7.1 server.

■ Create a backup of your software package files.

■ Create a list of the products that you currently have
installed. You need to install the equivalent products on
the 7.1 server so that the migration wizard can properly
migrate the 6.x data.

■ Copy your product licenses to a location that is accessible
from the 7.1 server. You can reapply the licenses when
you install the products. If your licenses are not
downloaded or available, you can download them from
the Symantec Licensing Portal.

For more information about licenses and using the
licensing portal, see the Customer Care Information
Center.

See “About migrating licenses to Symantec Management
Platform 7.1” on page 48.

■ Back up the 6.x database again to capture the most recent
data.

Prepare for the migration.Step 2

Migrating Symantec Management Platform
Migrating from Notification Server 6.x to Symantec Management Platform 7.1

36

https://licensing.symantec.com/acctmgmt/index.jsp?clearForm=true
http://customercare.symantec.com/
http://customercare.symantec.com/


Table 3-2 Process for migrating from Notification Server 6.x to Symantec
Management Platform 7.1 (continued)

DescriptionActionStep

The 7.1 server must be running the Microsoft Windows 2008
R2 operating system. Symantec recommends that you give
the 7.1 server a different name and IP address from the
name and IP addres of the 6.x server.

Because the Windows server user accounts are not migrated
during the migration, you must recreate them on the 7.1
server the migration process.

You should also install the following items:

■ SSL and certificates if you use them.

■ Third-party plug-ins that the products you install
require. These plug-ins include Microsoft Silverlight 4.0,
Adobe Flash Player 10, and Sun Java Runtime 6.

Prepare the 7.1 server for the
installation.

Step 3

You use Symantec Installation Manager to install the
Symantec Management Platform 7.1 products.

For more information, see topics on installing Symantec
Installation Manager in the IT Management Suite Planning
and Implementation Guide.

Install Symantec Installation Manager
on the 7.1 server.

Step 4

You install the Symantec Management Platform 7.1 products
with Symantec Installation Manager. Install the same or
the equivalent products that you had installed on the 6.x
server.

When you install the Symantec Management Platform
products, you should also install the migration wizard
components. During the installation process an Optional
Installations page appears where you have the option to
install the migration wizard components. You can also
install the migration wizard components at any time with
Symantec Installation Manager.

At the end of the installation process, Symantec Installation
Manager prompts you to apply licenses to the solutions you
installed. You can also run Symantec Installation Manager
at a later time to apply the licenses.

For more information, see topics on installing the Symantec
Management Platform products in the IT Management Suite
Planning and Implementation Guide.

Install the Symantec Management
Platform 7.1 products.

Step 5

37Migrating Symantec Management Platform
Migrating from Notification Server 6.x to Symantec Management Platform 7.1

http://www.symantec.com/docs/doc3464
http://www.symantec.com/docs/doc3464
http://www.symantec.com/docs/doc3464
http://www.symantec.com/docs/doc3464


Table 3-2 Process for migrating from Notification Server 6.x to Symantec
Management Platform 7.1 (continued)

DescriptionActionStep

You use the migration wizard to migrate 6.x data.

See “Migrating data to Symantec Management Platform 7.1
with the migration wizard” on page 55.

See “About the data that the migration wizard migrates
from Notification Server 6.x” on page 51.

The migration process consists of the following steps:

■ Install the migration wizard on the 6.x Notification
Server.

See “About installing the Symantec Notification Server
Migration Wizard” on page 54.

■ Export 6.x data from the 6.x Notification Server to a data
store file.

See “Exporting data from a data store file” on page 64.

■ Copy the data store file from the 6.x server to the 7.1
server or to a location that the 7.1 server can access. If
a PackageFiles folder is in the same directory as the data
store file, copy it to the same directory as the data store
file.

■ Import 6.x data from the data store file to the Symantec
Management Platform 7.1 server.

See “Importing Notification Server 6.x data from a data
store file” on page 59.

Migrate Notification Server 6.x data to
the 7.1 server with the migration
wizard.

Step 6

The migration wizard verifies the success of the data it
imports. However, you should browse to the migrated data
such as policies, reports, and packages and verify their state.

Verify that the 6.x data was
successfully migrated.

Step 7

Some solution-specific items are not migrated with the
Notification Server Database or with the migration wizard.
You must manually move these items from the 6.x server
to the 7.1 server.

See “About the 6.x data that you must manually migrate to
Symantec Management Platform 7.1” on page 61.

You must also configure each of the 7.1 solutions.

For more information, see topics on configuration in the
documentation for each solution.

Move solution-specific items from the
6.x server to the 7.1 server and
configure the solutions.

Step 8
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Table 3-2 Process for migrating from Notification Server 6.x to Symantec
Management Platform 7.1 (continued)

DescriptionActionStep

Before you configure your site servers, you should determine
how many site servers you need. You must then create the
sites and configure the site servers. If you had 6.x package
servers, you must redirect them to the 7.1 Notification
Server and upgrade their Altiris Agents with the Symantec
Management Agent. The package servers are then upgraded
automatically because their upgrade policy is enabled by
default.

See “About upgrading package servers” on page 47.

For recommendations on the number of site servers that
you need, see the IT Management Suite Planning and
Implementation Guide.

For more information, see topics on site servers in the
Symantec Management Platform User Guide.

Configure site servers.Step 9

Symantec recommends that you remove all sub-agents or
agent plug-ins from your managed computers. You should
leave only the Altiris Agent on the managed computers. For
package servers, you should also leave the Package Server
Agent.

See “About removing sub-agents or agent plug-ins from
managed computers” on page 47.

Remove sub-agents or agent plug-ins
from your managed computers

Step 10

The Altiris Agents that previously reported to the 6.x
Notification Server need to be redirected to the 7.1
Notification Server.

See “Redirecting managed computers to Notification Server
7.1” on page 42.

Redirect the Altiris Agents to the new
server.

Step 11
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Table 3-2 Process for migrating from Notification Server 6.x to Symantec
Management Platform 7.1 (continued)

DescriptionActionStep

After you have successfully redirected a group of computers,
upgrade the Altiris Agent and agent plug-ins for the clients
in the group. Upgrade the Altiris Agent before you upgrade
the plug-ins. You upgrade the Altiris Agent with the
Symantec Management Agent. To upgrade an agent or an
agent plug-in, you enable the upgrade policy for the agent
or plug-in.

See “Upgrading the Altiris Agent and the agent plug-ins”
on page 45.

See “About the Symantec Management Agent upgrade
policies” on page 44.

For more information, see topics on Symantec Management
Agent settings and configuring the agent upgrade in the
Symantec Management Platform User Guide.

Upgrade the Altiris Agent and the agent
plug-ins.

Step 12

Backing up the Notification Server Database
Backing up the Notification Server Database is the most important fail-safe
measure that you can take during the migration process. You can use the backup
to restore your database to a known good state if anything should happen to
compromise your database.

See “Migrating from Notification Server 6.x to Symantec Management Platform
7.1” on page 34.

To back up the Notification Server Database

1 Open Microsoft SQL Manager Studio.

2 In the left pane, expand the Databases folder.

3 In the left pane, under Databases, right-click the name of your database.

4 In the right-click menu, click Tasks > Back Up.

5 In the BackupDatabase dialog box, in the Backuptype drop-down list, click
Full.

6 In the Backup set section, enter a name for your backup.
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7 In the Destination section, add the location where you want your backup file
to be stored.

This location should be a secure storage location, and should not be on the
local computer.

8 Click OK.

About redirecting sites and agents to Notification Server 7.1
Before you redirect sites and agents to the new Notification Server computer, you
should develop a redirection plan. Use the guidelines and information in this topic
to help you develop that plan.

See “Redirecting managed computers to Notification Server 7.1” on page 42.

Symantec recommends that you keep the 6.x Notification Server and the Symantec
Management Platform 7.1 server running at the same time. Over time you
incrementally move groups of client computers to the Symantec Management
Platform 7.1 server. By maintaining your 6.x Notification Server, you preserve a
historical record of your settings and data. You also have more control over what
client computers you move and when you move them.

Use the following guidelines when you redirect sites and their package servers to
the 7.1 Notification Server:

■ When you redirect a site, Symantec recommends that you redirect and upgrade
its package server before you redirect any other agents within the site. If there
is more than one package server for a location or logical group, migrate the
package servers with their clients in proportional groups. You redirect and
upgrade the package servers first so that they are available in the new
environment when the agents in the site are redirected.

■ After a package server is redirected to the 7.1 Notification Server, you must
remove the package server from the 6.x Notification Server as soon as possible.
You remove a package server from the 6.x Notification Server to prevent the
agents that are still in the 6.x environment from communicating with it.

■ After you redirect a package server to the 7.1 Notification Server, upgrade the
package server immediately.
To upgrade a package server, upgrade the Altiris Agent. You use the Symantec
Management Agent upgrade policies on the Symantec Management Platform
7.1 server to upgrade the agent. After the agent is upgraded, the package server
is upgraded automatically because the upgrade policy is enabled by default.
See “About upgrading package servers” on page 47.
See “About the Symantec Management Agent upgrade policies” on page 44.
See “Upgrading the Altiris Agent and the agent plug-ins” on page 45.
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How you redirect sites and agents depends on whether you have sites defined and
the number of agents in your environment as follows:

■ If the number of agents is less than 5,000, any package
servers should be redirected to the new Notification
Server and then the Altiris Agents in the site.

■ If the number of agents is more than 5,000, Symantec
recommends that you first define sites in the 6.x
Notification Server. Each site should have at least one
package server and no site should have more than 5,000
agents. After you define the sites, redirect each site to
the new Notification Server. When you redirect a site,
redirect the package servers and then the agents within
the site.

No sites are defined.

■ If a site has less than 5,000 agents, redirect each package
server to the new Notification Server. When you redirect
a site, redirect the package servers and then the agents
within the site.

■ If a site has more than 5,000 agents, Symantec
recommends that you divide the site into smaller sites.

■ If multiple sites share a package server and the sites
have a total of less than 5,000 agents, redirect the
package servers and sites together.

■ If multiple sites share a package server and the sites
have a total of more than 5,000 agents, temporarily
remove the package server from the 6.x system. After
you redirect all the sites to the new Notification Server,
recreate the shared package server.

Sites are defined.

Redirecting managed computers to Notification Server 7.1
The Altiris Agents that previously reported to the 6.x Notification Server need to
be redirected to the 7.1 Notification Server. When you redirect a group of
computers, create a filter for the first group of computers that you want to move.
You then target the filter with the targeted Altiris Agent Settings policy and
exclude it from the targets of other policies. You can then expand the membership
of the filter as needed until it includes all computers.

See “About redirecting sites and agents to Notification Server 7.1” on page 41.

Although 20,000 computers can be managed with a single Notification Server,
Symantec recommends that you redirect no more than 5,000 computers at the
same time. However, it is possible to redirect up to 15,000 computers to a single
Notification Server at the same time.

Migrating Symantec Management Platform
Migrating from Notification Server 6.x to Symantec Management Platform 7.1

42



Note: If you redirect more than 5,000 computers at a time, disable any policies
and tasks that communicate frequently with the Symantec Management Agent.
Disabling the policies and tasks prevents the console and Notification Server from
being very slow.

See “Best practices for migrating to Symantec Management Platform 7.1”
on page 31.

For more information, see topics on the Altiris Agent Settings in the Altiris
Notification Server 6.x Help.

To redirect computers to Symantec Management Platform 7.1

1 In the 7.1 environment, install a package service and a task service on a site
server to handle clients as they are redirected.

By default, a task service is installed on the Symantec Management Platform
server. However, Symantec recommends that you always set up at least one
task server to service the client computers.

Your environment might require multiple site servers. You might elect to
redirect a package server and then the clients that use that package server
to ensure that packages are available regionally. You can also use virtual
machines to serve as temporary site servers during the redirection process.
After all the agents for those sites have upgraded, you should then remove
the virtual machines.

2 Remove all sub-agents or plug-ins from your managed computers.

However, on your Package Servers do not remove the Package Server Agent.

See “About removing sub-agents or agent plug-ins from managed computers”
on page 47.

3 On the Configuration menu, click AltirisAgent>AltirisAgentConfiguration,
and select the policy that contains the agents that you want to redirect to 7.1.

4 On the policy’s AltirisAgentSettings page, click the AdvancedSettings tab.

5 In the Alternate URL for accessing NS section, specify the URL for the 7.1
Notification Server as follows:

■ Server Name
Symantec recommends that you use the fully qualified domain name.

■ Server Web
The Server Web address should be in the following format:
https://<NS_FQDN>:<port>/Altiris/

6 Click Apply.
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About the Symantec Management Agent upgrade policies
You use a Symantec Management Agent upgrade policy to upgrade the Altiris
Agent on your managed computers. To perform the upgrade, you select and enable
the appropriate policy and apply it to a set of computers. Upgrade the Altiris
Agent with the Symantec Management Agent before you upgrade the agent
plug-ins.

See “Upgrading the Altiris Agent and the agent plug-ins” on page 45.

The Symantec Management Agent has a set of site server upgrade policies and a
set of upgrade policies for all other computers. Both sets have two policies for
upgrading 64-bit computers and another policy for upgrading 32-bit computers.
One 64-bit upgrade policy upgrades a 64-bit computer with a 64-bit agent, while
the other policy upgrades a 64-bit computer with a 32-bit agent.

The upgrade polices for the Symantec Management Agent are in a NonSiteServer
folder and a Site Server folder. To access these folders, on the Settings menu,
click Agents/Plug-ins>SymantecManagementAgent and expand the Windows
folder.

Note: The upgrade policy for the Symantec Management Agent for
UNIX/Linux/Mac is in the UNIX/Linux/Mac folder.

When you install a 64-bit agent on a computer, 64-bit sub-agents or plug-ins are
installed when they are available. If a 64-bit plug-in is not available, a 32-bit
plug-in is installed, and it runs in a surrogate service that was created for this
scenario. When you install a 32-bit agent on a 64-bit computer, 32-bit sub-agents
or plug-ins are installed.

Warning: If you install the 32-bit agent on a 64-bit computer, the agent may have
trouble returning some inventory data because it is runs in the WOW64 memory
space. Applications that run in the WOW64 memory space do not see the actual
registry and file system on a 64-bit computer.

For more information, see topics on file system redirector and registry redirector
in the Microsoft MSDN library.
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Note: When you install the Symantec Management Agent with a scheduled push
install on a 64-bit computer, the 64-bit agent is installed by default. However, if
you check the Forceinstallationof32-bitSymantecManagementAgenton64-bit
systems option, the 32-bit agent is installed. The option to force a 32-bit
installation is on the Symantec Management Agent Installation Options dialog
box. You access this dialog box when you click the Settings option on the Symantec
Management Agent Install page.

Upgrading the Altiris Agent and the agent plug-ins
After you migrate to Symantec Management Platform 7.1, you need to upgrade
the Altiris Agent and agent plug-ins on the client computers. Upgrade the Altiris
Agent before you upgrade the agent plug-ins. You upgrade the Altiris Agent with
the Symantec Management Agent.

See “About the Symantec Management Agent upgrade policies” on page 44.

See “Migrating from Notification Server 6.x to Symantec Management Platform
7.1” on page 34.

Warning: If you install the 32-bit agent on a 64-bit computer, the agent may have
trouble returning some inventory data because it is runs in the WOW64 memory
space. Applications that run in the WOW64 memory space do not see the actual
registry and file system on a 64-bit computer.

For more information, see topics on file system redirector and registry redirector
in the Microsoft MSDN library.

Note: Symantec recommends that you keep your 6.x Notification Server running
for six months to 12 months for reporting and configuration reference.
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To upgrade the Altiris Agent and the agent plug-ins

1 Remove the sub-agents or agent plug-ins from all of the managed computers.

Symantec recommends that you remove all agent sub-agents or agent plug-ins
from your managed computers to avoid any potential problems during the
upgrade process. However, on your package servers, you should also leave
the Package Server Agent.

See “About removing sub-agents or agent plug-ins from managed computers”
on page 47.

2 In Notification Server 6.x, redirect the managed computers to the 7.1
Notification Server.

See “About redirecting sites and agents to Notification Server 7.1” on page 41.

See “Redirecting managed computers to Notification Server 7.1” on page 42.

3 In Symantec Management Platform 7.1, use filters and targets to create a test
group of clients on which to test the upgrade of the agent and the installation
of the agent plug-ins.

Note: If you did not remove a 6.x sub-agent, you would use an upgrade policy
to install the 7.1 plug-in. However, because Software Management Solution,
pcAnywhere Solution, and Inventory Solution, do not have an equivalent 7.1
product, you must use an installation policy to install the plug-ins for these
products.

4 For the test group, enable the Symantec Management Agent upgrade policy.

5 For the test group, enable the installation policies for the agent plug-ins that
correspond to the plug-ins that were installed on client computers before you
migrated to 7.1.

6 For the test group, validate that policies, tasks, and other functionality works
correctly.

7 For the rest of your client computers, repeat the preceding steps that you
performed on the test group.

You can broaden the scope a few thousand clients at a time. Symantec
recommends that you do not upgrade more than 5,000 clients at the same
time. You can upgrade up to 15,000 clients at the same time. However, you
should then disable any policies and tasks that communicate frequently with
the Symantec Management Agent.

8 For the clients that are not available during the migration, ask your network
team to make the following change:
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■ Delete the Altiris Notification Server 6.0 DNS A Record.

■ Create DNS Alias (CNAME) to direct the host name for Notification Server
6.x to Symantec Management Platform 7.1.

Keep these settings in place until the upgrade of the agent and the agent
plug-ins is completed on all of the remaining clients.

About removing sub-agents or agent plug-ins from managed computers
Before you redirect your 6.x managed computers to Symantec Management
Platform 7.1, Symantec recommends that you remove all sub-agents or agent
plug-ins from those computers. You should remove these sub-agents from your
managed computers to avoid any potential problems during the migration process.
You should leave only the Altiris Agent on the managed computers. However, on
your package servers, you should also leave the Package Server Agent installed.

See “Upgrading the Altiris Agent and the agent plug-ins” on page 45.

See “Redirecting managed computers to Notification Server 7.1” on page 42.

Before you remove the sub-agents, create a record of where the sub-agents are
installed. You can use the collections that target the currently installed sub-agents
to create the record. After the sub-agents are removed, you have no way to
determine where they were installed. However, if you create a record, you can use
this record to ensure that you use the same distribution when you install the 7.1
plug-ins. You can also export the 6.x collections for agent distribution to CSV files.
You can then import the CSV files to create new static filters that you can use to
distribute the 7.1 plug-ins.

The preferred method for removing the plug-ins is to use predefined collections
and policies. You can also run AeXagentUtil.exe with the /UninstallAgents
parameter.

About upgrading package servers
You need to upgrade your package servers before you redirect your managed
computers to the 7.1 Notification Server. To upgrade a package server, redirect
it to the 7.1 Notification Server and upgrade its Symantec Management Agent.
Because the policy that upgrades the package servers is enabled by default, the
package server is then automatically upgraded. The Legacy Windows Package
Server Agent Upgrade policy upgrades the package servers.

See “Upgrading the Altiris Agent and the agent plug-ins” on page 45.

See “About redirecting sites and agents to Notification Server 7.1” on page 41.
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For a lengthy migration, Symantec recommends that you set up temporary package
servers or move your package servers in proportional groups along with their
clients. For example, suppose you have 10,000 clients pointing to a Notification
Server and four package servers. You do not want to leave either your old or new
Notification Server with no package servers. You should either add temporary
site servers or move 1/4 of your package servers with 1/4 of your clients.

When you set up package servers, you prepare the network topology for the agent
packages that are available from regional package servers. If you have remote
sites with a slow connection, you should upgrade their package servers before
you upgrade the agents on the clients. By upgrading the package servers, you
reduce the load of the package traffic.

Warning: Do not upgrade package servers before their client base is targeted to
be upgraded.

If you upgrade the agent on a package server to a 64-bit agent, its 32-bit assemblies
are removed and 64-bit assemblies are installed. The existing registry and folder
structure for packages remains intact. If you upgrade the agent on a package
server to a 32-bit agent, the package server is also upgraded to 32-bit.

After a package server is upgraded, it downloads any new 7.1 system-based
packages that the 7.1 Notification Server hosts. These packages include all solution
plug-ins. Any package that has not changed is not re-downloaded.

To access the package server agent upgrade policy, on the Settings menu, click
All Settings. You then navigate to Settings > Notification Server > Site Server
Settings > Package Service > Advanced > Windows > Legacy Windows Package
Server Agent Upgrade.

About migrating licenses to Symantec Management Platform 7.1
When you migrate from Notification Server 6.x to Symantec Management Platform
7.1, the licenses for your products are not migrated. You must copy the 6.x licenses
to a location where you can access them on the Symantec Management Platform
7.1 server.

See “Migrating from Notification Server 6.x to Symantec Management Platform
7.1” on page 34.

After you migrate the licenses, you must apply them. You can apply the licenses
when you install a product or at a later time. You apply the licenses on the Product
Licensing page in Symantec Installation Manager.

For more information, see topics on applying licenses in the IT Management Suite
Planning and Implementation Guide.
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If your licenses are not available, you can download them from the Symantec
Licensing Portal. If you cannot apply your old licenses in Symantec Installation
Manager, then you must also download new licenses from the licensing portal.

For more information about licenses and using the licensing portal, see the
Customer Care Information Center.

Note: Because some Notification Server 6.x solutions bundle with other solutions
on Symantec Management Platform 7.1, their licenses cannot be reused.

About data migration
When you migrate to Symantec Management Platform 7.1, you can also migrate
the Notification Server 6.x data to Symantec Management Platform 7.1.

See “About data migration when migrating from Notification Server 6.x”
on page 50.

Symantec provides the following tools to assist in the process of migrating data
to Symantec Management Platform 7.1:

■ Symantec Installation Manager
You use the Symantec Installation Manager to install the migration wizard
components. The migration wizard components give you access to the
Symantec Notification Server Migration Wizard.
See “About installing the Symantec Notification Server Migration Wizard”
on page 54.

■ Symantec Notification Server Migration Wizard
You use the Symantec Notification Server Migration Wizard to migrate
Notification Server 6.x data to Symantec Management Platform 7.1.
See “About the Symantec Notification Server Migration Wizard” on page 50.
See “About the data that the migration wizard migrates from Notification
Server 6.x” on page 51.

■ Deployment Solution migration tools
Deployment Solution includes a tool for migrating 6.x images to 7.1.
See “Architectural and functionality concepts of Deployment Solution 7.1 SP1”
on page 122.

For more information, see the documents at https://www-secure.symantec.com/
connect/articles/altiris-endpoint-management-migrations-and-upgrades-71.
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About data migration when migrating from Notification Server 6.x
When you migrate from Notification Server 6.x, you use the Symantec Notification
Server Migration Wizard to migrate Notification Server 6.x data. Some of the 6.x
data that you can migrate is actionable, while some it is read-only.

See “About the data that the migration wizard migrates from Notification Server
6.x” on page 51.

See “About data migration” on page 49.

See “About the Symantec Notification Server Migration Wizard” on page 50.

Consider the following before you use the migration wizard to migrate 6.x data
to Symantec Management Platform 7.x:

■ Some 6.x data is more difficult to replace than other data.
Asset data represents the physical items that you may not be able to gather
automatically after you migrate to Symantec Management Platform 7.1. This
data represents a lot of manual data entry and is an excellent candidate for
data migration. On the other hand, inventory data is replaced within a week
after you migrate to Symantec Management Platform 7.1. Consequently, the
inventory data is not as good a candidate for migration as the asset data.

■ Symantec Management Platform 7.1 cannot use some 6.x data.
After you migrate data, some of it is not editable and some is not actionable
because of fundamental changes in how Symantec Management Platform
works. For example, when you migrate the 6.x collections, the collections are
actionable but not editable. Because Symantec Management Platform 7.x uses
filters instead of collections, Symantec recommends that you convert your
collections to filters. Migrated 6.x custom reports are also read-only. You
cannot update the 6.x custom reports to include 7.1 information. However,
you can use your 6.x reports for audit and reference purposes.

■ Some 6.x data requires your configuration after migration.
Some 6.x data requires your configuration before you can use it in Symantec
Management Platform 7.1. For example, you can migrate custom agent settings
policies, but you should apply filters to the policies to replace the 6.x collections.

About the Symantec Notification Server Migration Wizard
When you migrate to Symantec Management Platform 7.1, you use the Symantec
Notification Server Migration Wizard to migrate the existing Notification Server
6.x data.

See “About the data that the migration wizard migrates from Notification Server
6.x” on page 51.
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See “About data migration” on page 49.

Migrating data with the migration wizard involves the following steps:

■ Export the data to a data store file with the migration wizard.

■ Copy the data store file to a location that the Symantec Management Platform
7.1 server can access.
If a PackageFiles folder is in the same directory as the data store file, copy it
to the same directory as the data store file.

■ Import the data from data store file with the migration wizard.

See “About the data store file” on page 62.

To migrate data with the migration wizard, you must install the migration wizard
on your 6.x server and on the 7.1 server. How you install the migration wizard
varies depending on where you install it.

See “About installing the Symantec Notification Server Migration Wizard”
on page 54.

The migration wizard uses exporters to export data and a corresponding set of
importers to import data. Each product that has data to migrate has its own set
of exporters and importers. By default, the migration wizard exports and imports
all of the data. Symantec recommends that you use the default setting to export
and import all of the data.

The EXE for the migration wizard is NSUUpgradeWizard.exe, and it is in the
C:\Program Files\Altiris\Upgrade directory by default. To run the migration
wizard, you must be a member of the local administrators group.

About the data that the migration wizard migrates from Notification
Server 6.x

When you migrate from Notification Server 6.x, you use the Symantec Notification
Server Migration Wizard to migrate Notification Server 6.x data. Some of the 6.x
data that you can migrate is actionable, while some it is read-only.

See “About data migration” on page 49.

See “About data migration when migrating from Notification Server 6.x”
on page 50.

See “About the Symantec Notification Server Migration Wizard” on page 50.

Note: You cannot migrate 6.x custom menu items with the migration wizard. You
must manually export the 6.x menus from the 6.x console and import them into
the 7.1 console.
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Table 3-3 Platform data that the migration wizard migrates from Notification
Server 6.x

DescriptionData

You can migrate predefined security roles and custom security roles.

Note: If you create a custom 6.x security role and give it permissions on predefined items such
as reports or policies, the permissions are not migrated. However, permissions on custom items
are migrated.

Security roles

You can migrate KMS and Credential Manager keys.Certificates - KMS/
PPA keys

You can migrate the non-default collections, and they are actionable but not editable. If you
use the collections, you should validate that they work correctly. Because Symantec Management
Platform 7.x uses filters instead of collections, Symantec recommends that you convert your
collections to filters. After you migrate your custom collections, you can use them as a reference
when creating filters.

Collections

You can migrate custom notification policies and custom agent settings policies. The custom
notification policies are read-only, but the custom agent settings policies are actionable.

Policies

You can migrate task-based policies, and they are actionable. These policies are referred to as
client task schedules in the 6.x console.

Task-based
policies

You can migrate predefined and custom reports, but they are read-only. You can use the reports
for audit and reference purposes. You should replace the 6.x reports with 7.1 reports to reflect
your current data.

Some of the reports you migrate may try to use the data that did not migrate and the reports
then have incomplete data. You should validate the migrated reports against the reports in the
6.x console.

Reports

You can migrate 6.x jobs and tasks, and they are actionable.Jobs and Tasks

You can migrate 6.x resource associations, and they are actionable.Resource
association
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Table 3-3 Platform data that the migration wizard migrates from Notification
Server 6.x (continued)

DescriptionData

You can migrate the Software Delivery packages that are stored locally and their command
lines. If a package and a command line are linked to a 6.x task, they are linked to the
corresponding 7.1 task or policy after migration.

A 6.x task becomes a 7.1 task or policy as follows:

■ A Software Delivery task becomes a Legacy Delivery task.

■ A Sequential Software Delivery task becomes a Managed Software Delivery policy.

■ A Software Delivery Task Server task becomes a Package Delivery task.

A migrated package is not associated with a software resource or placed in the Software Library
by default. Before you deliver a package with Quick Delivery, Managed Software Delivery, or
the Software Portal, associate the package with a software resource. When you import a software
delivery package, it is imported to the same location it had on the 6.x server unless you specify
an alternate location.

See “Promoting migrated Software Packages into the Software Library” on page 115.

You can also migrate all patch packages regardless of where they are stored. The packages are
imported into the default location.

Packages

You can migrate portal pages and Web parts, and they are actionable.Portal pages and
Web parts

You can migrate console views, and they are actionable.Console view

You can migrate the user-defined actions that you have added to a right-click menu.Right-click actions

You can migrate predefined and custom 6.x Inventory Forwarding rules. When you migrate
these rules, they are converted to 7.1 replication rules. You can also migrate Connector rules
and Active Directory Import rules.

Rules

For information about the solution-specific data that the migration wizard
migrates, see the following:

■ Patch Management Solution
See “Data that can be migrated from the 6.x version of Patch Management
Solution for Windows” on page 102.

■ Inventory Solution
See “About migrating to Inventory Solution 7.1 with Symantec Notification
Server Migration Wizard” on page 70.

■ Software Management Solution
See “Items that can and items that cannot be migrated from software delivery
solutions 6.x” on page 108.
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■ Asset Management Solution
See “About data migration special cases” on page 172.

About installing the Symantec Notification Server Migration Wizard
You use the Symantec Notification Server Migration Wizard to migrate data from
Notification Server 6.x to Symantec Management Platform 7.1. To migrate data
with the migration wizard, you must install the migration wizard on your 6.x
server and on the 7.1 server. How you install the migration wizard varies depending
on where you install it.

See “About data migration” on page 49.

See “About the Symantec Notification Server Migration Wizard” on page 50.

Note: To install the migration wizard, .NET Framework 2.0 is required.

Note: To run the migration wizard, you must be a member of the local
administrators group.

Table 3-4 About installing the Symantec Notification Server Migration Wizard

How to install the migration wizardWhere the migration wizard is
installed

Use Symantec Installation Manager on the computer to install the migration
wizard components.

After you select the products to install, Symantec Installation Manager
displays an OptionalInstallations page that includes the InstallMigration
WizardComponents option. If you check this option, the migration wizard
components are installed with the selected products. You can also access
the Optional Installations page at a later time to install the migration
wizard components.

Symantec Management Platform 7.1
server
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Table 3-4 About installing the Symantec Notification Server Migration Wizard
(continued)

How to install the migration wizardWhere the migration wizard is
installed

Copy the migration wizard installation package from the Symantec
Management Platform 7.1 server. The migration wizard installation package
has a 32-bit and a 64-bit version. Copy the 32-bit version. You then run the
installation package to install the migration wizard.

The migration wizard installation package is only available on the 7.1 server
if you have installed the optional migration wizard components on that
computer. By default, the migration wizard installation package is installed
at C:\Program Files\Altiris\Symantec Installation
Manager\MigrationPackage.

Note: The MigrationPackage folder contains four files. Two of the files
include the word "silent" in their name. Use the migration package files
that do not contain the word "silent" to install the migration wizard.

Note: You can install Symantec Installation Manager on another computer
and install only the migration wizard components on that computer. You
can then copy the migration wizard installation package to your current
Notification Server and migrate its data. You might install just the migration
wizard if you need to install the Symantec Management Platform 7.1
products on your current server. However, Symantec discourages the reuse
of the current server. For more information about installing the Symantec
Management Platform 7.1 products on your current server, see
HOWTO32427.

Current Notification Server

Migrating data to Symantec Management Platform 7.1 with the
migration wizard

You use the Symantec Notification Server Migration Wizard to migrate Notification
Server 6.x data to Symantec Management Platform 7.1. This topic provides an
overview of the process of migrating data with the migration wizard.

See “About the Symantec Notification Server Migration Wizard” on page 50.

See “About the data that the migration wizard migrates from Notification Server
6.x” on page 51.
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Table 3-5 Process for migrating data to Symantec Management Platform 7.1
with the migration wizard

DescriptionActionStep

Before you can migrate data with the migration wizard, you
must first install it. You use Symantec Installation Manager
to install the migration wizard components on the 7.1 server.
You then copy the migration wizard installation package to
your current Notification Server and install it.

See “About installing the Symantec Notification Server
Migration Wizard” on page 54.

Install the migration wizard on the 6.x
Notification Server.

Step 1

After the migration wizard is installed on the 6.x
Notification Server, it starts in export mode. The migration
wizard lets you export 6.x data to a data store file. You can
also manually run the migration wizard and export data
multiple times.

See “Exporting Notification Server 6.x data to a data store
file ” on page 57.

See “About the data store file” on page 62.

Export 6.x data to a data store file.Step 2

After you export data to a data store file, you can use Store
Browser to view the data that was exported.

See “Viewing the data in a data store file” on page 63.

(Optional) View the data in the data
store file.

Step 3

If you export 6.x data multiple times, you can use StoreDiff
to compare two data store files. StoreDiff creates a data
store file that contains the differences between the two data
store files. You can then use Store Browser to view these
differences.

See “Comparing two data store files” on page 65.

(Optional) Compare two data store files.Step 4

You need to copy the migration data to a location that is
accessible to the Symantec Management Platform 7.1 server.
By default, a data store file is created in the
Altiris\Upgrade\Data directory. If package files are exported,
this directory also contains a PackageFiles folder. You must
put the PackageFiles in the same directory where you put
the data store file.

You may also want to copy this data to a neutral location to
back up the data.

Copy the migration data to the
Symantec Management Platform 7.1
server.

Step 5
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Table 3-5 Process for migrating data to Symantec Management Platform 7.1
with the migration wizard (continued)

DescriptionActionStep

On the Symantec Management Platform 7.1 server, use the
migration wizard to import the 6.x data. If the migration
wizard is not installed on this computer, you must first
install it.

See “About installing the Symantec Notification Server
Migration Wizard” on page 54.

See “Importing Notification Server 6.x data from a data
store file” on page 59.

Import the 6.x data to Symantec
Management Platform 7.1.

Step 6

You must configure some 6.x data after it is migrated to
make it compatible with new 7.x features. For example, a
migrated 6.x software delivery package is not compatible
with Quick Delivery and Managed Software Delivery in
Software Management Solution. Before you can use these
delivery methods to deliver the migrated package, you must
promote the package to the Software Library.

See “Promoting migrated Software Packages into the
Software Library” on page 115.

Configure 6.x data that is not
compatible with 7.x features.

Step 7

Exporting Notification Server 6.x data to a data store file
When you migrate to Symantec Management Platform 7.1, you use the Symantec
Notification Server Migration Wizard to migrate Notification Server 6.x data.
When you use the migration wizard, one step in the migration process is to export
the 6.x data to a data store file. By default, the data store file is saved in the
C:\Program Files\Altiris\Upgrade\Data directory.

See “Migrating data to Symantec Management Platform 7.1 with the migration
wizard” on page 55.

See “About data migration” on page 49.

See “About the data store file” on page 62.

When the migration wizard runs in export mode, it uses exporters to export data.
Each product that has data to migrate has its own set of exporters. By default, the
migration wizard exports all of the data. Symantec recommends that you use the
default setting to export all of the data.

When you export data, additional data migration files may be created and saved
in this same directory. For example, when you export locally saved software
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package files, a PackageFiles folder is created that contains folders for all of the
package files.

To export Notification Server 6.x data to a data store file

1 Install and run the migration wizard on the 6.x Notification Server.

After the migration wizard is installed on the 6.x Notification Server, it starts
in export mode. You can also manually run NSUpgradewizard.exe to start
the migration wizard manually. The migration wizard EXE is in the C:\Program
Files\Altiris\Upgrade directory by default.

See “About installing the Symantec Notification Server Migration Wizard”
on page 54.

See “About the Symantec Notification Server Migration Wizard” on page 50.

2 If the Welcome page of the migration wizard appears, click Next.

3 On the Export / ImportTaskSelection page, specify a name and location for
the data store file, and click Next.

The default name has three parts: the word Store, the date, and the time. The
data store extension must be .adb.

4 On the Password Protection page, if you want to encrypt the data, enter a
password.

You must then use this password when you import the data on the Symantec
Management Platform 7.1 server.

5 On the ExporterConfiguration page, select the data to export, and click Next.

Symantec recommends that you select all of the available data.

See “Exporter Configuration or Importer Configuration page” on page 60.

6 On the ProductReadinessCheck page, review the messages, and click Next.

This page displays each product that has data that is not included in the
export. To view an explanation of why the data is not included, click in the
Message column.

7 If the product readiness warning message appears, click Yes.

This message indicates that not all products meet the product readiness
check. To view the explanations for any product readiness warnings, click
No, and then click Back.

8 On the Task Summary page, verify that the migration wizard is about to
perform the correct tasks, and click Next.
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9 When the message that the data export has completed successfully appears,
click OK.

If the data is not exported successfully, a message with instructions appears.

10 (Optional) To display details about each action, check Show Details.

11 Click Finish.

Importing Notification Server 6.x data from a data store file
You use the Symantec Notification Server Migration Wizard to migrate Notification
Server 6.x data to Symantec Management Platform 7.1. When you use the
migration wizard, one step in the migration process is to import the 6.x data from
a data store file.

See “Migrating data to Symantec Management Platform 7.1 with the migration
wizard” on page 55.

See “About the data store file” on page 62.

See “About the Symantec Notification Server Migration Wizard” on page 50.

When the migration wizard runs in import mode, it uses importers to import data.
Each product that has data to migrate has its own set of importers. By default,
the migration wizard imports all of the data.

You can import all of the data at one time or perform multiple imports and import
the data in stages. For example, you can perform an import for each product and
then check the data after each import. If you do not import all of the data initially,
you must manually run the migration wizard for subsequent imports. If you import
the same data twice, the last import overwrites any previous import.

To import Notification Server 6.x data from a data store file

1 Do one of the following to start the migration wizard in the import mode:

■ Install the migration wizard on the Symantec Management Platform 7.1
server with Symantec Installation Manager. By default, the migration
wizard starts after it is installed.
See “About installing the Symantec Notification Server Migration Wizard”
on page 54.
See “About the Symantec Notification Server Migration Wizard”
on page 50.

■ Run the migration wizard EXE manually.
When you install the optional migration wizard components, the migration
wizard EXE is installed. The EXE for the migration wizard is
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NSUpgradeWizard.exe, and by default it is in the C:\Program
Files\Altiris\Upgrade directory.

2 If the Welcome page appears, click Next.

3 On the Export / Import Task Selection page, select the data store file you
created when you exported the 6.x data, and click Next.

4 On the PasswordProtection page, if a password was used when the data was
exported, enter that password.

5 On the Importer Configuration page, select the data to import, and click
Next.

See “Exporter Configuration or Importer Configuration page” on page 60.

6 On the ProductReadinessCheck page, review the messages, and click Next.

This page displays each product that has data that is not included in the
import. To view an explanation of why the data is not included, click in the
Message column.

7 On the Task Summary page, verify the migration tasks the wizard is about
to perform, and click Next.

8 When the message that the data import has completed successfully appears,
click OK.

If the data is not imported successfully, a message with instructions appears.

9 (Optional) To display each action’s sub-actions, check Show Details.

10 Click Finish.

Exporter Configuration or Importer Configuration page
These configuration pages let you select the products whose data you want to
migrate. For each product, you can select the exporters or importers to use. These
exporters or importers define what data is migrated. For each exporter or importer,
you can filter the data to export or import. To access these configuration pages,
run Symantec Notification Server Migration Wizard. The Exporter Configuration
page appears when the migration wizard runs in export mode. The Importers
Configuration page appears when the migration wizard runs in import mode.

See “About data migration” on page 49.

See “About the Symantec Notification Server Migration Wizard” on page 50.
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Table 3-6 Options on the configuration pages

DescriptionOption

Displays the products whose data you can migrate. Data is
exported or imported only for the products that are checked.

Products

Displays the exporters or importers for the product that is
selected in the Products section. Data is exported or
imported only for the exporters or importers that are
checked in the Enabled column.

Importers or Exporters

Displays a dialog box that lets you filter the data that an
exporter or importer migrates as follows:

■ You can uncheck any item that you do not want to
migrate.

■ The Details option lets you display the Filter Details
dialog box.

You can sometimes change a value on the FilterDetails
dialog box. For example, when you import a locally stored
package file, you can sometimes change the drive to
which it is migrated.

Filters

About the 6.x data that you must manually migrate to Symantec
Management Platform 7.1

When you migrate from Notification Server 6.x to Symantec Management Platform
7.1, not all of the data is migrated with the migration wizard. You must manually
migrate some data from the 6.x server to the 7.1 server. For some of the migrated
data, you must also complete additional manual steps to make the data fully
functional.

See “Migrating from Notification Server 6.x to Symantec Management Platform
7.1” on page 34.

See “About migrating licenses to Symantec Management Platform 7.1” on page 48.

The following products require some manual migration steps:

■ Inventory Solution
See “About manually migrating to Inventory Solution 7.1” on page 72.

■ Software Delivery Solution
See “Migrating from Software Delivery Solution 6.x to Software Management
Solution 7.1” on page 112.

■ Patch Management Solution
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See “Gathering and restoring your files and settings for Patch Management
Solution for Windows” on page 104.

■ Asset Management Solution
See “About migrating Asset Management Solution” on page 171.

■ Barcode Solution
See “Manually migrating your Barcode Solution files and settings” on page 166.

■ Out-of-band Management Solution
See “Manually migrating Out of Band Management Component to version 7.1”
on page 158.

■ Real-Time System Management Solution
See “About manually migrating Real-Time System Manager Solution files and
settings” on page 146.

■ Real-Time Console Infrastructure Solution
See “About manually migrating Real-Time Console Infrastructure files and
settings” on page 150.

You must also copy the licenses of your Notification Server 6.x products to a
location that is accessible from the 7.1 server.

About the data store file
A data store file stores Notification Server data. When you migrate Notification
Server 6.x to Symantec Management Platform 7.1 with the migration wizard, you
use a data store file. First, you export the 6.x data to a data store file. You then
import the data from the data store file into Symantec Management Platform 7.1.

See “About the Symantec Notification Server Migration Wizard” on page 50.

By default, the data store file is saved in the C:\Program Files\Altiris\Upgrade\Data
directory. It has an .adb extension, is easy to copy and back up, and is not
dependent on SQL.

You can view the data in a data store file with the Store Browser. If you perform
multiple imports, you can view the data to determine which data to import next.
The data store file organizes all the data except key data by product. The data for
each product is stored in tables. The name of each table is
ProductName.TableName.

See “Viewing the data in a data store file” on page 63.

About the Store Browser
The Store Browser lets you do the following with data store files:
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■ Analyze the data before you import it.
The Store Browser lets you view each table and the data in each row of a table
before you import the data. If you perform multiple imports, you can view the
data to determine what data to import next.

■ Export specific data to create a smaller data store file.
If you encounter errors when you import data, you may need to send a data
store file that contains the data to Symantec Technical Support. The Store
Browser lets you export specific data to create a smaller data store file that is
more portable.
See “Exporting data from a data store file” on page 64.

■ View differences between two data store files.
If you have two similar data store files, you can use the StoreDiff utility to
create a data store file that highlights their differences. The Store Browser
lets you open this data store file and view the differences.
See “Comparing two data store files” on page 65.

See “About the data store file” on page 62.

See “Viewing the data in a data store file” on page 63.

By default, the EXE for the Store Browser is installed at C:\Program
Files\Altiris\Upgrade. It is installed whenever the migration wizard is installed.

Viewing the data in a data store file
You use Symantec Notification Server Migration Wizard to migrate Notification
Server 6.x data to Symantec Management Platform 7.1. When you migrate data
with the migration wizard, you export the data to a data store file and then import
the data from the data store file. After you create a data store file, you can use the
Store Browser to view the data in the data store file.

See “About data migration” on page 49.

See “About the data store file” on page 62.

See “About the Store Browser” on page 62.

To view the data in a data store file

1 Start the Store Browser.

By default, this file is installed at C:\Program Files\Altiris\Upgrade.

2 In the Store Browser, on the File menu, click Open and select the data store
file.

3 In the Table Name column, select a table.

The rows of the table appear in the right pane.
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4 To search for specific data in a table, use the following options at the bottom
of the right pane:

Type a number of a table row, and click Refresh. The
table row becomes the first row in the right pane.

Starting index

Type the search criteria, and select the columns of the
table in which to perform the search. All rows in the
table that match the search criteria are highlighted.
To use regular expressions for the search criteria,
check Regex.

Find

Check this option to highlight the text that does match
the search criteria.

Inverse

Check this option to perform a search with regular
expressions. You then type the regular expression in
Find.

Regex

Click this option to complete the search.Refresh

Click this option to move to the next row that matches
the search criteria.

Find Next

5 If a table row has an Xml column, do the following to view the XML:

■ Double-click the row.

■ In the DataViewfor table dialog box, on the first Column drop-down list,
click the XML entry.
The XML appears in the Value pane.

■ On the second Column drop-down list, click View as XML.

Exporting data from a data store file
If you encounter errors when you import data from a data store file, you may need
to send the file to Symantec Technical Support. For a large file, you can use Store
Browser to create a data store that is a subset of the original data store file. You
can export the data that causes the errors and then send this smaller file to support
so that they can help resolve the problem.

See “About the Store Browser” on page 62.

See “About the data store file” on page 62.

When you export data with the Store Browser, you can select the data tables to
export and the specific rows in the data tables. You can specify the rows to export
with row numbers, row ranges, or a data string.
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To export data from a data store file

1 Double-click StoreBrowser.exe.

By default, this file is installed at C:\Program Files\Altiris\Upgrade. It is
installed whenever the migration wizard is installed.

2 In the StoreBrowser, on the File menu, click Open, and select the data store
file that contains the data.

3 On the File menu, click Export Data.

4 In the Export Data Form dialog box, in the Export column, check the tables
whose data you want to export.

The NSCore.ExporterVersionInfo table is always exported. It contains the
data that the migration wizard needs to import the data from the data store
file.

5 To export the data for specific rows of a table, click in the Rows to Export
column and specify the rows as follows:

■ In the Export Options Form dialog box, click Specified Rows.

■ To specify rows by row number, check Row Ranges, and list the rows.

■ To specify the rows that contain a data string, check Containing String,
and define the string.

■ Click OK.

6 In the Export Data Form dialog box, in Destination Store, specify the name
and location for the new data store file.

7 Click Export.

Comparing two data store files
You can export the same type of 6.x data to a data store file multiple times. If the
data on the 6.x server changes between exports, then subsequent data store files
contain differences. You can use the StoreDiff utility to compare two data store
files.

When you compare two data store files that are different, a data store file is created
that contains the differences. You then use Store Browser to view this data store
file and see the differences. You can use this information to determine the data
to import. The data store file that StoreDiff creates cannot be used to import data
into Symantec Management Platform 7.1.

See “About the data store file” on page 62.

See “About the Store Browser” on page 62.
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To compare two data store files

1 Start the StoreDiff utility.

By default, the EXE for the StoreDiff utility is installed in the C:\Program
Files\Altiris\Upgrade directory. It is installed whenever the migration wizard
is installed.

2 On the Compare Data Stores dialog box, click Browse to select each of the
data store files.

3 In Diff Store, specify the name and location for the new data store file.

This data store file highlights the differences between the two data stores.

4 Click Generate Diff.

5 On the message that appears, click OK.

The message either states that the two data store files are identical or that a
new data store file is generated. If a new data store file is generated, the Store
Browser opens.

6 In the Store Browser, on the File menu, click Open, and select the new data
store file.

7 On the Diff Store Summary dialog box, click OK.

This dialog box lists the data store files that are compared in this new data
store file.

This dialog box also has the following color key for the differences between
the two data store files:

New data that exists only in the second data store.Green

Deleted data that exists only in the first data store.Yellow

Data that exists in both data stores but is different.Salmon

8 In the left pane of the Store Browser, select a table that is shaded with one
of the three colors.

Only the tables that have differences between the two data store files are
shaded.

9 In the right pane, view the rows that have differences between the two data
store files.

10 If a table row has an Xml column, do the following to view the XML:

■ Double-click the row.
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■ In the DataViewfor table dialog box, on the first Column drop-down list,
click the XML entry.
The XML appears in the Value pane.

■ On the second Column drop-down list, click View as XML.
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Migrating Inventory
Solution

This chapter includes the following topics:

■ Before you migrate to Inventory Solution 7.1

■ About migrating to Inventory Solution 7.1 with Symantec Notification Server
Migration Wizard

■ About manually migrating to Inventory Solution 7.1

■ Process for manually migrating your custom inventory script files

■ Process for manually migrating your Inventory Solution baseline configuration
files

■ Data migration to Inventory for Network Devices 7.1

Before you migrate to Inventory Solution 7.1
To successfully migrate to Inventory Solution 7.1, perform the following
preliminary actions:

■ If your Inventory Solution version is earlier than 6.1.1075 SP2, you must
upgrade it to the latest 6.x Service Pack before you migrate to 7.1. Before the
upgrade to the latest Service Pack, ensure that the following steps are
performed:

■ Normalize the inventory data classes that are available for normalization.
In the AltirisConsole6.0, you can view these data classes at Configuration
> Solutions Settings > Assets and Inventory > Inventory > Windows >
Normalize.
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In the Altiris Console 6.5, you can view these data classes at Configure >
Solutions > Inventory > Windows > Normalize.
Normalization can take a long time depending on the size of the tables of
the data classes’ target.

■ Remove predefined special groups. You can leave your custom special
groups, though no upgrade is supported for them.
In the Altiris Console 6.0, you can view your special groups and AeX SW
data classes at Configuration > Resource Settings > Data Classes >
Inventory > Software.
In the Altiris Console 6.5, you can view your special groups and AeX SW
data classes at View > Configuration > Resource Settings > Data Classes
> Inventory > Software.
For more information about removing the predefined special groups, see
the article at http://www.symantec.com/docs/HOWTO7373.

■ Check which items are not migrated with Symantec Notification Server
Migration Wizard, and then back up the items.
See “About migrating to Inventory Solution 7.1 with Symantec Notification
Server Migration Wizard” on page 70.
See “About manually migrating to Inventory Solution 7.1” on page 72.

About migrating to Inventory Solution 7.1 with
Symantec Notification Server Migration Wizard

To successfully migrate Inventory Solution, you perform the following types of
product migration:

■ Migration to Symantec Management Platform 7.1 with the Symantec
Notification Server Migration Wizard.
See “Before you migrate to Inventory Solution 7.1” on page 69.
See “Migrating from Notification Server 6.x to Symantec Management Platform
7.1” on page 34.
See “About data migration” on page 49.
See “About the Symantec Notification Server Migration Wizard” on page 50.
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Note: When the Altiris Agent 6.x is upgraded to the Symantec Management
Agent 7.1, error messages appear in Notification Server logs. The messages
notify you about failure to process some Notification Server events and load
inventory.

This behavior is expected in the transition period because the 6.x inventory
policies and data classes do not yet exist in the 7.1 database. After Inventory
agents (known as plug-ins in the 7.1 environment) get installed, the new
inventory policies and items are referenced. As a result, the errors no longer
occur in the logs.

■ Manual migration.
See “About manually migrating to Inventory Solution 7.1” on page 72.

The following items are automatically migrated during the upgrade from
Notification Server 6.x to Symantec Management Platform 7.1:

■ Predefined and custom 6.x inventory policies and tasks are upgraded to the
equivalent 7.1 task-based policies.

Note: For successful migration, 6.x custom inventory tasks should be located
in the predefined folders. Currently, migration is not supported for custom
created folders with custom inventory tasks.

The schedules and advanced options of the policies are not migrated. The tasks
are not scheduled.

■ Predefined and custom 6.x application metering policies are migrated.
The migrated policies preserve their settings. That is, the policies that are
enabled in 6.x stay enabled, and the policies that are disabled in 6.x stay
disabled. The policies are applied to all computers with the Application
Metering Plug-in installed.

Note: The schedules and advanced options of the policies are not migrated.

■ 6.x predefined data classes are migrated into the legacy 6.x data classes in the
7.1 database for reporting purposes.
New inventory data that is collected in the 7.1 environment goes into the 7.1
predefined data classes.

■ 6.x custom data classes are migrated into the legacy 6.x data classes in the 7.1
database for reporting purposes.
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New relevant custom inventory data that is collected in the 7.1 environment
goes into these migrated data classes.

■ 6.x inventory data from 6.x data classes.

The following items are not migrated with the Symantec Notification Server
Migration Wizard to the 7.1 database due to extensive changes in the database
structure:

■ Inventory agent is not upgraded but Inventory Plug-in gets installed instead.

■ Inventory Solution 6.x configuration settings.

■ Predefined and custom 6.x inventory reports.

Note: During the upgrade, 7.1 inventory reports are updated to show the 6.x
data. So you can view the information from 6.x predefined inventory reports
in 7.1 reports.

■ Application Metering Solution 6.x configuration settings.

■ 6.x application metering predefined and custom reports, data classes, and
data.

■ 6.x history data classes.

■ Stand-alone inventory packages.
You cannot migrate your stand-alone packages from version 6.x to version
7.1. The data class schema for stand-alone packages is different in version 7.1.
The format for sending Notification Server events is different in version 7.1.
Consequently, if you attempt to use your version 6 stand-alone packages in
version 7, the information fails to load into the Symantec Configuration
Management Database.

■ Custom inventory script files for Windows and for UNIX, Linux, and Mac.
See “Process for manually migrating your custom inventory script files”
on page 73.

■ Inventory baseline configuration and snapshot files.
See “Process for manually migrating your Inventory Solution baseline
configuration files” on page 93.

About manually migrating to Inventory Solution 7.1
When you use the Symantec Notification Server Migration Wizard to migrate to
7.1, some of your Inventory Solution files and settings do not migrate. This
situation occurs because of the extensive changes in the database structure. To
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preserve these files and settings, you must manually migrate them from your
previous Notification Server computer to your Notification Server 7.1 computer.
After you move these files to your new environment, you must complete
configuration steps to make them operate correctly.

See “Before you migrate to Inventory Solution 7.1” on page 69.

See the following for information about manually migrating Inventory Solution
items:

■ Custom inventory script files for Windows and for UNIX, Linux, and Mac.
You can manually migrate your custom inventory script files. However, you
must perform custom configuration steps to make them operate correctly in
the 7.1 environment.
See “Process for manually migrating your custom inventory script files”
on page 73.

■ Inventory baseline configuration and snapshot files.
You can use the Symantec Notification Server Migration Wizard to migrate
the baseline files. However, you have to perform some additional steps to verify
that the data has migrated successfully.
See “Process for manually migrating your Inventory Solution baseline
configuration files” on page 93.

Process formanuallymigrating your custom inventory
script files

You can manually migrate your custom inventory script files. However, you must
perform custom configuration steps to make them operate correctly in the 7.1
environment.

Table 4-1 Process for manually migrating your custom inventory script files
for Windows from 6.x to 7.1

DescriptionActionStep

Before you migrate your custom
inventory files, create a backup copy of
them in a neutral storage location.

See “Backing up your custom inventory
script files” on page 78.

Create a backup of your custom
inventory script files.

Step 1
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Table 4-1 Process for manually migrating your custom inventory script files
for Windows from 6.x to 7.1 (continued)

DescriptionActionStep

Migration to Inventory Solution 7.1
with the Symantec Notification Server
Migration Wizard lets you
automatically migrate a number of
Inventory Solution items.

See “About migrating to Inventory
Solution 7.1 with Symantec Notification
Server Migration Wizard” on page 70.

Perform the migration to
Inventory Solution 7.1 with the
Symantec Notification Server
Migration Wizard.

Step 2

Copy your custom inventory script files
to your Notification Server 7.1
computer.

When you install or upgrade to
Symantec Management Platform 7.1
on Windows computers, it
automatically creates a package
directory for storing your custom
inventory.

See “Copying your custom inventory
script files to your Notification Server
7.1 computer” on page 78.

Copy your custom inventory script
files to your Notification Server
7.1 computer.

Step 3

In version 6.x, there are several .INI
files that control the inventory
processes that run on client computers.

To run 6.x custom inventory in the 7.1
environment, you need to create similar
.INI or batch files to execute the desired
command lines.

See “About creating an .INI file for
custom inventory” on page 80.

Create .INI files.Step 4

Before setting up the software resource
package, you must ensure that the
certain prerequisites are met on your
Notification Server 7.1 computer.

See “Prerequisites for creating a custom
inventory software resource package”
on page 81.

Meet the prerequisites to create a
custom inventory software
resource package.

Step 5
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Table 4-1 Process for manually migrating your custom inventory script files
for Windows from 6.x to 7.1 (continued)

DescriptionActionStep

You need to create a software resource
with a package and a command line
before performing Quick Delivery
tasks.

A software resource is similar to the
software delivery package in 6.x.

A software resource contains the
package definition that includes the
path to the package, and the program
definition that includes the desired
command line.

See “Creating a software resource with
a package and a command line for
custom inventory script files”
on page 81.

Create a software resource with a
package and a command line.

Step 6

To successfully use your manually
migrated custom inventory script files
in the 7.1 environment, you need
Software Management Solution to
create and perform Quick Delivery
tasks.

See “Creating a Quick Delivery task for
a custom inventory script file”
on page 83.

Create a Quick Delivery task for
a custom inventory script file.

Step 7

Create a custom data class for a custom
inventory script task.

When you create the custom data class,
ensure that you enter the name and the
description for the data class from your
manually migrated custom inventory
script file.

See “Creating and customizing a data
class” on page 84.

Create a custom data class.Step 8
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Table 4-1 Process for manually migrating your custom inventory script files
for Windows from 6.x to 7.1 (continued)

DescriptionActionStep

Create a custom inventory script task
that gathers the custom inventory.

See “Creating a custom inventory script
task” on page 85.

When you customize the custom
inventory script task, ensure that you
add the logic to gather the data and
populate the attribute variables in the
script according to the data in your
manually migrated custom inventory
script file.

See “Customizing the custom inventory
sample script for Windows” on page 87.

Create a custom inventory script
task.

Step 9

Table 4-2 Process for manually migrating your custom inventory script files
for UNIX, Linux, and Mac from 6.x to 7.1

DescriptionActionStep

Before you migrate your custom
inventory files, create a backup copy of
them in a neutral storage location.

See “Backing up your custom inventory
script files” on page 78.

Create a backup of your custom
inventory script files.

Step 1

Migration to Inventory Solution 7.1
with the Symantec Notification Server
Migration Wizard lets you
automatically migrate a number of
Inventory Solution items.

See “About migrating to Inventory
Solution 7.1 with Symantec Notification
Server Migration Wizard” on page 70.

Perform the migration to
Inventory Solution 7.1 with the
Symantec Notification Server
Migration Wizard.

Step 2
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Table 4-2 Process for manually migrating your custom inventory script files
for UNIX, Linux, and Mac from 6.x to 7.1 (continued)

DescriptionActionStep

Copy your custom inventory script files
and packages to your Notification
Server 7.1 computer.

During installation or upgrade on UNIX,
Linux, and Mac platforms, Symantec
Management Platform 7.1 does not
create any special directory for storing
your custom inventory. You can define
by yourself where to store your custom
inventory script files for UNIX, Linux,
and Mac.

See “Copying your custom inventory
script files to your Notification Server
7.1 computer” on page 78.

Copy your custom inventory script
files and packages to your
Notification Server 7.1 computer.

Step 3

Create a custom data class for a custom
inventory script task.

When you create the custom data class,
ensure that you enter the name and the
description for the data class from your
manually migrated custom inventory
script file.

See “Creating and customizing a data
class” on page 84.

Create a custom data class.Step 4

Create a custom inventory script task
that gathers the custom inventory.

See “Creating a custom inventory script
task” on page 85.

When you customize the custom
inventory script task, ensure that you
copy and paste the script text from your
manually migrated custom inventory
script file.

See “Customizing the custom inventory
sample script for UNIX, Linux, and
Mac” on page 91.

Create a custom inventory script
task.

Step 5
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Backing up your custom inventory script files
This task is a part of the process for manually migrating your custom inventory
script files.

See “Process for manually migrating your custom inventory script files”
on page 73.

Before you migrate your custom inventory files, create a backup copy of them in
a neutral storage location.

To back up your custom inventory script files for Windows

1 On your previous Notification Server computer, copy all of your custom
inventory script files (.CIT, .XML, etc.) to a neutral storage location.

By default, your custom inventory script files are located on your previous
Notification Server computer in the following location:

■ C:\Program Files\Altiris\Notification

Server\NSCap\Bin\Win32\X86\Inventory Solution

The default location may not include other locations where you have placed
your custom inventory script files. Ensure that you also back up the custom
inventory script files that you have created outside of the default location.

2 On your previous Notification Server computer, copy all of your custom
inventory .INI files to a neutral storage location. These .INI files invoke the
AeXCustInv.exe file. By default, the naming convention for these files is
aexinvsoln*.EXE.

To back up your custom inventory script files for UNIX, Linux, and Mac

◆ On your previous Notification Server computer, copy all of your custom
inventory script files (.CIT, .XML, etc.) to a neutral storage location.

By default, your custom inventory script files are located on your previous
Notification Server computer in the following locations:

■ C:\Program Files\Altiris\Notification

Server\NSCap\Bin\Mac\Inventory

■ C:\Program Files\Altiris\Notification

Server\NSCap\Bin\Unix\Inventory\<PLATFORM>\<PROCESSOR TYPE>

Copying your custom inventory script files to your Notification Server
7.1 computer

This task is a part of the process for manually migrating your custom inventory
script files.
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See “Process for manually migrating your custom inventory script files”
on page 73.

When you install or upgrade to Symantec Management Platform 7.1 on Windows
computers, it automatically creates a package directory for storing your custom
inventory.

By default, the path to the custom inventory directory for Windows is C:\Program
Files\Altiris\Notification Server\NSCap\bin\Win32\X86\Inventory\Custom

Inventory 6.1.

The package directory for Windows contains the following files:

■ AeXInvSoln.exe

This file is the same as the file in 6.1 SP2. This file launches AeXCustInv.exe
and AeXNSInvCollector.exe as specified in AeXInvSoln.ini.

■ AeXCustInv.exe

This file differs from the file in 6.1 SP2. This file has bug fixes.

■ AeXNSInvCollector.exe

This file differs from the file in 6.1 SP2. This file behaves in a similar way to
the 6.1 SP2 file. However, this file generates Notification Server events (NSEs)
in the new format that is required to store inventory to your Notification Server
7.1 computer.

■ AeXNSEvent.dll

This file is new. AeXNSInvCollector.exe uses this file for generating NSEs in
the new format.

■ AeXInvSoln.ini

This file specifies an example of how to launch the AeXCustInv.exe and
AeXNSInvCollector.exe files.

■ AeXCustInvStd.cit

This file is a sample custom inventory script from version 6.1 SP2.

On UNIX, Linux, and Mac platforms, Symantec Management Platform 7.1 does
not create any special directory for storing your custom inventory. You can define
by yourself where to store your custom inventory script files for UNIX, Linux, and
Mac.
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To copy your custom inventory files to a Notification Server 7.1 computer

1 Copy all of your custom inventory script files for Windows (.CIT, .XML, etc.)
to C:\Program Files\Altiris\Notification

Server\NSCap\bin\Win32\X86\Inventory\Custom Inventory 6.1.

Copy all of your custom inventory script files for UNIX, Linux, and Mac to
the directory previously defined by you.

2 (Windows only) Copy all of your custom inventory .INI files to C:\Program

Files\Altiris\Notification

Server\NSCap\bin\Win32\X86\Inventory\Custom Inventory 6.1.

By default, the naming convention for these files is aexinvsoln*.EXE.

About creating an .INI file for custom inventory
(Windows only)

The task of creating an .INI file is a part of the process for manually migrating
your custom inventory script files.

See “Process for manually migrating your custom inventory script files”
on page 73.

In version 6.x, there are several .INI files that control the inventory processes
that run on client computers.

These .INI files contain batch type commands, similar to the following:

aexauditpls.exe /hidden /output xml

aexmachinv.exe

aexcustinv.exe /in .\AeXCustInvStd.cit /out AeXCustInvStd.nsi

aexsnplus.exe /output xml

aexnsinvcollector.exe /hidden /nsctransport /v default /useguid

To run 6.x custom inventory in the version 7.1 environment, you need similar
.INI or batch files to execute the desired command lines. These files need to be in
the same directory as the source .CIT or .XML files. By default, this directory is
C:\Program Files\Altiris\Notification

Server\NSCap\bin\Win32\X86\Inventory\Custom Inventory 6.1.

A sample .INI file AeXInvSoln.ini is included in this directory by default.

You can include all desired custom inventory script files in a single .INI file and
have a single software resource, package, command line, and task. However, you
may prefer to create multiple .INI files: one for each custom inventory or set of
custom inventory processes. Then each .INI file contains a software resource,
package, command line, and task for each custom inventory script file.
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Typically, the updated .INI file should do nothing more than run one or more
aexcustinv.exe command lines, followed by aexnsinvcollector.exe as the last
command in the file. However, it may also be necessary to include custom
commands or programs in the .INI file. In this scenario, it may be necessary to
run a third-party or custom application to collect data, create output data, and
have custom inventory gather that data and report it to Notification Server. The
.INI file is essentially a batch file that the client agent executes. Consequently, it
is possible to include other pertinent commands in the .INI file.

Following is an example of how an .INI file for a custom inventory task can look:

aexcustinv.exe /in .\win32_useraccount.xml /out win32_useraccount.nsi

aexnsinvcollector.exe /hidden /nsctransport /v default /useguid

A good practice is to keep the source .XML file name and the .nsi output file name
identical.

Prerequisites for creating a custom inventory software resource
package

(Windows only)

The task of meeting the prerequisites is a part of the process for manually
migrating your custom inventory script files.

See “Process for manually migrating your custom inventory script files”
on page 73.

Before setting up the software resource package, you must ensure that the
following prerequisites have been met on your Notification Server 7.1 computer:

■ Java 2 JRE 1.6 is required for some Symantec Management Console screens.

■ The appropriate interpreters for Perl, Python, VBScript, etc. must be installed.

■ The Symantec Management Agent and Software Management Solution plug-in
must be installed on each client computer.

■ The 7.1 version of aexinvcollector.exe must exist on the 7.1 Notification
Server computer. This file is installed by default as part of the installation.

■ Ensure that the 6.x custom inventory data classes are migrated. Create new
custom inventory data classes if needed.

Creating a software resource with a package and a command line for
custom inventory script files

(Windows only)
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This task is a part of the process for manually migrating your custom inventory
script files.

See “Process for manually migrating your custom inventory script files”
on page 73.

A software resource is similar to the software delivery package in 6.x.

A software resource contains the package definition that includes the path to the
package, and the program definition that includes the desired command line.

To create a software resource for custom inventory script files

1 In the SymantecManagementConsole, on the Manage menu, click Software
Catalog.

2 On the Manage Software Catalog page, click Import.

3 On the ImportSoftware:SpecifySoftware page, perform the following steps:

Select Software Release.Software type

In the Source field, select Access Package from an
existing UNC.

In the Location field, browse to:
\\local_NS7_servername\nscap\bin\win32\x86\Inventory\Custom

Inventory 6.1

Package source

Click Display Location and select AeXInvSoln.exe.

Click Set Installation File.

Click Next.

Package contents

4 Select Create a new software resource and enter a name for the package.

5 Make sure that Opensoftwareresourceforeditingwhenfinished is checked.

6 Click OK.

7 On the Software Resource editing page, click the Package tab.

8 In the CommandLines section, click Addcommand. aexinvsoln.exe should
be the command line.

9 Click Edit.
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10 On the Add or Edit Command Line page, perform the following steps:

Enter Custinv - Win32_UserAccount - CommandLineName

Select this option.Command line requires a
package

Select the name that you entered when you created
the software resource package.

Package

Select EXE Software Installation File.Installation File Type

Select Custom.Command Type

Enter AeXInvSoln.exe /s win32_useraccountCommand Line

11 Click OK.

12 Click Save Changes.

Creating a Quick Delivery task for a custom inventory script file
(Windows only)

This task is a part of the process for manually migrating your custom inventory
script files.

See “Process for manually migrating your custom inventory script files”
on page 73.

To successfully use your manually migrated custom inventory script files, you
need Software Management Solution to perform Quick Delivery tasks.

For more information, see the topics about managed software delivery in the
Software Management Solution Help.

To create a Quick Delivery task for a custom inventory script file

1 In the SymantecManagementConsole, on the Manage menu, click Jobsand
Tasks.

2 In the left pane, expand System Jobs and Tasks > Software.

3 Right-click the QuickDelivery folder under which you want to create a task,
and then click New > Task.

4 In the Create New Task dialog box, in the left pane, under Software, click
Quick Delivery.

5 Change the Name of the task.
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6 Under Software, select a custom inventory software resource package to
deliver.

7 Under Command line, select a command line.

8 Under Package, select an installation package.

9 Click OK.

10 (Optional) To run the task immediately, click Quick Run.

Alternatively, you can click New Schedule to schedule the task.

Creating and customizing a data class
This task is a part of the process for manually migrating your custom inventory
script files.

See “Process for manually migrating your custom inventory script files”
on page 73.

From the Symantec Management Console, you can create a custom data class.
You can add, edit, and delete attributes of the data class and you can change the
position of the attribute. You can also find the GUID and view the data in the data
class.

Be aware that every time you modify an attribute and you save the changes, the
data class is assigned a new GUID.

For more information, see the topics about custom inventory data classes and
about gathering custom inventory in the Inventory Solution Help.

To create and customize a data class

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, under Settings, expand DiscoveryandInventory>Inventory
Solution, and then click Manage Custom Data classes.

3 To create a data class, do the following:

■ On the Manage Custom Data Classes page, click New data class.

■ Enter a name and a description for the data class and click OK.
The name of the new data class must be unique.

4 To customize a data class, on the Manage Custom Data Classes page, in the
data classes list, click the data class.

5 (Optional) To add an attribute to the data class, do the following:

■ Click Add attribute.
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■ In the DataClassAttribute dialog box, specify the details of the attribute.
To add an attribute that uniquely defines a row in the data class, click Yes
in the Key drop-down list. You enforce that the attribute always has a
unique value that is other than NULL.
If the attribute should never be empty or blank, click Yes in the Data
required drop-down list. If you click Yes in the Key drop-down list, the
Data required option is automatically set to Yes. You cannot change it
unless you click No in the Key drop-down list.

■ Click OK.

6 (Optional) To edit or delete the attributes, select the attribute, and then click
the Edit or Delete symbols.

7 (Optional) To let the data class store inventory of multiple objects, check
Allow multiple rows from a single computer resource. The data class can
store the inventory of services, user accounts, files, network cards, and other
objects.

When you report inventory values for the columns in a Notification Server
Event (NSE), the attributes are identified by the column ID and not by the
column name. As a result, the order of attributes in a data class must be
correct. On the Manage Custom Data Classes page, you can also specify the
sequence of the attributes.

8 Click Save changes.

Warning:The final step of saving changes is very important. When you create
any data class or add any attributes, all the information is stored in memory.
Nothing is created in the database and on details page, no GUID is yet assigned.
As a result, a 00000000-0000-0000-0000-000000000000 GUID is displayed
in the property of the data class. Only after you click Save changes on the
Manage Custom Data Classes page, the data class is saved in the database,
and the GUID is generated. Note that the GUID changes every time you make
changes to the definition of the data class and save it.

Creating a custom inventory script task
This task is a part of the process for manually migrating your custom inventory
script files.

See “Process for manually migrating your custom inventory script files”
on page 73.
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After you have created the custom inventory data class, you create a custom
inventory script task that gathers the custom inventory. The script task is
configured with the script to gather the custom inventory and the schedule of the
task.

See “Creating and customizing a data class” on page 84.

To create a custom inventory script task, you can clone a sample script task and
modify it with the custom data classes that you created. You can also create an
inventory script task on the Jobs and Tasks Portal page.

Note: The process of creating a custom inventory script task is the same across
all platforms: Windows, UNIX, Linux, and Mac. However, the scripting language
and the logic that is used in the scripts are different.

For more information, see the topics about gathering custom inventory in the
Inventory Solution Help.

To clone a sample custom inventory script task

1 In the Symantec Management Console, on the Manage menu, click Jobs and
Tasks.

2 In the left pane, under Jobs and Tasks, expand Samples > Discovery and
Inventory > Inventory samples > Custom.

3 Right-click the sample custom inventory script task and click Clone.

4 In the Clone Item dialog box, give the cloned script a descriptive name and
click OK.

5 (Optional) Customize the sample script and click Save changes.

Depending on the selected script type, you have different options to customize
the script.

See “Customizing the custom inventory sample script for Windows”
on page 87.

See “Customizing the custom inventory sample script for UNIX, Linux, and
Mac” on page 91.

6 Under Task Status, schedule the task to run on client computers.

For more information, see the topics about running a task in the Symantec
Management Platform Help.
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To create a custom inventory script task

1 In the Symantec Management Console, on the Manage menu, click Jobs and
Tasks.

2 In the left pane, right-click Jobs and Tasks, and then click New > Task.

3 In the Create New Task dialog box, in the left pane, click Run Script.

4 In the right pane, enter a descriptive name for the task.

5 In the Script type drop-down list, select the script type.

6 Enter your own script or copy a sample custom inventory script to the script
editor.

To access a sample custom inventory script, do the following:

■ In the Symantec Management Console, on the Manage menu, click Jobs
and Tasks.

■ In the left pane, under Jobs and Tasks, expand Samples > Discovery and
Inventory > Inventory samples > Custom.

7 (Optional) Customize the sample script and click OK.

Depending on the selected script type, you have different options to customize
the sample script.

See “Customizing the custom inventory sample script for Windows”
on page 87.

See “Customizing the custom inventory sample script for UNIX, Linux, and
Mac” on page 91.

8 Under Task Status, schedule the task to run on client computers.

For more information, see the topics about running a task in the Symantec
Management Platform Help.

Customizing the custom inventory sample script for Windows
(Windows only)

This task is a part of the process for manually migrating your custom inventory
script files.

See “Process for manually migrating your custom inventory script files”
on page 73.

The easiest way to create a new custom inventory script task is to clone the existing
sample and customize it according to your needs. The sample script for Windows
already contains the required code for a WMI query. You only need to add your
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own logic to gather the data that you want and to populate the attribute variables
in the script.

Note that every time you create or edit an existing custom data class, the data
class is assigned a new GUID. You must manually update the script with the new
GUID, if it refers to the older GUID for the same custom data class.

See “Creating a custom inventory script task” on page 85.

For more information, see the topics about gathering custom inventory in the
Inventory Solution Help.

To customize the custom inventory sample script for Windows

1 Clone or open an existing sample of the custom inventory script task.

2 Specify the values that you want to gather.

Example:

strComputer = "."

Set objWMIService = GetObject("winmgmts:" &

"{impersonationLevel=impersonate}!\\" & strComputer &

"\root\cimv2")

'Fire WMI Query

Set objCIMObj = objWMIService.ExecQuery("select * from

CIM_processor")

3 Replace the GUID with the GUID of the data class that you created.

Example:

set objDCInstance = nse.AddDataClass ("{e8220123-4987-4b5e-bc39-

ec6eaea312ef}")

To access the GUID of the data class that you created, do the following:

■ In the Symantec Management Console, on the Settings menu, click All
Settings.

■ In the left pane, under Settings, expand Discovery and Inventory >
Inventory Solution, and then click Manage Custom Data classes.

■ On the ManageCustomDataClasses page, select the data class and click
the Details symbol.
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4 Update attributes of the data class.

Example:

For each objInfo in objCIMObj

'Add a new row

dim objDataRow

set objDataRow = objDataClass.AddRow

'Set columns

objDataRow.SetField 0, objInfo.DeviceID

objDataRow.SetField 1, objInfo.L2CacheSize

objDataRow.SetField 2, objInfo.L2CacheSpeed

Next

5 Click Save changes.

Custom inventory sample script for Windows
The sample inventory script for Windows does the following:

■ Creates a WMI object, runs a WMI query, and stores the result set.

■ Creates an Notification Server event (NSE) object.

■ Creates an Inventory data block and associates it with a specific custom data
class.

■ Loops through each row in the result set and populates each row of the result
set into a row in the data block.

■ Processes and sends the NSE to Notification Server.

See “Customizing the custom inventory sample script for Windows” on page 87.

The following is a sample script:

'The following is a sample custom inventory script gathering

information about the processor of a computer and posting data to

the server using Altiris NSE Component

'========================================================================================

' On Error Resume Next

'Create instance of Wbem service object and connect to namespace

strComputer = "."
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Set objWMIService = GetObject("winmgmts:" &

"{impersonationLevel=impersonate}!\\" & strComputer & "\root\cimv2")

'Fire WMI Query

Set objCIMObj = objWMIService.ExecQuery("select * from CIM_processor")

'========================================================================================

'Create instance of Altiris NSE component

dim nse

set nse = WScript.CreateObject ("Altiris.AeXNSEvent")

' Set the header data of the NSE

' Please don't modify this GUID

nse.To = "{1592B913-72F3-4C36-91D2-D4EDA21D2F96}"

nse.Priority = 1

'Create Inventory data block. Here assumption is that the data class

with

below guid is already configured on server

dim objDCInstance

set objDCInstance = nse.AddDataClass ("{e8220123-4987-4b5e-bc39-

ec6eaea312ef}")

dim objDataClass

set objDataClass = nse.AddDataBlock (objDCInstance)

For each objInfo in objCIMObj

'Add a new row

dim objDataRow

set objDataRow = objDataClass.AddRow

'Set columns

objDataRow.SetField 0, objInfo.DeviceID

objDataRow.SetField 1, objInfo.L2CacheSize

objDataRow.SetField 2, objInfo.L2CacheSpeed

Next
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nse.SendQueued

Customizing the custom inventory sample script for UNIX, Linux, and
Mac

(UNIX, Linux, and Mac only)

This task is a part of the process for manually migrating your custom inventory
script files.

See “Process for manually migrating your custom inventory script files”
on page 73.

The custom inventory script for UNIX, Linux, and Mac generates a text output
that contains the collected inventory data in a specified format. This data is used
to create the NSE and is posted into the Configuration Management Database
(CMDB). The logic of creating the NSE and posting the data is hidden from the
user.

When you customize the sample script, you can modify the output that the script
generates.

See “Creating a custom inventory script task” on page 85.

For more information, see the topics about gathering custom inventory in the
Inventory Solution Help.

To customize the custom inventory sample script for UNIX, Linux, and Mac

1 Clone or open an existing sample of the custom inventory script task.

Note that the first lines of the script should not be changed. Changes should
be made after the # SCRIPT_BEGINS_HERE label.

2 Specify the data class.

Example:

echo UNIX_PS_List

3 Specify the delimiters.

Example:

echo "Delimiters=\" \" "

4 Specify the data type and the length of each column.

Example:

echo string20 string20 string20 string256
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5 Specify the column names.

Example:

echo PID Terminal Time Command

Note that the column names are not used in 7.x custom inventory. The column
names are left for backward compatibility with 6.x Inventory Solution. You
can leave this line empty in 7.x.

6 Specify commands to retrieve data from system.

Example:

ps -e

7 Click Save changes.

Custom inventory sample script for UNIX, Linux, and Mac
The sample inventory script for UNIX, Linux, and Mac does the following:

■ Includes a helper script that implements the logic of creating NSE and posting
it to Configuration Management Database (CMDB).

■ Specifies the data class.

■ Specifies delimiters for use in parsing the data that is returned from the
command that runs.

■ Specifies the data type and length of each column.

■ Specifies the column names. The column names are only required when the
command that runs does not already include column headings.

■ Runs the desired command. In this case, appropriate platform-specific
commands run.

See “Customizing the custom inventory sample script for UNIX, Linux, and Mac”
on page 91.

The following is a sample script:

. `aex-helper info path -s INVENTORY`/lib/helpers/custominv_inc.sh

#

# Sample script for custom inventory

# The first line of code should be always included at the begin of

the script

# Actual script for collecting inventory data begins after the

following label:
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# SCRIPT_BEGINS_HERE

#!/bin/sh

echo UNIX_PS_List

echo "Delimiters=\" \" "

echo string20 string20 string20 string256

echo PID Terminal Time Command

if [ "`uname -s`" = "Darwin" ] ; then

ps -ax | sed -e "1d" | awk '{print $1 " " $2 " " $4 " " $5 " " }'

else

ps -e | sed -e "1d" | awk '{print $1 " " $2 " " $3 " " $4 " " }'

fi

Process for manually migrating your Inventory
Solution baseline configuration files

You can use the Symantec Notification Server Migration Wizard to migrate the
baseline files. However, you have to perform some additional steps to verify that
the data has migrated successfully.

Table 4-3 Process for manually migrating your Inventory Solution baseline
configuration files

DescriptionActionStep

Before you decommission your previous
Notification Server computer, back up
your baseline configuration files to a
neutral storage location.

See “Backing up your Inventory
Solution baseline configuration files”
on page 95.

Create a backup of your baseline
configuration files.

Step 1
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Table 4-3 Process for manually migrating your Inventory Solution baseline
configuration files (continued)

DescriptionActionStep

Export your baseline configuration file
data to a data store file.

You perform this step with the
Symantec Notification Server Migration
Wizard.

During the export, make sure that the
following actions are done on the
Exporter Configuration page:

■ Under Products, select Application
Management Solution.

■ Under Exporters, make sure that
Enable is checked for Baseline
Package Resource File Exporter.

■ Click Filters to view the Filters for
Baseline Package Resource File
Exporter dialog box, and then
ensure that the dialog entry is
populated and enabled.

See “Exporting Notification Server 6.x
data to a data store file ” on page 57.

Export your baseline
configuration file data.

Step 2

After you install the Symantec
Management Platform, copy your
baseline configuration files and the
exported data store file to the 7.1
Notification Server computer.

See “Copying your Inventory Solution
baseline configuration files to the 7.1
Notification Server computer”
on page 95.

Copy your baseline configuration
files and the data store file to the
7.1 Notification Server computer.

Step 3

Import your baseline configuration file
data from a data store file.

You perform this step with the
Symantec Notification Server Migration
Wizard.

See “Importing Notification Server 6.x
data from a data store file” on page 59.

Import your baseline
configuration file data.

Step 4
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Table 4-3 Process for manually migrating your Inventory Solution baseline
configuration files (continued)

DescriptionActionStep

After you imported your baseline
configuration files on the 7.1
Notification Server computer, you
should verify that your baseline
configuration files are successfully
migrated.

See “Verifying the migration of your
baseline configuration files”
on page 96.

Verify that your baseline
configuration files are
successfully migrated.

Step 5

Backing up your Inventory Solution baseline configuration files
This task is a part of the process for manually migrating your Inventory Solution
baseline configuration files.

See “Process for manually migrating your Inventory Solution baseline
configuration files” on page 93.

Before you decommission your previous Notification Server computer, back up
your baseline configuration files to a neutral storage location.

To back up your Inventory Solution baseline configuration files

◆ On your previous Notification Server computer, copy all of your baseline
configuration files in the folders FileBaselinePackage and
RegBaselinePackage to a neutral storage location.

By default, your baseline configuration files are located on your previous
Notification Server computer in the following location:

■ %InstallDir%\Altiris\Notification

Server\NSCap\Bin\Win32\X86\Application Mgmt Solution

The default location may not include other locations where you have placed
your baseline configuration files. Ensure that you also back up the baseline
configuration files that you have created outside of the default location.

Copying your Inventory Solution baseline configuration files to the 7.1
Notification Server computer

This task is a part of the process for manually migrating your Inventory Solution
baseline configuration files.
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See “Process for manually migrating your Inventory Solution baseline
configuration files” on page 93.

After you install the Symantec Management Platform, copy your baseline
configuration files and the exported data store file to the 7.1 Notification Server
computer.

See “Backing up your Inventory Solution baseline configuration files” on page 95.

See “Exporting Notification Server 6.x data to a data store file ” on page 57.

To copy your Inventory Solution baseline configuration files and the exported data
store file to the 7.1 Notification Server computer

1 Copy the FileBaselinePackage and RegBaselinePackage folders with your
baseline configuration files from your neutral storage location.

2 Copy the exported data store file from your previous Notification Server
computer.

By default, the data store file is saved in the C:\Program

Files\Altiris\Upgrade\Data directory.

The data store file has an .adb extension, is easy to copy and back up, and is
not dependent on SQL.

See “About the data store file” on page 62.

3 On your 7.1 Notification Server computer, paste your baseline configuration
and the exported data store file to the same location. The recommended
location is %InstallDir%\Program Files\Altiris\Upgrade\Data

Create the Data folder if it is not already created.

Verifying the migration of your baseline configuration files
This task is a part of the process for manually migrating your Inventory Solution
baseline configuration files.

See “Process for manually migrating your Inventory Solution baseline
configuration files” on page 93.

After you imported your baseline configuration files on the 7.1 Notification Server
computer, you should verify that your baseline configuration files are successfully
migrated.

See “Importing Notification Server 6.x data from a data store file” on page 59.

To verify the migration of your baseline configuration files

1 Verify that the imported baseline configuration files are located at the
following locations:
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■ The entire file that is related to the file baseline should be located at
%InstallDir%\Altiris\Notification

Server\NSCap\bin\Win32\X86\Inventory\Application

Management\FileBaselinePackage\6.x.

■ The entire file that is related to the registry baseline should be located at
%InstallDir%\Altiris\Notification

Server\NSCap\bin\Win32\X86\Inventory\Application

Management\RegBaselinePackage\6.x.

2 Verify that the 6.x baseline task is imported into the Configuration
Management Database.

You can view the baseline task in the Symantec Management Console, on
the Manage menu, at Jobs and Tasks > System Jobs and Tasks > Discovery
and Inventory > Inventory > Baseline Task 6.x.

3 On the Run sample baseline page, verify that the files that are associated
with the 6.x baseline task are associated with the imported baseline task in
7.1.

4 (Optional) Perform manual steps to associate the unassociated baseline
configuration files to the imported baseline task.

To manually associate a baseline configuration file to a baseline task

1 Copy a baseline configuration file from the 6.x Notification Server computer
to the 7.1 Notification Server computer.

■ For the file baseline .bls files, the recommended folder is
%InstallDir%\Altiris\Notification

Server\NSCap\bin\Win32\X86\Inventory\Application

Management\FileBaselinePackage.

■ For the registry baseline .bls files, the recommended folder is
%InstallDir%\Altiris\Notification

Server\NSCap\bin\Win32\X86\Inventory\Application

Management\RegBaselinePackage.

2 On the 7.1 Notification Server computer, in the Symantec Management
Console, on the Manage menu, click Jobs and Tasks.

3 In the left pane, under Jobs and Tasks, click System Jobs and Tasks >
Discovery and Inventory > Inventory > Baseline Task 6.x > Run sample
baseline.

4 On the Run sample baseline page, perform one of the following steps,
depending on your requirement:
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■ Click Compile a baseline snapshot, and then click Use custom baseline
configuration.

■ Click Compare with a baseline snapshot, and then click Compare with
custom baseline snapshot.

5 Click Browse, and then browse to the baseline configuration file that you
have copied in step 1.

The following is an example of the baseline configuration file path:
\\localhost\NSCap\bin\Win32\X86\Inventory\Application

Management\FileBaselinePackage\6.x\sample.bls.

6 Click Save changes.

Data migration to Inventory for Network Devices 7.1
You perform the product migration from 6.x to 7.1 according to the migration
scenario for Inventory Solution and IT Management Suite.

See “Before you migrate to Inventory Solution 7.1” on page 69.

See “Migrating from Notification Server 6.x to Symantec Management Platform
7.1” on page 34.

See “About data migration” on page 49.

See “About the Symantec Notification Server Migration Wizard” on page 50.

During the migration from Inventory for Network Devices version 6.x , the
following data is migrated:
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■ Inv_SNMP_Host_Devices

■ Inv_SNMP_Host_Resources

■ Inv_SNMP_NW_Adapters

■ Inv_SNMP_NW_Disk_Storage

■ Inv_SNMP_NW_NLM

■ Inv_SNMP_NW_Partitions

■ Inv_SNMP_NW_Printers

■ Inv_SNMP_NW_Server

■ Inv_SNMP_NW_Settings

■ Inv_SNMP_NW_Settings_Descriptions

■ Inv_SNMP_NW_Volume

■ Inv_SNMP_Physical_Entities

■ Inv_SNMP_Printer (changes its name to
Inv_SNMP_HP_Printer in 7.x)

■ Inv_SNMP_Software

■ Inv_SNMP_Storage

■ Inv_SNMP_Win32_Print_Queues

■ Inv_SNMP_Win32_Services

■ Inv_SNMP_Win32_Shares

The data class list from 6.x to 7.x.

■ SNMPDeviceMap

■ SNMPTableMap

SNMP data mapping tables.

All MIB files in the 6.0
NetworkInventory\Mibs directory are
imported into the database during the
upgrade.

MIB files.
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Migrating Patch
Management Solution

This chapter includes the following topics:

■ About upgrading Patch Management Solution for Windows

■ About upgrading Patch Management Solution for Linux

■ About upgrading Patch Management Solution for Mac

■ Data that can be migrated from the 6.x version of Patch Management Solution
for Windows

■ About migrating downloaded software update package files

■ Gathering and restoring your files and settings for Patch Management Solution
for Windows

About upgrading Patch Management Solution for
Windows

Migration Wizard migrates most of your Patch Management Solution for Windows
6.x data and settings. There are a few key areas that do not migrate or require
some additional manual configuration, but these are not labor intensive areas.
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About upgrading Patch Management Solution for
Linux

Upgrading from Patch Management Solution for Linux 6.x is not supported and
no data can be migrated. Install and use the clean installation of Patch Management
Solution for Linux 7.1.

About upgradingPatchManagement Solution forMac
There was no 6.x version of Patch Management Solution for Mac.

Data that can be migrated from the 6.x version of
Patch Management Solution for Windows

Some of the Patch Management Solution for Windows 6.x items can be migrated.

Table 5-1 Patch Management Solution for Windows 6.x data migration
reference

DescriptionCan it be
migrated?

Item in 6.x

Your existing Software Update Agent policies
(for example, your patch reboot settings) are
migrated and converted into their version 7.1
equivalents.

YesSoftware Update Agent
policies

The core patch policies are migrated and
converted into their version 7.1 equivalents.

YesCore Patch Management
Solution policies

Your historical patch reporting data is
migrated to version 7.1.

YesHistorical patch reporting
data

The information about whether the package
is staged or not is migrated to 7.1.

YesPatch package staging status

The migration wizard lets you export the
downloaded software update package files from
the 6.0 server and store them in the same
location as the .adb file. You can then use the
migration wizard to import the files to the new
7.1 server.

See “About migrating downloaded software
update package files” on page 103.

YesPatch packages
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Table 5-1 Patch Management Solution for Windows 6.x data migration
reference (continued)

DescriptionCan it be
migrated?

Item in 6.x

You should run the PMImport Task as soon as
possible after the installation of Patch
Management Solution. Before you migrate,
review your 6.x import and staging settings so
that you can recreate them in the 7.1
environment.

This step should be the first post-installation
configuration step you take once you have
installed Patch Management 7.1 (and/or other
solutions) on the 64-bit server.

NoPMImport

Your reporting history is recreated after you
install the Symantec Management Agent 7.1
and Software Update Plug-in 7.1 on the target
computers. The Reporting history will recreate
automatically once the plug-in is installed and
has sent the data to the Notification Server
computer. A new agent database is used on the
client computer, but the same data classes are
used in version 7.1 as in version 6.x.

NoReporting History for each
client

Default patch collections are not migraed.NoDefault patch collections

You must import patch metadata (PMImport)
on the 7.1 server before you migrate data. After
migration the bulletin status will be the same
as in 6.x.

YesStatus of bulletins
(Enabled/Disabled)

Custom severities list and bulletin custom
severities are migrated.

YesCustom severities

About migrating downloaded software update
package files

In 7.1, the migration wizard lets you export the downloaded software update
package files from the 6.x server and store them in the same location as the .adb
file. You can then use the migration wizard to import the files to the new 7.1
server.
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Migration wizard will import the exported packages to the location that is specified
on the Core Settings page. This setting can be migrated from the 6.x server. In
case the migrated path is not available on the new server, the default location will
be used, which is C:\Program Files\Altiris\Patch

Management\Packages\Updates.

Note: Currently, migration wizard can migrate packages only if the Symantec
Management Platform is installed at the default location. If you installed Symantec
Management Platform to a custom location, you must manually move the software
update package files from migration folder to the desired location.

When you run the Import Patch Data task, the packages will be recreated (but
not redownloaded), and then appear in the Symantec Management Console.

Gathering and restoring your files and settings for
Patch Management Solution for Windows

You use the migration wizard to gather your files and settings for Patch
Management Solution. Some manual configuration is required.

To gather your files and settings for Patch Management:

1 One or two weeks before you migrate, on your previous Notification Server
computer, set the patch removal settings within the update policies for a
future date. This step retains the patches on the client computers and the
package servers within the architecture throughout the migration. You can
change these settings back to the previous settings after the updating of
package servers and the updating of agents is complete. Consider setting this
setting far in advance: for example, 1 year.

2 On your 7.1 Notification Server computer, mirror the ImportPatchData for
Microsoft task settings from the 6.x Notification Server's Microsoft Patch
Management Import task.

3 On the 7.1 Notification Server computer, run the Import Patch Data for
Microsoft task and allow it to complete.
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4 On the 7.1 Notification Server computer, stage the patches that your policies
need. You must stage these patches before the client computers check in to
the new 7.1 server.

Warning: If your package servers check in before your packages are staged,
then the packages may be deleted from the package servers in the architecture.
This situation can be harmful for slow link package servers because the client
computers that use them for their security patches will be unable to get them.

5 On the 6.x server, run the migration wizard to export your patch data from
the 6.x installation. When you run the wizard, ensure that all of the Patch
Management Solution data elements are selected for migration. This step
ensures that the software update packages are also exported and stored in
the same location as the .adb file.

6 On the 7.1 Notification Server computer, run the migration wizard to import
patch data and packages.

7 On the 7.1 Notification Server computer, verify that the package files were
migrated.

See “About migrating downloaded software update package files” on page 103.

8 Verify that the settings and policies match the 6.x server settings.

See “Data that can be migrated from the 6.x version of Patch Management
Solution for Windows” on page 102.
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Migrating Software Delivery
to Software Management
Solution

This chapter includes the following topics:

■ Things to know about migrating from 6.x to 7.1

■ Items that can and items that cannot be migrated from software delivery
solutions 6.x

■ Migrating from Software Delivery Solution 6.x to Software Management
Solution 7.1

Things to know about migrating from 6.x to 7.1
The following are things to consider if you want to migrate from Software Delivery
Solution 6.x to Software Management Solution 7.1:

■ Only upgrade from Software Delivery Solution 6.1 SP3 or SP4 is supported.

■ The Software Virtualization Solution must be upgraded to the latest released
version, which is 2.1.3062.

■ Symantec recommends that you apply any additional point hot fixes to Software
Delivery SP3 before upgrade. Having the hot fixes installed does not affect the
upgrade if you do have them applied.

■ The only physical packages that are migrated are the ones that are on the local
Notification Server drive. The packages are not converted into the software
library resources. You must take additional steps to move these packages into
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software resources in the library. For packages physically located on a UNC
share, the UNC path will be migrated.

■ For 7.1, you are not conducting an actual in-place upgrade, but are exporting
supported data from the old database and then using a migrating wizard to
put that data into the new structure after 7.1 is installed. This is called an
off-box upgrade.
Because you perform an off-box upgrade, take the following into consideration:

■ If the software library was located on the 6.x Notification Server computer,
you must manually move the physical files to the new 7.1 server. Migration
Wizard does not move these files.

■ If you were using a custom local path for the software resources on the 6.x
Notification Server, you must recreate the same file structure on the new
7.1 server.
For example, if the software resources were located on disk F:, you must
have disk F: on the new 7.1 computer too, otherwise the Software
Management Solution will not work.

■ If a path that is used in a software resource is longer than 248 characters,
the physical files cannot be migrated.
For example, Microsoft SQL Server 2008 folder structure can exceed 248
symbols. You can recreate the folder structure and migrate such files
manually.

■ The packages on the client computers are not kept and will be re-downloaded.

Items that can and items that cannot be migrated
from software delivery solutions 6.x

Data from the following 6.x software delivery solutions can be migrated to 7.1:

■ Software Delivery Solution (for Windows) 6.x

■ Software Delivery Solution for Linux, UNIX, and Mac 6.x

■ Software Vitalization Solution 6.x

Data from the following 6.x software management solutions cannot be migrated
to 7.1:

■ Application Management Solution 6.x

The following tables show the 6.x items that can or cannot be migrated.
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Table 6-1 Software delivery items that can and cannot be migrated

DetailsCan it be
migrated?

Item in 6.x

Software packages from Software Delivery
Solution 6.x and Software Vitalization Solution
6.x are imported as Software Package resources

Packages can be migrated however, you must
manually promote each package into the
Software Library. The estimated manual effort
is about 1 minute per package to promote a
package into the new framework.

YesSoftware Delivery packages

Software programs from Software Delivery
Solution 6.x and Software Vitalization Solution
are imported as Program items. The
association between a software package and
program is maintained during the migration
process.

Migrated software packages and programs do
not get automatically associated with an entry
in the Software Catalog. Following the
migration process, administrators can use the
migrated software packages (and related
program data) to create new entries in the
Software Catalog or associate them with
existing entries in the Software Catalog.

In case a 6.x program had the uninstall
command defined, in 7.1 it will appear as a
separate Software Command Line resource
with “uninstall” prefix in its name. The
association of migrated uninstall command
line with Software Resource is maintained.

The Execution Environment details set in the
actual Program object have been moved to
their equivalent in 7.1; execution environment
resides in Tasks, not in the Program Items.

YesSoftware Delivery programs
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Table 6-1 Software delivery items that can and cannot be migrated (continued)

DetailsCan it be
migrated?

Item in 6.x

Software Delivery Solution 6.x tasks are
migrated using the following rules:

■ Software Delivery tasks are imported as
Legacy Software Delivery policies

■ Software Delivery Task Server tasks are
imported as Package Deliveries

■ Sequential Software Delivery tasks are
imported as “Managed Deliveries”

YesSoftware Delivery tasks

Sequential Software Tasks are imported as
Managed Delivery Objects.

YesSequential Software tasks

Symantec Workspace Vitalization (SWV)
Solution 6.x tasks are migrated using the
following rules:

■ Virtual Software tasks are imported as
“Legacy Software Delivery policies”

■ SWV Task Server tasks are imported as
“SVS Command tasks”

YesSoftware Virtualization
Solution tasks

Symantec Workspace
Virtualization (SWV)
Solution 6.x tasks

Software Management Solution has more
robust, comprehensive reports that consolidate
like data and provide a greater range of
flexibility.

Some custom reports can be migrated from 6.0
to 7.1 for historical reporting purposes and
configuration only. Other Custom Reports are
not migrated.

This is due to the following reasons:

■ The events/tables, etc. are not the same
between Software Delivery 6.x and the
Software Management Solution 7.1

■ Task migrations do not include any event
data captured from the 6.x framework

■ Event data is not migrated with the Core
Notification Server migration

■ Task Server drives the majority of Tasks in
the 7.1 Framework

Yes and NoSoftware Delivery custom
reports
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Table 6-1 Software delivery items that can and cannot be migrated (continued)

DetailsCan it be
migrated?

Item in 6.x

Application Management Solution 6.x
installation state policies cannot be migrated
to 7.1.

Application Management is joined with
Software Management Solution. The
functionality can then be incorporated into the
larger Software Management Framework,
extending the possibilities. The drawback is
the lack of migration support available between
Application Management 6.x and Software
Management Solution. No Application
Management policies are migrated between
6.x and 7.1.

Record Settings and Configurations for all
active policies being used within Application
Management must be re-created.

The Windows Installer applications and tasks
to update Windows Installer source paths must
be re-created as Application Management
tasks.

The Installation state management policies
must be re-created as Managed Delivery
policies.

NoApplication Management

Application Management Solution 6.x tasks to
repair Windows Installer applications and
tasks to update Windows Installer source paths
must be re-created as Application Management
tasks in Software Management Solution.

NoApplication Management
Solution 6.x tasks to repair
Windows Installer
applications and tasks to
update Windows Installer
source paths

There are new software features for which
there is not equivalent migration data to
populate. This includes metadata within the
Software Catalog. These are new areas where
there currently is no data defined.

NoData for new features
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Table 6-1 Software delivery items that can and cannot be migrated (continued)

DetailsCan it be
migrated?

Item in 6.x

No Software Portal requests can be migrated.
This includes the automatically generated
items of a software request type, data related
to Software Portal requests submitted by users
and the policies created to fulfill requests.

NoSoftware Portal Requests

Software Portal tasks are not migrated. This
includes tasks that are generated either by an
automatically approved request or generated
by a manually approved request. The inks to
the single computer collections generated,
including sequential tasks, are not migrated.

NoSoftware Portal Tasks

Alert Manager Portal Requests are not
migrated. This includes the Helpdesk/Alert
Manager incidents that are created when
someone requests software that requires
approval.

NoSoftware Portal Alert
Manager requests

Software Portal Security settings are not
migrated. Security determines what software
a user can see based on what permissions that
user has been given to the Package/Program.
Take snapshots of all of your Portal
configurations before you migrate. These
configurations can be found under the
Software Portal tab of a Package/Program or
a Sequential Task.

NoSoftware Portal Security
settings

Software Portal configuration settings for a
software delivery package (e.g. “Install
Software” and “Install on Approval”) can be
migrated.

YesSoftware Portal
configuration settings

Migrating from Software Delivery Solution 6.x to
Software Management Solution 7.1

To upgrade Software Delivery Solution you must understand how its old data
structure relates to the new data structure of the Software Management
Framework. Many Software Delivery objects are upgraded into Symantec
Management Platform 7.1; however, not all objects can be migrated.
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Table 6-2 Process for migrating Software Delivery Solution 6.x to Software
Management Solution 7.1

DescriptionActionStep

See topics about ITMS migration in this
guide.

See “Migration Wizard objects” on page 113.

See “Things to know about migrating from
6.x to 7.1” on page 107.

See “Items that can and items that cannot
be migrated from software delivery
solutions 6.x” on page 108.

Use the Symantec
Management Platform
Migration Wizard to migrate
the majority of your Software
Delivery data.

Step 1

You must complete additional manual
migration steps to reach complete
functional parity.

See “About validating Software Package
Migration” on page 114.

Validate package migration.Step 2

You must convert each of your Software
Delivery packages into the equivalent
resource detail in the Software Catalogue.

See “Promoting migrated Software
Packages into the Software Library”
on page 115.

See “Viewing promoted packages as
software resources in the Software Library”
on page 117.

Convert the Software
Delivery packages.

Step 3

See “Enabling legacy software delivery
policies” on page 117.

Enable legacy software
delivery policies.

Step 4

See “About migrated Software Delivery
sequential tasks” on page 118.

Review the sequential
software delivery tasks.

Step 5

See “Viewing migrated task server
infrastructure software delivery tasks”
on page 118.

Review the task server
infrastructure tasks.

Step 6

Migration Wizard objects
The following table lists the objects of the Migration Wizard.
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Table 6-3 Software Delivery Solution objects in Migration Wizard

DescriptionObject

Migrates your Software Delivery Solution license over
to the new Software Management Solution.

Software Delivery Solution for
Windows License Certificate
Exporter/Importer

Exports or imports all Packages and Programs, as they
were previously defined.

Software Delivery Package and
Program Exporter/Importer

Exports or imports locally stored package files, not
UNC or HTTP based. This option is deselected by
default.

Software Delivery Package File
Exporter/Importer

Exports or imports standard Software Delivery Tasks.Software Delivery Task
Exporter/Importer

Similar to the software delivery package and program
exporter/importer except only SVS objects of the same
kind are targeted.

Virtual Software Package and
Program Exporter/Importer

Exports or imports physical VSPs stored locally on the
Notification Server computer . This option is deselected
by default.

Virtual Software Package File
Exporter/Importer

Similar to SWD but for SVS Tasks.Virtual Software Task
Exporter/Importer

Exports or imports specific Sequential Tasks, including
the links to the multiple Packages and Programs.

Sequential Software Delivery Task
Exporter/Importer

Exports or imports Task Server-based Tasks run by
the Software Delivery Agent for the Task Server
Plug-in.

Delivery Software Task
Exporter/Importer

SVS Tasks contained within Task Server.Virtual Software Command Task
Exporter/Importer

Exports or imports Events and Inventory for SVS.Virtual Software Data Class Data
Exporter /Importer

About validating Software Package Migration
After you migrate, the data can be used. By default the migrated packages can be
used with Delivery Software and Quick Delivery Tasks within the Task Server
infrastructure.
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The packages are located in the Symantec Management Console under Manage
> Resources > Organizational Views > Default > All Resources > Package >
SoftwarePackage. You should review the list to ensure that the packages you had
created on the 6.x platform are displayed correctly in this location.

The following article contains information about how to use these objects using
the same basic structure and functions from Software Delivery 6.1 in the 7.1
framework:

https://www-secure.symantec.com/community/article/5929/
introduction-software-management-notification-server-70-part-1-software-delivery

Promoting migrated Software Packages into the Software Library
Packages can be migrated; however you must manually promote each package
into the Software Library. The estimated manual effort is about 1 minute per
package to promote a package into the new framework.

To promote your packages to the Definitive Software Library, use the following
procedures:

■ See “To promote a package to a new software resource” on page 115.

■ See “To promote a package to an existing software resource” on page 116.

■ See “To promote several packages to new software resources” on page 116.

Once you have complete the wizard for a given package, you cannot promote that
package again. Verify the accuracy of the options before completing the wizard.

To promote a package to a new software resource

1 In the Symantec Management Console, on the Manage menu, go to Resources
> Organizational Views > Default > All Resources > Package > Software
Package.

2 On the package that you want to promote, right-click on the package and
click Resource Manager.

3 In the left pane, click Assign to Software Resource.

4 In the Assign Package to Software Resource wizard, in the Select software
resource dialog, click Create new software resource.

5 Enter a name for the software resource.

6 Choose a Type for the software resource. If you are unsure of what type to
use, select Software Release.

7 Use the Version field to track updates and changes to the software resource.

8 Software Product is not required but can be entered here.
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9 Click Next.

The conversion takes a Package/Program from 6.x and converts it into a
Package and Command-line for the 7.1 Platform. When promoting the package,
the command line goes with it and can be configured at this point. During
the migration, the installation file type is set to what is believed that the type
should be. Review to ensure that it is accurate.

10 Click Finish.

To promote a package to an existing software resource

1 In the Symantec Management Console, on the Manage menu, go to Resources
> Organizational Views > Default > All Resources > Package > Software
Package.

2 Right-click the package that you want to promote, and click Resource
Manager.

3 In the left pane, click Assign to Software Resource.

4 Select Use Existing software resource.

5 Click Select software resource.

6 In the list of software resources, select the resource that you want to promote
your package to become.

7 Review the command-line parameters to ensure that they are set correctly.

8 Click Finish.

To promote several packages to new software resources

1 In the Symantec Management Console, on the Manage menu, go to Resources
> Organizational Views > Default > All Resources > Package > Software
Package.

2 In the left pane, Ctrl+click to multi-select the packages that you want to
promote.

If the packages you want do not display in the window, you may need to enter
a filter to access them. In this case the multi-select feature still functions
correctly and you can continue to select multiple packages.

3 Right-click one of the packages that you selected and then click Assign to
Software Resources.

4 In the Assign Packages to Software Resources page, verify that all the
packages you intended to assign are displayed. Schedule the task to Runnow.

This task converts the packages into software resources, and stores them in
the software library.
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Viewing promoted packages as software resources in the Software
Library

After you promote your migrated packages into software resources, they are
available in the Software Library. In the Software Library you can view and modify
each software resource.

To view your promoted packages as software resources in the Software Library

1 In the Symantec Management Console, on the Manage menu, go to Software
> Software Catalog > Deliverable Software > Releases.

2 Double-click a package that you want to view.

3 In the software resource window, click the tabs to view and edit the
configuration settings of the resource Software publishing.

Enabling legacy software delivery policies
The migration wizard converts your previous software delivery tasks into software
delivery legacy policies. It stores these policies in a folder called Legacy Software
Delivery. After migration, these legacy policies are disabled by default.

If you want a specific policy to run you must enable it. You should review the
configuration and settings carefully before you choose to enable a legacy software
delivery policy. Some policies may fail to work correctly because not all settings
are migrated precisely due to the changes in Software Delivery version 7.

For example, in version 6 you may have chosen to have a task target the collection
all computers with software delivery agent. The software delivery agent is no
longer used. In this example the policy would be migrated, but the target for that
policy would be blank. You might need to target the policy to the filter of
computers, all computers with software management agent/plug-in to make it
work as you expect.

To enable legacy software delivery policies

1 In the Symantec Management Console, on the Manage menu, go to Policies
> Software > Legacy Software Delivery.

2 Select a policy that you want to enable.

3 Review the settings to make sure that they meet your requirements.

Consider the following items:

■ The GotoPackage link opens a page with details about the legacy package.
It does not reference the resource in the Software Library.

■ The Go to Program link opens the command-line interface. In version 7,
the resource type Program has been replaced by Command-line.
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■ The Advanced tab displays the execution environment as it was previously
defined in the type Program in version 6.

■ The former collection that was assigned to the Software Delivery task is
now called Target. Depending on the previous collection, the policy may
have a correct target assigned. You can now view and modify the policy's
target in the Applies To section.

4 Expand the schedule section and create a schedule for the policy.

5 Click Save Changes.

6 On the Policy Rules/Actions bar turn the policy on.

About migrated Software Delivery sequential tasks
The sequential tasks you created previously are converted into managed software
delivery policies. Even though they have been migrated, not all sequential tasks
convert into managed software delivery policies correctly. Before you attempt to
use one of these migrated managed delivery policies, you should review its settings
carefully to determine if it meets your expectations.

You can access the migrated sequential tasks in the Symantec Management Console
on the Manage menu at Policies > Software > Managed Software Delivery.

Determine whether creating a new managed delivery policy or a new task server
job can better meet the needs that you met with a sequential task. You can still
use your migrated packages (software resources) and your migrated programs
(command lines) when you create new policies and jobs. Task server jobs are best
for the following: multiple software rollouts, additional complex operations such
as AMT functions or scripting, or working on unmanaged targets. Managed delivery
policies are best for application state management, versioning control, and
intelligent deployment.

Viewing migrated task server infrastructure software delivery tasks
During migration, the migration wizard converts the task server software delivery
tasks into the new standard software management tasks. You can still use a Quick
Delivery task with the task server.

However, for these tasks to work correctly, you must manually convert your
packages and programs into software resources with command lines.

The new package delivery task contains links to the package and program (software
resource and command line).
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To view your migrated task server plug-in tasks

1 In the Symantec Management Console, on the Manage menu, click Jobs and
Tasks > System Jobs and Tasks > Software > Package Delivery.

2 Select the task that you want to view.

3 The window displays what package and command line the task uses. Click
Advanced to view task-related information, including the execution
environment.

4 If you modify the task, click Save Changes.

5 To schedule the task, use the schedule utility in the Task Status section.
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Migrating Deployment
Solution

This chapter includes the following topics:

■ About migrating from Deployment Solution 6.9

■ Architectural and functionality concepts of Deployment Solution 7.1 SP1

■ Advantages of using Deployment Solution 7.1 SP1 over 6.9

■ Comparison of Deployment Solution 6.9 tasks with 7.1 SP1

■ Migrating from Deployment Solution 6.9 to 7.1 SP1

■ Importing an existing image

■ Adding drivers to a driver database

■ About predefining computers in Deployment Solution 7.1 SP1

■ Importing predefined computers

■ Installing the Deployment Solution 7.1 SP1 agent and plug-in

■ Uninstalling the Deployment Solution 6.9 agent

■ Limitations of migrating from to Deployment Solution 7.1 SP1

About migrating from Deployment Solution 6.9
Deployment Solution 6.9 is a standalone product and is not designed to be
integrated with Symantec Management Platform. Deployment Solution 7.1 SP1
offers the core imaging and deployment capabilities of Deployment Solution 6.9
that are natively integrated on the Symantec Management Platform. Hence,
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Deployment Solution 7.1 SP1 does not require its own agent, console, or database
infrastructure separate from what is already provided with Symantec Management
Platform. Instead, Deployment Solution 7.1 SP1 plugs in and extends the
capabilities natively offered by Symantec Management Platform.

Though Deployment Solution 7.1 SP1 supports most of the functionalities of
Deployment Solution 6.9, you cannot migrate jobs and tasks from version 6.9.
You have to manually recreate the supported functionalities. The process for
recreating these tasks is exceptionally valuable since many of the attributes of
these items can be made broadly consumable by many tasks.

See “Comparison of Deployment Solution 6.9 tasks with 7.1 SP1 ” on page 128.

See “Migrating from Deployment Solution 6.9 to 7.1 SP1” on page 132.

You can only migrate Ghost and RapiDeploy images. If you want to migrate your
existing images, you must create a backup copy of them on a neutral storage
location before you upgrade. After you upgrade to version 7.1 SP1, you can then
restore them to their correct location.

Architectural and functionality concepts of
Deployment Solution 7.1 SP1

Table 7-1 lists the key architectural and functionality concepts of Deployment
Solution 7.1. It focuses on the areas that are different from Deployment Solution
6.9.

Table 7-1 Architectural and functionality concepts of Deployment Solution
7.1 SP1

DescriptionArchitecture/Functionality

Deployment Solution 7.I SP1 is integrated with Symantec
Management Platform, which has centralized management
capabilities. It leverages the capabilities of Symantec
Management Platform's agent, console, servers, and
database infrastructure.

Symantec Management
Platform integration

With Deployment Solution 7.1 SP1, AClient and DAgent are
no longer necessary. The Symantec Management Agent and
two plug-ins (the Altiris Client Task Agent and the
Deployment Solution plug-in) provide the required imaging,
deployment, and other functionalities. These plug-ins can
be viewed through the Symantec Management Agent’s
console.

Agent
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Table 7-1 Architectural and functionality concepts of Deployment Solution
7.1 SP1 (continued)

DescriptionArchitecture/Functionality

Symantec Management Platform’s Configuration
Management Database (CMDB) stores all inventory,
configuration, and settings information that Deployment
Solution collects or requires. This information is available
to Deployment Solution 7.1 SP1 processes and any other
solution that is implemented on the same Symantec
Management Platform environment. Likewise, the
information and the capabilities that are made available by
other SMP solutions are available to Deployment Solution
7.1 SP1.

CMDB

The configuration and on-going administration of
Deployment Solution 7.1 SP1 relies on the Symantec
Management Console. Configuration of initial settings,
infrastructure management, job creation and execution,
and access to Deployment Solution reports can be performed
from the console.

Console

Task Server provides the task-execution capabilities in
Deployment Solution 7.1 SP1. It supports immediate task
execution immediacy matching that of Deployment Solution
6.9. Deployment Solution 7.1 SP1 jobs can also include the
tasks from other solutions that are installed on the same
server as Deployment Solution. Furthermore, in Deployment
Solution 6.9 the task engine was embedded in the
Deployment Solution Server functionality. However, with
Deployment Solution 7.1 SP1, this functionality can
co-reside or execute remotely from the back-end server.
Symantec Management Platform allows multiple task
servers to be assigned to the same back-end server. For
example, Notification Server. This feature gives Deployment
Solution 7.1 SP1 unprecedented task-execution scalability.

For more information, search for topics on Task Server in
the Symantec Management Platform User Guide.

Task server

123Migrating Deployment Solution
Architectural and functionality concepts of Deployment Solution 7.1 SP1



Table 7-1 Architectural and functionality concepts of Deployment Solution
7.1 SP1 (continued)

DescriptionArchitecture/Functionality

Deployment Solution 7.1 SP1 offers both tasks and jobs as
the means for performing work. Tasks are individual units
of work, while jobs are sequences of tasks or other jobs. Jobs
can include branching a logic that causes different paths in
the job to be executed, depending on the result of previous
operations. Unlike Deployment Solution 6.9, where only
jobs can be executed, Deployment Solution 7.1 SP1 allows
individual tasks to be scheduled. It eliminates the need for
the jobs that contain only a single task. Jobs and tasks can
be scheduled to be run immediately, at a later time, or with
a specific frequency.

The tasks that are available in Deployment Solution 6.9 and
the jobs that are provided in 7.1 are correlated. All tasks
types in Deployment Solution 7.1 SP1 are located in the
console, under the Manage>JobsandTasks>Deployment
and Migration folder. From there, you can right-click Add
> New Job to bring up the Add Task dialog box.

See “Comparison of Deployment Solution 6.9 tasks with 7.1
SP1 ” on page 128.

Tasks and jobs

The following are the important differences to keep in mind
as you create the imaging tasks:

■ Tasks do not make assumptions about the environment
they are running on, such as the preboot operating
system or production operating system. The job that
invokes imaging tasks needs to make sure that the
computer is rebooted to the appropriate environment.
It ensures the reboot environment by specifying whether
a computer should reboot to production or automation,
independent of the current environment and its place
of execution inside a job.

■ The traditional imaging tasks have been divided into
smaller tasks to enable custom processing from within
an imaging job. These tasks need to be placed in an
imaging job in the correct sequence to ensure proper
execution.

See “Comparison of Deployment Solution 6.9 tasks with
7.1 SP1 ” on page 128.

Imaging tasks
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Table 7-1 Architectural and functionality concepts of Deployment Solution
7.1 SP1 (continued)

DescriptionArchitecture/Functionality

In Deployment Solution 7.1 SP1, system configurations are
centralized resources. They are the means for remotely
assigning computer and domain names, as well as local
account and network settings, to a computer. Multiple
configurations can be defined using the console and then
applied as part of imaging jobs and configuration tasks.

System configurations

Deployment Solution 7.1 SP1 includes the 6.9 tokens. Tokens
can be used inside scripts, as parameters in tasks, and in
answer files. Users can specify custom tokens in the console.
After tokens are centrally specified, they can be used in the
same manner as predefined tokens. This functionality
removes the need to include and maintain SQL queries inside
various scripts.

Predefined and custom
tokens

Deployment Solution 7.1 SP1 provides PXE capabilities as
the means to accomplish zero-touch, bare-metal
deployments. In Deployment Solution 7.1 SP1, PXE servers
are configured though a centralized policy. After the PXE
policy is configured and enabled from the Symantec
Management Console, PXE services are installed. Then, the
automation configurations are created on all targeted
computers.

Note: Each PXE server generates its automations using the
Boot Disk Creator that is installed on its own hard drive.

PXE

Deployment Solution 7.1 SP1 provides zero-touch
re-imaging through its automation folder feature. This
feature provides the same benefit as the automation
partition capability of Deployment Solution 6.9. Using the
automation folder rather than PXE for re-imaging is
encouraged because of its speed and lower bandwidth
requirements.

Automation folder
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Table 7-1 Architectural and functionality concepts of Deployment Solution
7.1 SP1 (continued)

DescriptionArchitecture/Functionality

Many of the Deployment Solution 6.9 stand-alone tools are
still available in Deployment Solution 7.1 SP1. Their use is
integrated with the normal operation of Deployment
Solution.

The most commonly used tools are as follows:

■ PC Transplant Editor

■ Boot Disk Creator

■ Image Explorer

■ Ghost Explorer

Stand-alone tools

DeployAnywhere is used to implement hardware
independent imaging (HII). If DeployAnywhere is selected
in the image task, it ensures that the critical drivers in an
image match the target system. Otherwise, DeployAnywhere
reconciles the differences.

Deployment Solution 7.1 SP1 includes a database of NIC
and mass storage drivers that DeployAnywhere uses to
retarget an image to a specific computer. You can add
drivers through SymantecManagementConsole>Settings
> Deployment > Driver Database Management.

DeployAnywhere

Advantages of using Deployment Solution 7.1 SP1
over 6.9

Table 7-2 lists the key benefits that Deployment Solution 6.9 users gain by
implementing Deployment Solution 7.1.

Table 7-2 Advantages of using Deployment Solution 7.1 SP1 over 6.9

DetailsNew capability

Automatic synchronization of computers, jobs, scripts, security
settings, system configurations, drivers, images, software
packages, pre-OS, personality templates, and custom tokens across
Deployment Solution servers.

Server configuration
synchronization

A central policy manages the PXE servers. Each PXE server
generates images based on the configuration policy.

PXE management
reliability and
scalability
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Table 7-2 Advantages of using Deployment Solution 7.1 SP1 over 6.9
(continued)

DetailsNew capability

Full customization of the menus, computers, and tasks that are
visible to custom-defined roles. You can specify what roles have
sufficient rights to modify jobs and tasks and what roles can only
run those jobs and tasks.

UI customization /
role-based
management

Out-of-the-box reports listing deployment run jobs, success status,
and other pertinent information. Ability to create custom reports
(grids, charts, etc.).

Reports

Computer groups can be defined in terms of any given number of
characteristics. Any computers that match the specified criteria
automatically appear as members of those groups. A computer
can belong to one or more groups.

Dynamic groups

Branch the logic that is supported inside jobs. Visual display shows
the portions of the job that execute if a certain condition is true.
The decision check can be a multi-part logic statement that
includes ANDs and ORs.

Decision branching in
jobs

Superior capabilities for importing data from Active Directory
and keeping it synchronized. Includes the ability to map roles to
AD groups and leverage AD authentication information on an
ongoing basis.

Enhanced AD
integration

Support for: Command Script, JavaScript, Perl Script, PowerShell,
Python Script, and VBScript.

Extended scripting
support

Filter the computer list by any substring in the name, OS, IP
address, and filters. You can also filter jobs by any substring in
their name. This process expedites use and significantly reduces
the drag-and-drop accidents.

Filtered computer and
job views

No pre-allocation is required of contiguous disk sectors. Greater
reliability and improved compatibility with full disk encryption.

Automation folder

Task engine operation can be offloaded to one or more servers,
adding to the already superior scalability of Symantec
Management Platform.

Horizontal scalability
through Task Server

Custom tokens are extensions to predefined tokens. You can
change a custom token in one place and all tasks, scripts, and
answer files can access that change.

Central custom tokens
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Table 7-2 Advantages of using Deployment Solution 7.1 SP1 over 6.9
(continued)

DetailsNew capability

Keep track of the licenses employed. The Linux Scripted OS Install
has been streamlined and closely follows the recommended
practices.

Streamlined scripted
OS install

Tasks are reusable, you do not need to re-defined them each time
they are required in a job. Changing a task in one place
automatically updates all jobs that include it.

Tasks can be reused in
multiple jobs

Being integrated with Symantec Management Platform,
Deployment Solution 7.1 SP1 supplements the core imaging and
deployment capabilities of Symantec Management Platform-based
solutions.

Extensibility through
other IT management
solutions

Comparison of Deployment Solution 6.9 tasks with
7.1 SP1

You can manually recreate the tasks that you had created in Deployment Solution
6.9, but with some limitations.

Table 7-3 lists the equivalent tasks that you can recreate in Deployment Solution
7.I SP1 and their limitations.
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Table 7-3 Comparison of Deployment Solution 6.9 tasks with 7.1 SP1

CommentsTasks in Deployment
Solution 7.1 SP1

Tasks in Deployment
Solution 6.9

aeximport utility,
aexschedule utility, and
WLogEvent utility are not
supported in Deployment
Solution 7.1 SP1. Modify the
run script tasks that are
created using these utilities
in Deployment Solution 6.9
while recreating them in
Deployment Solution 7.1 SP1.

Review the script tasks that
are created using tokens as
some of the Deployment
Solution 6.9 tokens are not
supported.

Run ScriptRun Script

No limitationPower ControlPower Control

No limitationCopy file task with option to
execute the task.

Another option is to use
Software Management
Solution.

Distribute Software

No limitationCopy file task with the
option to execute task

Copy file

First create the system
configuration settings from
Settings > Deployment and
Migration > System
Configuration. Then you can
create and execute the Apply
system configuration task.

ApplysystemconfigurationModify Configuration
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Table 7-3 Comparison of Deployment Solution 6.9 tasks with 7.1 SP1
(continued)

CommentsTasks in Deployment
Solution 7.1 SP1

Tasks in Deployment
Solution 6.9

Only Ghost and RapiDeply
imaging tools are supported
in Deployment Solution 7.I
SP1 for creating and
deploying images.

To create a backup image,
perform the following tasks
sequentially:

■ Reboot to Automation
■ Create Image (backup

image )

■ Reboot to Production

To create a disk image task,
perform the following tasks
sequentially:

■ Prepare for Image
Capture

■ Reboot to Automation
■ Create Image (disk

image)

■ Reboot to Production

You can create two
equivalent tasks:

■ Create Image task to
capture backup image.
This task is created to
take a backup of a
computer. The backup
image is deployed on the
same computer.

■ Create Image task to
capture disk image. This
task is created to take a
generic image that is
deployed on multiple
computers.

Create Disk Image
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Table 7-3 Comparison of Deployment Solution 6.9 tasks with 7.1 SP1
(continued)

CommentsTasks in Deployment
Solution 7.1 SP1

Tasks in Deployment
Solution 6.9

You can import Deployment
Solution 6.9 images to
Deployment Solution 7.I SP1
using the resource import
tool. The Deployment
Solution 6.9 images do not
contain the Symantec
Management Agent. When
you deploy these images on
client computers, they
become unmanaged
computers.

To perform a Restore
Back-up Image task, perform
the following tasks
sequentially:

■ Reboot to Automation
■ Restore Back-up Image
■ Reboot to Production

To perform a Deploy Image
task, perform the following
tasks sequentially:

■ Reboot to Automation
■ Deploy Image
■ Reboot to Production

You can create two
equivalent tasks:

■ Restore Back-up Image
task to deploy the backup
image.

■ Deploy Image task to a
deploy disk image on
multiple computers.

Distribute Disk Image

No limitationCapture PersonalityCapture Personality

No limitationDeploy PersonalityDeploy Personality
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Table 7-3 Comparison of Deployment Solution 6.9 tasks with 7.1 SP1
(continued)

CommentsTasks in Deployment
Solution 7.1 SP1

Tasks in Deployment
Solution 6.9

To perform an Install
Windows OS task, perform
the following tasks
sequentially:

■ Reboot to Automation
■ Install Windows OS

To perform a Install LinuxOS
task, perform the following
tasks sequentially:

■ Reboot to Automation
■ Install Linux OS

You can create two
equivalent tasks:

■ Install Windows OS
■ Install Linux OS

Scripted OS Install

See “Migrating from Deployment Solution 6.9 to 7.1 SP1” on page 132.

See “About migrating from Deployment Solution 6.9” on page 121.

Migrating from Deployment Solution 6.9 to 7.1 SP1
Deployment Solution 6.9 is a standalone product and is not designed to be
integrated with a centralized management system. However, Deployment Solution
7.I SP1 is integrated with Symantec Management Platform, which has centralized
management capabilities. Deployment Solution 7.I SP1 supports most of the
functionalities of Deployment Solution 6.9. You can manually recreate the
supported functionalities.

Table 7-4 Process for migrating from Deployment Solution 6.9 to 7.1 SP1

DescriptionActionStep

Create the backup and make the backed
up items accessible from the
Deployment Solution 7.1 SP1 server
database from the eXpress share.

Create a backup of Deployment
Solution 6.9 images, CSV files, and
Deploy Anywhere drivers.

Step 1
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Table 7-4 Process for migrating from Deployment Solution 6.9 to 7.1 SP1
(continued)

DescriptionActionStep

Install ITMS 7.1 SP1 on a Windows
Server 2008 R2 x64 and ensure that you
have selected Deployment Solution
from the Product list.

For more information on installing the
ITMS 7.1 SP1 server, see ITMS
Implementation Guide.

Install a new 7.1 SP1 server.Step 2

Import Deployment Solution 6.x images
to Deployment Solution 7.I SP1 using
the Resource Import Tool.
ResourceImportTool.exe is located
at the
\\%NSSERVER%\Deployment\tools

folder.

Ensure that the image package is
created for the imported image.

The imported image package is created
under Settings > Deployment and
Migration > Disk Images. You can use
the imported images for the Deploy
Image task.

See “Importing an existing image”
on page 135.

Import the DS 6.9 images into
ITMS 7.1 SP1 by using the
Resource Import Tool.

Step 3

Copy the required drivers from the
following Deployment Solution 6.9
driver database:

\\[Backup

Server]\eXpress\DriversDB

All default drivers are present in
Deployment Solution 7.1 SP1. Only the
drivers that you added to Deployment
Solution 6.9 need to copied.

Copy the required Deployment
Solution 6.9 drivers.

Step 4
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Table 7-4 Process for migrating from Deployment Solution 6.9 to 7.1 SP1
(continued)

DescriptionActionStep

Add the backed up drivers to the
Deployment Solution 7.1 SP1 driver
database from the Symantec
Management Console > Settings >
Deployment > Driver Management
page.

See “Adding drivers to a driver
database” on page 136.

Add the backed up drivers to
Deployment Solution 7.I SP1.

Step 5

Import the predefined computers which
were imported in Deployment Solution
6.9 and are not yet managed in the
network. You can use the existing CSV
file for importing client computers with
few changes.

See “Importing predefined computers”
on page 140.

See “ About predefining computers in
Deployment Solution 7.1 SP1 ”
on page 138.

Import the predefined computers.Step 6

Recreate equivalent Deployment
Solution 6.9 jobs and tasks in
Deployment Solution 7.1 SP1.

See “Comparison of Deployment
Solution 6.9 tasks with 7.1 SP1 ”
on page 128.

Recreate Deployment Solution 6.9
jobs and tasks.

Step 7

Install Symantec Management Agent
using the Symantec Management
Agent Install page.

Install Deployment Plug-in using the
appropriate Plug-in policy for Windows
(x86/x64) and Linux computers.

See “Installing the Deployment
Solution 7.1 SP1 agent and plug-in”
on page 140.

Install Symantec Management
Agent and Deployment Plug-in.

Step 8
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Table 7-4 Process for migrating from Deployment Solution 6.9 to 7.1 SP1
(continued)

DescriptionActionStep

Uninstall the Deployment Solution 6.9
Agent using the Runscript task.

See “Uninstalling the Deployment
Solution 6.9 agent” on page 141.

Uninstall the Deployment
Solution 6.9 agent.

Step 9

Importing an existing image
You can use the DeploymentSolutionResourceImportTool to import an existing
image. You can import images and then use them to deploy on client computers.
Deployment Solution Resource Import Tool needs all the splitted files for a
RapiDeploy image to be selected for the effectual import of the RapiDeploy image.
Partial selection of files would show up as successful import, but will not lead to
a valid image. If you want to import a splitted Ghost image, selection of one split
automatically selects the other splits also.

Deployment Solution Resource Import Tool lets you import images that are
located on HTTP Web server. User credentials are not required to access the
located on HTTP Web server.

You can also import OS packages using the DeploymentSolutionResourceImport
Tool.

To import an existing image

1 Browse to \C:\Program Files\Altiris\Altiris

Agent\Agents\Deployment\Task Handler\Tools” or [Altiris Agent

Install Dir]\Agents\Deployment\Task Handler\Tools and execute the
ResourceImportTool.exe.

You can execute this tool from Symantec Management Platform or from Site
Server.

Ensure that you run this tool only from Symantec Management Platform.

2 On the Deployment Solution Resource Import Tool, click browse to
C:\DS_Resources\Win7 Image, and open required .gho or .img file.

3 From the Select OS, select Windows 7 Professional.

4 Click Import.

5 A message indicating the successful upload of image is displayed. Acknowledge
the message and close the Deployment Solution Resource Import Tool.
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Adding drivers to a driver database
Deployment Solution lets you add drivers to the driver database to ensure the
successful completion of Windows OS installation and Windows image deployment
tasks. By adding drivers to the driver database, you eliminate the need for manual
driver installations. When you add drivers to the driver database, missing drivers
and newly discovered drivers are automatically added to the image.

You can add drivers to the following driver databases:

Adding drivers to the DeployAnywhere driver database helps in
making the task of imaging and scripted OS installation hardware
independent. Hence, deploying of image to client computers and
performing an OS installation do not fail due to hardware
dependencies.

The DeployAnywhere driver database supports only the Windows
operating system.

See “Adding drivers to the DeployAnywhere database” on page 137.

DeployAnywhere

Adding drivers to the Preboot database helps the preboot images
to support mass storage devices (MSDs) and network interface cards
(NICs). These drivers are added to the preboot images. These preboot
images are deployed through the preboot environment. It ensures
that you can reboot the client computers successfully to automation
or to PXE.

The Preboot driver database supports the Windows and Linux
operating systems.

See “Adding drivers to the Preboot database” on page 136.

Preboot

Driver databases lets you perform the following functionalities:

■ List drivers for DeployAnywhere and Preboot databases.

■ Add drivers to DeployAnywhere and Preboot databases by folder.

■ Delete drivers from the DeployAnywhere database only.

■ Search for drivers in DeployAnywhere and Preboot databases.
The search does not display any results if you use \ in your search string.

■ View device details of the selected driver by clicking More Info.

Adding drivers to the Preboot database
You can add drivers to the Preboot database. You can use these drivers for your
preboot PXE configurations needs.
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BootWiz.exe is stored in the \Program Files\Altiris\Altiris

Agent\Agents\Deployment\Task Handler\bootwiz directory.

If a preboot configuration that you already created needs a new driver, you must
regenerate that preboot configuration.

You can also add drivers to the DeployAnywhere database.

See “Adding drivers to the DeployAnywhere database” on page 137.

To add drivers to the Preboot database

1 In the Symantec Management Console, on the Settings menu, click
Deployment > Driver Management.

2 Click the Preboot tab.

3 (Optional) To view details of a driver, select the driver from the list and click
More Info.

4 Click Add.

5 Browse to select the required the driver to add.

6 Select the relevant operating system: WinPE, or Linux.

7 Select the relevant architecture: x86 or x64.

8 Click OK.

The new driver is used when you create a new configuration.

Adding drivers to the DeployAnywhere database
The DeployAnywhere driver database helps make image deployment and scripted
operating system installation tasks hardware-independent. DeployAnywhere
focuses on the device drivers that are critical because the retargeted system has
to be managed remotely. During a Windows scripted operating system installation,
if any required driver is missing, it takes the missing drivers from the
DeployAnywhere driver database.

See “Adding drivers to a driver database” on page 136.

DeployAnywhere supports only the Windows operating system.

DeployAnywhere supports the following critical driver types:

■ Mass storage device (MSD)

■ Network interface card (NIC)

The MSDs are critical because they allow the resident operating system to boot
while network drivers ensure that the retargeted node is managed remotely.

DeployAnywhere supports the following non-critical driver types:
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■ Graphics

■ Audio

■ Keyboard

■ Mouse

■ USB

■ CD-ROM

■ Printer

■ Bluetooth

■ Multimedia

■ Modem

You can also add drivers to the Preboot database.

See “Adding drivers to the Preboot database” on page 136.

To add a new driver to the DeployAnywhere driver database

1 In the Symantec Management Console, on the Settings menu, click
Deployment > Driver Management.

2 Click the DeployAnywhere tab.

3 (Optional) To view details of a driver, select the driver from the list and click
More Info.

4 Click Add.

5 Browse to select the driver to add .

6 Click OK.

About predefining computers inDeployment Solution
7.1 SP1

If you intend to use the Deployment Solution 6.9 CSV file in Deployment Solution
7.1 SP1, you can use it after modifying it to adhere to Deployment Solution 7.1
SP1 CSV template. In the new Deployment Solution 7.1 SP1 CSV template file, the
MAC, UUID, and serial number are mandatory fields. If information in any of
these fields is not provided, the mapping to the actual computer fails. When the
mapping fails, a duplicate resource is created for the actual computer. Some of
the fields in Deployment Solution 6.9 CSV file template are ignored in the Import
predefined computer feature of Deployment Solution 7.1 SP1. The following are
the fields that are ignored:
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■ Computer Name

■ Domain Flag

■ Domain Controller Name

■ Use Preferred Tree Flag

■ Preferred Server

■ Preferred Tree

■ NetWare User

■ NDS Context

■ Run Scripts Flag

■ User

■ Organization

■ Key

■ Password Never Expires Flag

■ Cannot Change Password Flag

■ Must Change Password Flag

■ Username

■ Full Name

■ Groups

■ Password

■ Contact

■ Department

■ Email

■ Mailstop

■ Phone

■ Site

■ Computer Group

■ Event

■ Event Start Time
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Importing predefined computers
You can import a predefined computer to assign jobs to unmanaged computers.
An unmanaged computer does not yet have the Symantec Management Agent or
the Deployment plug-in installed on it.

When a computer performs a PXE Boot, the PXE process reports the new
computer’s name, MAC address, serial number, and BIOS or motherboard UUID.
From this information, Symantec Management Platform can identify the computer
and run any tasks or jobs that are assigned to that computer. If information is not
available in any of these fields, the mapping to the actual computer fails. When
the mapping fails, a duplicate resource is created for the actual computer. Hence,
name, MAC address, serial number, and UUID are mandatory fields. If any of these
fields is not specified, the mapping of the defined computer to the actual computer
fails.

Ensure that you have set the preboot image to respond to predefined computers.
In case the preboot image is not set, an error is displayed when you import the
predefined computers.

To import predefined computer

1 In the Symantec Management Console, on the Settings menu, click
Deployment > Predefined Computers.

2 Click Import Computers, and then navigate to the.txt or the .csv file
containing the information about the computers to import.

You can copy a sample Pre-DefinedComputers.csv file from the \Program

Files\Altiris\Notification

Server\NSCap\bin\Win32\X86\Deployment\Sample\PreDefinedComputers

folder.

3 From the Manage menu, select Computers to view the details of imported
predefined computers.

Installing theDeployment Solution 7.1 SP1 agent and
plug-in

The Symantec Management Agent and the Deployment plug-in replace the
Deployment Solution 6.9 clients and agent software (DAgent and adlagent).
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To install the 7.I SP1 agent and plug-in

1 Install Symantec Management Agent using the Symantec Management
Agent Install page.

2 Install the Deployment Plug-in using the appropriate Plug-in policy for
Windows (x86 or x64) and Linux computers.

3 Uninstall the DAgent/adlagent from the client.

See “Uninstalling the Deployment Solution 6.9 agent” on page 141.

Uninstalling the Deployment Solution 6.9 agent
You can uninstall Deployment Solution 6.9 agents using the Runscript task to
execute the following commands for different agents:

“C:\Program
Files\Altiris\AClient\aclient.exe” -remove
-silent -all

Vista and earlier version
computers (AClient)

msiexec.exe /X
{6C8D5E56-CA12-42B2-9075-044B4C7067A9} /qn

Vista and later version
computers (DAgent)

/opt/altiris/deployment/adlagent/bin/uninstallFor Linux or UNIX (adlagent)

Limitations ofmigrating from toDeployment Solution
7.1 SP1

The following is the list of limitations that you encounter when you migrate from
Deployment Solution 6.9 to Deployment Solution 7.I SP1:

■ Return code handling in DS 6.9 is different.

■ Few tokens from DS 6.9 are supported.

■ No support for standalone utilities like aexschedule and aeximport.

■ Functionalities of Deployment Solution 6.9, like imaging, Scripted OS install,
Copy File, and Script are provided, but you have to recreate these tasks.

■ Script task functionality does not work due to limitations in command-line
utilities, token, and lack of WLogEvent utility.

■ Drivers that are added to the Preboot driver database need to be added
manually.
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■ Client computers become unmanaged when the images are imported from
Deployment Solution 6.9 using the import tool, ResourceImportTool.exe. The
Deployment Solution 6.9 images do not contain the Symantec Management
Platform Agent. To manage the client computers, install the Symantec
Management Platform Agent on them.

See “About migrating from Deployment Solution 6.9” on page 121.

See “Migrating from Deployment Solution 6.9 to 7.1 SP1” on page 132.
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Migrating Monitor Solution

This chapter includes the following topics:

■ About Monitor Solution migration

■ About Monitor Pack for Servers migration

About Monitor Solution migration
You perform the product migration to version 7.1 according to the migration
scenario for IT Management Suite. The majority of the solution-specific data is
migrated when you migrate according to the process that is defined in the
Migrating Symantec Management Platform chapter.

See “Migrating from Notification Server 6.x to Symantec Management Platform
7.1” on page 34.

See “About data migration” on page 49.

Agent-based resources are not available after migration. To make agent-based
resources available, you need to first upgrade the Symantec Management Agent
with the Monitor Plug-in. To upgrade you need to redirect the needed resources
to the Symantec Management Platform 7.1 from the old platform. For more
information, see topics on Symantec Management Agent in the Symantec
ManagementPlatformUserGuide. You then need to enable the applicable upgrade
policy for the Monitor Plug-in.

See “About Monitor Pack for Servers migration” on page 143.

About Monitor Pack for Servers migration
When migrating Monitor Solution 6.x items to Monitor Solution 7.1, modified
items (such as policies, metrics, rules, and new monitor packs) are all migrated.
If an item that is not modified and another item that has been modified references
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it, this referenced item is migrated. For example, if you modified a metric, but not
a rule that the metric references, then both the metric and the rule are migrated.
Default unchanged policies, metrics, and rules do not migrate.

See “About Monitor Solution migration” on page 143.

Migrating Monitor Solution
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Migrating Real-Time System
Manager Solution

This chapter includes the following topics:

■ About Real-Time System Manager Solution migration to version 7.1

■ Manually migrating Real-Time System Manager Solution to version 7.1

■ About manually migrating Real-Time System Manager Solution files and
settings

■ How to validate Real-Time System Manager Solution after the migration

About Real-TimeSystemManager Solutionmigration
to version 7.1

You can migrate from Real-Time System Manager Solution 6.x to Real-Time
System Manager Solution 7.1. In addition to using the migration wizard to migrate,
you must complete some manual steps. You need to manually move and store
some .XMLfiles on the 7.1 computer.

See “Manually migrating Real-Time System Manager Solution to version 7.1”
on page 145.

Manually migrating Real-Time System Manager
Solution to version 7.1

You can use the Symantec Notification Server Wizard to help you migrate
Real-Time System Manager Solution to version 7.1.
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Table 9-1 Process for manually migrating Real-Time System Manager Solution
to version 7.1

DescriptionActionStep

When you migrate to Symantec
Management Platform 7.1, you use
the Symantec Notification Server
Wizard to migrate the previous
Notification Server data. When you
use the migration wizard, you must
export Notification Server data to a
data store file.

See “Exporting Notification Server
6.x data to a data store file ”
on page 57.

Export the data from the
previous Notification Server
computer.

Step 1

You use the Symantec Notification
Server Migration Wizard to migrate
the previous Notification Server data
to Symantec Management Platform
7.1. When you use the migration
wizard, you must import the data
from a data store file.

See “Importing Notification Server
6.x data from a data store file”
on page 59.

Import the exported data from
the previous Notification Server
computer to the Symantec
Management Platform 7.1.

Step 2

You need to move and store some
XML files from the old Notification
Server computer to the Symantec
Management Platfrom 7.1 computer.

See “About manually migrating
Real-Time System Manager Solution
files and settings” on page 146.

Move and store Real-Time
System Manager Solution files
and settings.

Step 3

AboutmanuallymigratingReal-TimeSystemManager
Solution files and settings

The Real-Time System Manager Solution Migration Wizard contains the following
exporter and importer objects:

■ Boot Redirection task

Migrating Real-Time System Manager Solution
About manually migrating Real-Time System Manager Solution files and settings
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■ Network Filtering task

■ Password Management task

■ Process Management task

■ Service Management task

■ Network Filtering task

The majority of your Real-Time System Manager Solution data is migrated using
the migration wizard. However, to have full predefined functionality, you must
move some files. You need to manually move and store these files from the old
Notification Server computer to the new 7.1 computer.

By default, the files that need to be moved are located on your previous Notification
Server in specific locations.

Table 9-2 Real-Time System Manager Solution files path

Symantec Management Platform 7.1
path

Notification Server path

To the following location on the new 7.1
Symantec Management Platform:

C:\Program
Files\Altiris\RTSM\Web\UIData\CBFilters.xml

C:\Program

Files\Altiris\RTSM\UIData\CBFilters.xml

How to validate Real-Time SystemManager Solution
after the migration

After you finish the migration process, it is necessary to validate the migrated
items. In fact, you need to make sure that these items have been correctly migrated
to your new 7.1 Symantec Management Platform environment. They still should
have the same predefined functionality. You need to check the following items:

■ Connection settings and credential profiles
If you have used a security certificate in your connection settings, you need
to make sure that it has a correct server name and location.
For more information, see the topics about connection profiles in the Symantec
Management Platform Help.

■ Network filters
For more information, see the topics about filtering network traffic on multiple
computers in the Real-Time SystemManager User Guide.

■ Boot Redirection
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You need to manually move and store your redirection images from your old
Notification Server to your new 7.1 Symantec Management Platform
environment.
For more information, see the topics about booting multiple computers from
another device in the Real-Time SystemManager User Guide.

■ Network Filtering
You need to manually move and store your predefined custom network filters
from your old Notification Server to your new 7.1 Symantec Management
Platform environment.
For more information, see the topics about filtering network traffic on multiple
computers in the Real-Time SystemManager User Guide.

■ Password Management
For more information, see the topics about resetting a local user password on
multiple computers in the Real-Time SystemManager User Guide.

■ Process Management
For more information, see the topics about running or stopping a process on
multiple computers in the Real-Time SystemManager User Guide.

■ Service Management
For more information, see the topics about running or stopping a service on
multiple computers in the Real-Time SystemManager User Guide.

Migrating Real-Time System Manager Solution
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Migrating Real-Time
Console Infrastructure

This chapter includes the following topics:

■ About Real-Time Console Infrastructure migration to version 7.1

■ Manually migrating Real-Time Console Infrastructure to version 7.1

■ About manually migrating Real-Time Console Infrastructure files and settings

■ How to validate Real-Time Console Infrastructure after the migration

About Real-TimeConsole Infrastructuremigration to
version 7.1

You can migrate from Real-Time Console Infrastructure 6.x to Real-Time Console
Infrastructure 7.1. In addition to using the migration wizard to migrate, you must
complete some manual steps. You need to manually move and store some .XML
files on the 7.1 computer.

See “Manually migrating Real-Time Console Infrastructure to version 7.1”
on page 149.

ManuallymigratingReal-TimeConsole Infrastructure
to version 7.1

You can use the Symantec Notification Server Migration Wizard to help you
migrate Real-Time Console Infrastructure to version 7.1.
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Table 10-1 Process for manually migrating Real-Time Console Infrastructure
to version 7.1

DescriptionActionStep

When you migrate to Symantec
Management Platform 7.1, you use the
Symantec Notification Server Migration
Wizard to migrate the previous
Notification Server data. When you use
the migration wizard, you must export
Notification Server data to a data store
file.

See “Exporting Notification Server 6.x
data to a data store file ” on page 57.

Export data from the
previous Notification Server.
computer

Step 1

You use the Symantec Notification Server
Migration Wizard to migrate the previous
Notification Server data to Symantec
Management Platform 7.1. When you use
the migration wizard, you must import
the old data from a data store file.

See “Importing Notification Server 6.x
data from a data store file” on page 59.

Import the exported data
from the previous
Notification Server computer
to the Symantec
Management Platform 7.1.

Step 2

You need to move and store some XML
files from the old Notification Server
computer to the Symantec Management
Platfrom 7.1 computer.

See “About manually migrating
Real-Time Console Infrastructure files
and settings” on page 150.

Move and store Real-Time
Console Infrastructure files
and settings.

Step 3

About manually migrating Real-Time Console
Infrastructure files and settings

The majority of your Real-Time Console Infrastructure Solution data is migrated
when you migrate your Real-Time Console Infrastructure to your new 7.1 Symantec
Management Platform. However, you must manually migrate some files. To
migrate these files, you use your previous Notification Server computer files and
move them to your new 7.1 Symantec Management Platform environment.

Migrating Real-Time Console Infrastructure
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Table 10-2 Real-Time Console Infrastructure files path

Symantec Management Platform 7.1
path

Old Notification Server path

The following location on the 7.1 Symantec
Management Platform:

C:\Program

Files\Altiris\RTCI\Web\UIData\PortCheck.xml

C:\Program

Files\Altiris\RTSM\UIData\PortCheck.xml

How to validate Real-Time Console Infrastructure
after the migration

You need to check if your previous settings and options have been correctly
migrated. In addition, if you had any scheduled tasks on your old Notification
Server computer, check that those predefined tasks have been correctly migrated.

Predefined tasks may consist of the predefined time schedule, computer profiles,
connection profiles, and credential profiles as follows:

■ Connection and credential profiles
If you have used a security certificate in your connection settings, you need
to make sure that it has a correct server name and location.
For more information, see the topics about connection profiles in the Symantec
Management Platform Help.

■ Get out-of-band inventory
For more information, see the topics about collecting and viewing Intel AMT
and DASH inventory in the Real-Time Console Infrastructure User Guide.

■ Power management
For more information, see the topics about managing the power state of
computers remotely in the Real-Time Console Infrastructure User Guide.

■ Update Intel AMT credentials
For more information, see the topics about updating Intel AMT credentials in
the Real-Time Console Infrastructure User Guide.

■ Update Intel AMT settings
For more information, see the topics about updating Intel AMT settings and
configuring Intel AMT in the Real-Time Console Infrastructure User Guide.

■ Update out-of-band alert settings
You need to make sure that you have a correct SNMP server for Intel AMT
and ASF and also correct Destination URL for DASH.
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For more information, see the topics about updating Intel AMT and DASH
alert settings in the Real-Time Console Infrastructure User Guide.
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Migrating Carbon Copy
Solution

This chapter includes the following topics:

■ About migrating from Carbon Copy 6.x to pcAnywhere Solution 7.1

■ Advantages of using pcAnywhere over Carbon Copy

■ Before you begin the 6.x to 7.1 migration with pcAnywhere

■ Migrating from Carbon Copy 6.x to pcAnywhere Solution 7.1

Aboutmigrating fromCarbonCopy6.x to pcAnywhere
Solution 7.1

pcAnywhere 12.6 replaces Carbon Copy 6.x in IT Management Suite 7.1.

When you install the pcAnywhere plug-in on a client computer, it automatically
removes the Carbon Copy agent. If you have client computers with the Carbon
Copy agent installed and you do not install the pcAnywhere plug-in on them, the
Carbon Copy agent does not uninstall automatically.

When you install the pcAnywhere plug-in on a client computer, it installs the
pcAnywhere host on each targeted client computer. The installation package that
is sent to each targeted computer is approximately 50MB.

If you customize the communication ports on the 6.x server, be sure to customize
the ports on the 7.1 server as well.

You can migrate Carbon Copy events and inventory data to 7.1. However, you can
only use the data to view legacy reports and view historical data. The data is not
usable by pcAnywhere.
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In the migration wizard export settings, Carbon Copy data is included under the
pcAnywhere node.

See “Before you begin the 6.x to 7.1 migration with pcAnywhere” on page 154.

See “Migrating from Carbon Copy 6.x to pcAnywhere Solution 7.1 ” on page 155.

See “Advantages of using pcAnywhere over Carbon Copy” on page 154.

Advantages of using pcAnywhere over Carbon Copy
The advantages of using pcAnywhere over Carbon Copy are as follows:

■ pcAnywhere has native support for Windows NT 4.0/Vista

■ Remote/Viewer supports Windows Mobile

■ pcAnywhere supports Mac OS X

■ pcAnywhere supports Linux

■ pcAnywhere includes cross-platform support

■ pcAnywhere includes robust security in the form of serialization and mandatory
passwords

■ pcAnywhere includes platform improvements such as a client-side mirror
driver

■ pcAnywhere includes an access server, which provides remote session
connectivity

See “About migrating from Carbon Copy 6.x to pcAnywhere Solution 7.1”
on page 153.

See “Migrating from Carbon Copy 6.x to pcAnywhere Solution 7.1 ” on page 155.

Before you begin the 6.x to 7.1 migration with
pcAnywhere

Before you begin the migration from 6.x, complete the following tasks:

■ Back up your current 6.x server and database.

■ Validate the success of the backups before you proceed.

■ Review the solutions you have currently installed in the source 6.0 system and
capture the information. You should have the same installed solutions on the
target server (wherever applicable) for the migration wizard to properly place
the data that has been gathered from the 6.0 source computer.

Migrating Carbon Copy Solution
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■ Verify that all IT Management Suite licenses are stored in a safe location to
be used on the 7.1 server. If the licenses are not downloaded or available, you
can regain them from the Symantec Licensing Portal .

Migrating from Carbon Copy 6.x to pcAnywhere
Solution 7.1

In IT Management Suite 7.1, pcAnywhere Solution 7.1 replaces Carbon Copy 6.x.

After pcAnywhere is integrated with Symantec Management Platform, it leverages
the platform capabilities.

Ensure that you have completed the required tasks before you start migrating to
IT Management Suite 7.1 and upgrade to pcAnywhere Solution 7.1 SP1.

See “About migrating from Carbon Copy 6.x to pcAnywhere Solution 7.1”
on page 153.

See “Before you begin the 6.x to 7.1 migration with pcAnywhere” on page 154.

To migrate from Carbon Copy 6.x to pcAnywhere Solution 7.1

1 Prepare the target server for the installation of IT Management Suite 7.1.

IT Management Suite 7.1 requires and is currently only supported on
Microsoft Windows 2008 R2 x64. For SSL and other certificates, make sure
that they are in place on the 7.1 target server before you install Symantec
Installation Manager or solutions.

2 Install IT Management Suite 7.1 on the target server (including the migration
components within the optional components).

3 Use the migration wizard to export 6.x data from the source 6.x server.

4 Copy the x86 migration package from the IT Management Suite 7.1 server.

The package is located at Program Files\Symantec Installation

Manager\Migration Package\

Multiple migration packages are launched and installed for pcAnywhere.

5 From the Program files/upgrade directory on the 6.x server, run the
migration wizard (NSUpgrade.exe).

This exports KMS and CM keys into a data store file (*adb)

6 Back up the data store file (*adb).

7 Restore the backed up data store file from Notification Server 6.x to 7.1.
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8 Run the x64 migration wizard and import the backed up.adb file.

9 Enable deploy policies for the Symantec Management Agent and the
pcAnywhere plug-ins.

The Symantec Management Agent and the pcAnywhere agents replace the
older Altiris Agent and the Carbon Copy Agent.

Migrating Carbon Copy Solution
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Migrating Out of Band
Management Component

This chapter includes the following topics:

■ About Out of Band Management Component migration to version 7.1

■ Manually migrating Out of Band Management Component to version 7.1

■ Redirecting the Altiris Agent from Notification Server 6.x to Symantec
Management Platform 7.1

■ Migrating the Intel AMT database

■ Configuring the Intel AMT database

■ Fine-tuning Out of Band Management Component 7.1 after the migration

AboutOutofBandManagementComponentmigration
to version 7.1

This chapter provides details of migration from the Out-of-Band Management
Component 6.x to the Out-of-Band Management Component 7.1. In addition to
using the migration wizard to migrate, you must complete some manual steps.
You need to manually move and store some databases on the 7.1 computer.

See “Manually migrating Out of Band Management Component to version 7.1”
on page 158.
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Manually migrating Out of Band Management
Component to version 7.1

Table 12-1 Process for manually migrating Out of Band Management
Component 6.x to version 7.1

DescriptionActionStep

When you migrate to Symantec
Management Platform 7.1, you use the
Symantec Notification Server Migration
Wizard to migrate Notification Server 6.x
data. When you use the migration wizard,
you must export Notification Server data
to a data store file.

See “Exporting Notification Server 6.x
data to a data store file ” on page 57.

Export data from the
previous Notification Server
6.x using the migration
installation package.

Step 1

The Intel AMT database is not migrated
through the migration process. To
preserve it, you must manually migrate
it from the old Notification Server to
Symantec Management Platform 7.1.

See “Migrating the Intel AMT database”
on page 160.

Detach the Intel AMT
database from the old
Notification Server database.

Step 2

The Intel AMT database is not migrated
through the migration process. To
preserve it, you must manually migrate
it from the old Notification Server to
Symantec Management Platform 7.1.

See “Migrating the Intel AMT database”
on page 160.

Attach the Intel AMT
database to the 7.1 database.

Step 3

After you move the Intel AMT database
to your new environment, you must
validate it and make sure that it operates
correctly.

See “Configuring the Intel AMT database”
on page 160.

Reconfigure the Intel AMT
database on the Symantec
Management Platform 7.1.

Step 4

Migrating Out of Band Management Component
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Table 12-1 Process for manually migrating Out of Band Management
Component 6.x to version 7.1 (continued)

DescriptionActionStep

You use the Symantec Notification Server
Migration Wizard to migrate Notification
Server 6.x data to Symantec Management
Platform 7.1. When you use the migration
wizard, you must import the 6.x data from
a data store file.

See “Importing Notification Server 6.x
data from a data store file” on page 59.

Import the exported data
from 6.x Notification Server
to the Symantec
Management Platform 7.1.

Step 5

You need to redirect the existing clients
pointing to 6.x Notification Server to the
new Symantec Management Platform 7.1.

See “Redirecting the Altiris Agent from
Notification Server 6.x to Symantec
Management Platform 7.1” on page 159.

Redirect the Altiris Agent
from Notification Server 6.x
to Symantec Management
Platform 7.1.

Step 6

After you have finished all the migration
steps, you can fine-tune Out of Band
Management Component 7.1.

See “Fine-tuning Out of Band
Management Component 7.1 after the
migration” on page 161.

Fine-tune Out of Band
Management Component 7.1
after the migration.

Step 7

Redirecting the Altiris Agent fromNotification Server
6.x to Symantec Management Platform 7.1

You need to redirect the existing clients that point to 6.x Notification Server to
the new Symantec Management Platform 7.1.

See “About Out of Band Management Component migration to version 7.1”
on page 157.

See “Manually migrating Out of Band Management Component to version 7.1”
on page 158.
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To redirect the Altiris Agent fromNotification Server 6.x to SymantecManagement
Platform 7.1

1 In the Altiris Console 6.5, click Configure > Agents > Desktop Settings.

2 Under Altiris Agent Settings, click the Advanced Settings tab.

3 Under AlternativeURL foraccessingNS, check Specify analternativeURL
fortheAltirisAgenttousetoaccess theNS and specify the 7.1 ServerName
and Server Web.

Migrating the Intel AMT database
The IntelAMTdatabase is not migrated through the migration process. To preserve
it, you must manually migrate it from the previous Notification Server to Symantec
Management Platform 7.1. You must manually move the Intel AMT database to
your new environment by using Microsoft SQL Management Studio.

See “About Out of Band Management Component migration to version 7.1”
on page 157.

See “Manually migrating Out of Band Management Component to version 7.1”
on page 158.

To move the Intel AMT database

1 On the old Notification Server computer, open Microsoft SQL Manager Studio.

2 In the left pane, expand the Databases folder.

3 In the left pane, under Databases, right-click on the Intel AMT database.

4 In the right-click menu, click Tasks > Detach.

To restore the Intel AMT database

1 On the 7.1 computer, open Microsoft SQL Manager Studio.

2 In the left pane, expand the Databases folder.

3 In the left pane, right-click the Databases.

4 In the right-click menu, click Tasks > Attach.

Configuring the Intel AMT database
After you move the Intel AMT database to your new environment, you must
validate it and make sure that it operates correctly. In addition, make sure that
the correct address of the SQL Server and SQL Login is specified in the Out of
Band Management Component settings.

Migrating Out of Band Management Component
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See “Migrating the Intel AMT database” on page 160.

See “About Out of Band Management Component migration to version 7.1”
on page 157.

See “Manually migrating Out of Band Management Component to version 7.1”
on page 158.

To configure the Intel AMT database

1 In the Symantec Management Console, on the Home menu, click Remote
Management > Out of Band Management.

2 In the left pane, under ConfigureAdditionalOOBSiteServer, click Configure
and Assign OOB Site Server.

3 Click Site Management > Settings > OOB Service > OOB Service Settings.

4 Under Global OOB site service installation settings, edit SQL server. You
must specify the SQL Server name where the Intel AMT database is now
located.

If you have used the default Intel AMT database name (NS_Database_Name_AMT)
on your previous Notification Server and transferred it to a 7.1 computer database
with the same name, Out of Band Management Component 7.1 automatically
accepts the previous database. In some cases, before the installation of out-of-band
site servers, you need to modify out-of-band site server settings with your custom
database name.

For more information, see the topics about configuring the out-of-band site server
installation settings in the Out of BandManagement Component Implementation
Guide.

Fine-tuningOut of BandManagement Component 7.1
after the migration

You can start to fine-tune Out of Band Management Component 7.1 after you
complete the steps for manual migration.

See “Manually migrating Out of Band Management Component to version 7.1”
on page 158.

You might experience the following errors on different pages:

■ Configuration saved but cannot be applied. Please check that

currently selected Intel SCS is installed and running in Service

Location page
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After you have configured the Intel AMT database, you can receive this error
on the page.
This message is an expected issue and it means that you do not have an Out
of Band Management Component site server installed. It needs to apply the
SQL settings to the out-of-band site server. You need to install an out-of-band
site server.
For more information, see the topics about installing an out-of-band site server
in the Out of BandManagement Component Implmentation Guide.

■ One or more of Intel® AMT Setup and Configuration Servers in

outdated. You have to upgrade it by turning on the 'Out of Band

Service Agent' policy. If you don't want to use this server, you

can delete it

When you try to view configured Intel AMT computers on the Intel AMT
Computers page, you may see this error message.
You can remove all site servers from the current computer. The other
workaround is to remove an entry inside the URL from
dbo.Inv_OOB_Site_Server_State and also dbo.csto_servers. It is a common
resolution in case your old Notification Server is not functional. You also need
to verify the out-of-band site server installation by checking the general
settings for the Intel AMT computers.

■ Obsolete Intel AMT Setup and Configuration Services
During the migration of Out of Band Management Component 6.2 to version
7.1, an exception about obsolete site servers on the Out of Band Management
Component portal page comes up. It means that data about the 6.2 Notification
Server persists on the Symantec Management Platform 7.1 Out of Band
Management Component site server database. If you click on the exception
link, it opens an Obsolete IntelAMTSetupandConfigurationServices page.
On this page, you can choose to delete the obsolete site server or upgrade it.

■ Active Directory integration reinitiation
Active Directory integration cannot be migrated during the migration from
the Out of Band Management Component 6.2 to version 7.1. You must manually
reinitiate the Active Directory integration on the ConfigureGeneral Settings
page in the Out of Band Management Component portal.

■ Secure TLS profiles
If you previously used Secure TLS profiles, then you need to request a new
security certificate for the new 7.1 Symantec Management Platform.
For more information, see the topics about configuring TLS in theOut of Band
Management Component Implementation Guide.

Migrating Out of Band Management Component
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Migrating CMDB Solution

This chapter includes the following topics:

■ Migrating to CMDB Solution 7.1

Migrating to CMDB Solution 7.1
You perform the product migration from 6.x to 7.1 according to the migration
scenario for Asset Management Solution and IT Management Suite.

See “About migrating Asset Management Solution” on page 171.

See “Migrating from Notification Server 6.x to Symantec Management Platform
7.1” on page 34.

See “About data migration” on page 49.

See “About the Symantec Notification Server Migration Wizard” on page 50.
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Migrating Barcode Solution

This chapter includes the following topics:

■ About migrating Barcode Solution

■ Manually migrating your Barcode Solution files and settings

■ Synchronizing data

■ Verifying asset data

■ Backing up the Barcode Solution default synchronization profile

■ Restoring the Barcode Solution default synchronization profile

About migrating Barcode Solution
In addition to using the migration wizard to migrate Barcode Solution, you must
complete some manual steps.

See “Manually migrating your Barcode Solution files and settings” on page 166.

Before you migrate your data, you need to take the following actions:

■ Ensure that handheld devices have uploaded their data to the previous
Notification Server computer.
See “Synchronizing data” on page 167.

■ Ensure that all batches in the upload verification section have been processed.
See “Verifying asset data” on page 168.

■ Back up the default synchronization profile.
See “Backing up the Barcode Solution default synchronization profile”
on page 169.
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Manually migrating your Barcode Solution files and
settings

The majority of your Barcode Solution data is migrated when you migrate your
Configuration Management Database (CMDB) using the migration wizard. However
you must first manually migrate your default synchronization profile settings.
To migrate these settings you use the console to export them into an XML file.
You then import this XML file after you install your new Symantec Management
Platform. In addition, Symantec recommends that you finish synchronizing all
your data from the handheld devices. Also, ensure that you verify your asset data
before you load it into the CMDB by processing all batches.

See “About migrating Barcode Solution” on page 165.

Table 14-1 Process for manually migrating your Barcode Solution files and
settings

DescriptionActionStep

You must finish synchronizing all your
data from the handheld device to the
Barcode Solution before you migrate.
Failure to do this means you may lose
data. You cannot upload the data from
the old version of Barcoder to the new
version Barcode Solution. You have to
upload to the old version of the Barcode
Solution first and then migrate the data
over again.

See “Synchronizing data” on page 167.

Handheld devices have uploaded
their data to the previous
Notification Server computer.

Step 1

All batches in the upload verification
section have been processed.

See “Verifying asset data” on page 168.

All batches in the upload
verification section have been
processed.

Step 2

Use the Symantec Management Console
to export your default synchronization
profile settings into an XML file. Store
this file on a neutral storage location.

See “Backing up the Barcode Solution
default synchronization profile”
on page 169.

Back up the Barcode Solution
default synchronization profile.

Step 3
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Table 14-1 Process for manually migrating your Barcode Solution files and
settings (continued)

DescriptionActionStep

Use the Symantec Notification Server
Migration Wizard to export and import
your data.

See “Exporting Notification Server 6.x
data to a data store file ” on page 57.

See “Importing Notification Server 6.x
data from a data store file” on page 59.

Warning: Since Barcode Solution relies
on CMDB Solution, the CMDB data must
be imported at the same time or before
you import your barcode data. For this
reason ensure that you have CMDB
Solution selected in the Exporter
Configuration page of the Symantec
Notification Server Migration Wizard
.

Use the Symantec Notification
Server Migration Wizard to export
and import your data.

Step 4

Use the Symantec Management Console
to import your default synchronization
profile settings from an XML file.

See “Restoring the Barcode Solution
default synchronization profile”
on page 169.

Restore the Barcode Solution
default synchronization profile
file

Step 5

Synchronizing data
Any data that is specified in the user profile and the Manage Handheld Device
page is uploaded to the barcode device in the initial synchronization. It may involve
the transfer of a significant amount of data. Ensure a good connection (either
wireless or through a cradle) with the Notification Server computer.

This task is part of the process for manually migrating your Barcode Solution
files settings. After you complete this task, you can complete the rest of the process.

See “Manually migrating your Barcode Solution files and settings” on page 166.
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To synchronize data

1 Make sure that the barcode device has a connection to the host computer,
either wireless or through a synchronization cradle.

2 On the barcode device, click Start >Programs>SymantecAltirisBarcoder.

3 Select Synchronize from the menu option.

4 Enter your security credentials and click Login.

Your password and user name are cached for an hour on the handheld device.
If you do not use it for over an hour, you must reenter your security
credentials. Closing the application clears the cached credentials; they need
to be reentered on launching the application again.

5 Select the synchronization profile to use, and click Next.

6 Choose one of the synchronization options, and click Sync.

Verifying asset data
By default, you need to verify your asset data before you load it into the
Configuration Management Database. You verify asset data from the Upload
Verification page.

This task is part of the process for manually migrating your Barcode Solution
files settings. After you complete this task, you can complete the rest of the process.

See “Manually migrating your Barcode Solution files and settings” on page 166.

To verify asset data

1 In the Altiris Console 6.5, on the Home menu, click Tasks.

2 In the left pane, click Tasks > Barcode > Manage Changes > Upload
Verification.

3 In the Batch Summary Table in the right pane, select the batch of uploaded
data that you want to verify.

4 Click Batch Details.

5 In the BatchDetails dialog box, select a resource and click ResourceDetails
to view its changed details.

6 Click Apply, and close the Batch Details dialog box.

7 In the Batch Summary Table select the relevant batch and click Apply to
save changes.
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Backing up the Barcode Solution default
synchronization profile

Before you decommission your previous Notification Server computer, back up
your Barcode Solution default synchronization profile to a neutral storage location.

Name the clone default profile Default profile 6.x or similar. Since the default
profile already exists on 7.1, renaming the cloned default profile ensures that it
can be identified differently in the 7.1 environment. By being uniquely identifiable,
the cloned default profile is not overwritten.

This task is part of the process for manually migrating your Barcode Solution
files settings. After you complete this task, you can complete the rest of the process.

See “Manually migrating your Barcode Solution files and settings” on page 166.

To back up the Barcode Solution default synchronization profile:

1 On your previous Notification Server computer, in the Altiris Console 6.5 ,
select the Configuration tab.

2 In the left pane, expand Configuration > Solutions Settings > Assets and
Inventory > Barcode Solution > Synchronization Profile > Default.

3 Right-click Default, and click Export.

4 Save the Default.xml file to a neutral storage location.

5 Clone the default profile to ensure that it can be identified in the 7.1
environment.

Restoring the Barcode Solution default
synchronization profile

After you install Symantec Management Platform and have run the migration
wizard, you can restore your Barcode Solution default synchronization profile.

This task is part of the process for manually migrating your Barcode Solution
files settings. After you complete this task, you can complete the rest of the process.

See “Manually migrating your Barcode Solution files and settings” on page 166.

To restore the Barcode Solution default synchronization profile:

1 On your new Notification Server computer, in the Symantec Management
Console, go to Home > Service and Asset Management > Barcode.

2 In the left pane, expand Barcode Solution > Synchronization Profiles >
Default.
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3 Right-click the Synchronization Profiles folder, and click Import.

4 Browse to the default synchronization file.

5 Click Open.
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Migrating Asset
Management Solution

This chapter includes the following topics:

■ About migrating Asset Management Solution

■ About data migration special cases

■ Migrating legacy software license items

About migrating Asset Management Solution
You perform the product migration from Asset Management Solution 6.x to version
7.1 according to the migration scenario for IT Management Suite.

See “Migrating from Notification Server 6.x to Symantec Management Platform
7.1” on page 34.

See “About data migration” on page 49.

After you migrate your data from a Notification Server 6.x environment, you must
do the following:

■ Review and reconfigure the asset-specific security access rights because they
are not copied to the corresponding 7.1 roles automatically.
See “About data migration special cases” on page 172.

■ Migrate the legacy software license items.
See “Migrating legacy software license items” on page 173.
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About data migration special cases
When you migrate from Notification Server 6.x, there are some data migration
special cases that you need to know about.

See “About migrating Asset Management Solution” on page 171.

Table 15-1 About data migration special cases

DescriptionData

Legacy Receiving Types are not upgraded.

If any existing Legacy Receiving Type is found, the Legacy Receiving Types Check exporter
fails and gives a warning message.

Pre-6.5 Legacy
Receiving Types

The following CMDB Solution schedules become tasks and are accessible from Jobs/Taskspage:

■ Assign Computer's Ownership to be the Primary User

■ Clean Ownership

■ Duplicate Computer Merge

■ Duplicate User Merge

■ Inventory Clean Up

■ Inventory To Asset Synchronization

■ Resource Merge Rule

■ Update Network Resource Location

The following Asset Management Solution schedules become tasks and are accessible from
Jobs/Tasks page:

■ Depreciable Items Cost Evaluation

■ Software License Evaluation

The Configuration
Items that are
converted to tasks

The 6.x Notification Policies are moved to the LegacyNotificationPolicies folder under Settings
> Notification Server. Existing folder structure is retained.

Note that Asset Management Solution and CMDB Solution do not upgrade the Task/Job and
Message Action Policy items because the Task Management Solution owns them.

Notification
Policies

If the accounting period is configured in 6.5, then it is also regenerated in 7.1 based on the
accounting period item details.

Accounting Period

6.5 data class is not able to record a situation where all owners are removed from an asset. A
new upgrade logic is able to populate the correct tables even when all the ownership information
is deleted.

Cost Model
Upgrade logic

All Asset 6.5 roles are renamed to Role Name+(legacy). You must review their security access
rights and make appropriate changes if necessary.

Asset Roles
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Migrating legacy software license items
After you complete the task of migrating data from a Notification Server 6.x
environment, you must migrate legacy software license items to Symantec
Management Platform 7.1. Asset Management Solution 7.1 includes a wizard that
helps you go through this process.

See “About migrating Asset Management Solution” on page 171.

To migrate legacy software license items

1 Complete the steps to migrate data from Notification Server 6.x.

2 Make sure that your MigrateLegacySoftwareLicenses settings are correct.

For more information, see the topics about configuring settings for migrating
legacy software licenses in the Asset Management Suite Help.

3 Make sure that the Software Catalog is populated and current. You can use
manual entry, run the Software Discovery task, or run an inventory policy.

For more information, see the topics about populating the Software Catalog
in the Symantec Management Platform Help.

4 In the Symantec Management Console, on the Home menu, click Serviceand
Asset Management > Software Licensing.

5 In the right pane, in the Legacy Licenses Requiring Migration Web part,
click Legacy License Count: n.

The Legacy License Count n indicates the number of legacy software license
items that need to be migrated.

6 In the List of legacy 6.5 Software Licenses to be migrated list, right-click a
license that you want to migrate, and then click Migrate Legacy Software
License.

Note that you migrate each software license one by one and it takes two to
three minutes to migrate each license in case you have all the software
purchase and software product data available in the Configuration
Management Database (CMDB).

7 In the Migrate Legacy Software License wizard, follow the on-screen
instructions for each software license item that you need to migrate.

8 Click Finish.

After a software license item is migrated, it appears in the Software License
list. The LegacyLicenseCount indicates the number of software license items
that still need to be migrated. Note that you must right-click in the Web part,
and then click Refresh to display the changes.
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Migrating Workflow
Solution

This chapter includes the following topics:

■ About migrating Workflow Solution

■ Upgrading Workflow processes

■ Determining a project's persistence settings

■ Versioning a process

About migrating Workflow Solution
You perform the Workflow Solution data migration from 6.x to 7.1 according to
the migration scenario for IT Management Suite.

See “Migrating from Notification Server 6.x to Symantec Management Platform
7.1” on page 34.

See “About data migration” on page 49.

After you migrate your data, you must upgrade your Workflow processes.

See “Upgrading Workflow processes” on page 175.

Upgrading Workflow processes
If you already have a Workflow Server running on a Symantec Management
Platform computer, installing Workflow does not upgrade Workflow Server.
Upgrading Workflow Server would break running processes. Instead, the Workflow
installation adds a message in the Symantec Management Console that the
Workflow Server should be upgraded manually.
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Symantec recommends that you schedule a service stop, upgrade Workflow Server,
test the published processes, and then resume the service.

Warning: You can disrupt currently-running processes by installing Workflow if
you do not keep the same persistence settings. Ideally, you should use the same
persistence settings for Workflow that you used for the earlier versions of
Workflow. During installation you can set the persistence setting for Workflow.
If the persistence settings in the earlier versions of Workflow are not supported
in the current version of Workflow, version your projects so that you do not
overwrite the currently-running processes.

See “Determining a project's persistence settings” on page 177.

See “Versioning a process” on page 179.

Table 16-1 Process for upgrading Workflow processes

DescriptionActionStep

Create packages for all your projects, and store these packages on a safe
directory.

For more information on creating a project package, see the Symantec
Workflow Solution User Guide.

Back up your projectsStep 1

Create a backup of your Ensemble database. Store the database backup on
a safe directory.

Back up the Ensemble
database

Step 2

When you install Workflow on your testing computer, make sure that you
do the following:

■ Use the same Workflow persistence settings as in your earlier version
of Workflow configuration.

See “Determining a project's persistence settings” on page 177.

If you use the persistence settings that are not supported by Workflow,
version your projects.

See “Versioning a process” on page 179.

■ Set Workflow to have access to a Symantec Management Platform server
(Notification Server).

Install Workflow on a
testing computer

Step 3

Open each project and make the necessary changes for it to be compatible
with Workflow and the Symantec Management Platform. Change any old
Notification Server components and settings.

If possible use the same persistence setting for your Workflow projects as
you used for your earlier versions of Workflow projects.

See “Determining a project's persistence settings” on page 177.

Revise your projectsStep 4
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Table 16-1 Process for upgrading Workflow processes (continued)

DescriptionActionStep

Publish the revised projects to the Workflow testing computer.

For more information on publishing projects, see the Symantec Workflow
Solution User Guide.

Publish revised projects
to Workflow testing
computer

Step 5

Conduct thorough tests to ensure that your projects work properly in a
Workflow and Symantec Management Platform environment. If you
encounter any problems, fix the project and republish.

Warning: Publishing untested processes in a production environment can
cause significant problems. Symantec recommends that you test all
processes thoroughly, before you publish them to a production environment.

Test revised projectsStep 6

When you install Workflow on your production computer, make sure that
you use the same persistence settings as in your earlier version of
configuration.

See “Determining a project's persistence settings” on page 177.

Install Workflow on a
production computer

Step 7

Publish all of your revised projects to the Workflow production computer.

For more information on publishing projects, see the Symantec Workflow
Solution User Guide.

Publish revised projects
to production computer

Step 8

Determining a project's persistence settings
Persistence refers to how a running process is stored in memory to improve the
performance of Workflow. Persistence is set at the project level, but most projects
use the default setting that is set when Workflow is installed (almost always
file-based). For the earlier versions of Workflow projects, the persistence settings
are configured under the project's Publishing data tab in the WorkQueueService
Name property.

See “Upgrading Workflow processes” on page 175.

Table 16-2 Persistence options

DescriptionPersistence option

Uses Process Manager SQL database settings. The
workflow project uses the Ensemble database for
persistence.

There is no Workflow equivalent of this setting.

LogicBase.Components.Ensemble.WSWorkQueue

177Migrating Workflow Solution
Determining a project's persistence settings



Table 16-2 Persistence options (continued)

DescriptionPersistence option

Uses Exchange for persistence. This is the most common
persistence setting. This setting uses either file-based or
SQL-based persistence over Exchange.

For information on determining whether this setting uses
file-based or SQL-based persistence, see the following
section:

The Workflow equivalent of this is Exchange (file-based)
or SQL-based persistence. You can set this when you
install Workflow.

LogicBase.Components.Default.ExchangeAdapters.
LogicBaseExchangeWorkQueue

Uses direct file-based persistence.

There is no Workflow equivalent of this setting.

LogicBase.Core.Workflow.FileSystemAdapters.
FileSystemWorkQueue

Uses internal Workflow memory.

There is no Workflow equivalent of this setting.

LogicBase.Core.Models.Workflow.InMemoryWorkQueue

Uses direct SQL-based persistence.

There is no Workflow equivalent of this setting.

LogicBase.Core.Workflow.SQLServerAdapters.
SQLServerWorkQueue

Your projects are probably set to use
LogicBase.Components.Default.ExchangeAdapters.LogicBaseExchangeWorkQueue.
In this case, you can determine whether the exchange is set to file-based or
SQL-based persistence in the Configuration and Logging Tool.

If any of your projects use a persistence setting other than
LogicBase.Components.Default.ExchangeAdapters.LogicBaseExchangeWorkQueue,
you should version them to avoid losing process data.

See “Versioning a process” on page 179.

To determine the default persistence setting in the Workflow Explorer

1 Open the Configuration and Logging Tool.

Click Start>Programs>Symantec>WorkflowDesigner>Tools>Workflow
Explorer.

2 Click the SymQ Configuration tab.
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3 In the left pane, click SymQ_Local_Defaults.

4 In the right pane, double-click local.workflow-.

If the Deliver To Queue property is set to LBME.Workflow (with a prefix),
the default persistence setting is file-based.

If the Deliver To Queue property is set to workflowsqlexchange (with a
prefix), the default persistence setting is SQL-based.

Versioning a process
If you have an earlier version of Workflow project that uses a persistence setting
that is not supported in the current version of Workflow, version the project so
that you do not lose any process data (such as tasks). Process versioning is handled
in IIS. When you publish a workflow project, a new virtual directory is created in
IIS, unless one of the same name already exists. If an identical one exists, the new
process overwrites the process that is already published there. You must create
a new virtual directory to contain the updated process while the old process runs
in its virtual directory. The following steps assume that you have a currently
running process that you replace with an updated version.

Versioning works only with the “Publish Application to Server” publishing option.
Because the other publishing options do not let you set the virtual directory name,
you cannot use versioning with them.

See “Upgrading Workflow processes” on page 175.

See “Determining a project's persistence settings” on page 177.

To version a process

1 In Workflow Designer, when you are ready to publish your updated process,
click File > Deploy Project > Publish Project.

2 In the VirtualDirectory field, add the updated version number to the end of
the name of the virtual directory.

For example, if the old process is in a virtual directory called “PurchaseOrder”,
call the new virtual directory “PurchaseOrder2.0.”

Warning: If you publish without changing the name of the virtual directory,
your new process completely replaces the old one and breaks any of its current
instances.

3 Complete the publishing process as normal.
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4 Repoint the invocation links to the virtual directory of the updated process.

In other words, whatever invoked the old process (such as Process Manager
service catalog item or external link) must be repointed to the new virtual
directory that contains the process.

5 After the old process has finished all activity, delete its virtual directory.

Migrating Workflow Solution
Versioning a process

180



Migrating Inventory Pack
for Servers Solution

This chapter includes the following topics:

■ Migrating to Inventory Pack for Servers 7.1

Migrating to Inventory Pack for Servers 7.1
You perform the product migration from 6.x to 7.1 according to the migration
scenario for Inventory Solution and IT Management Suite.

See “Before you migrate to Inventory Solution 7.1” on page 69.

See “Migrating from Notification Server 6.x to Symantec Management Platform
7.1” on page 34.

See “About data migration” on page 49.

See “About the Symantec Notification Server Migration Wizard” on page 50.
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Migrating Power Scheme
Solution

This chapter includes the following topics:

■ About migrating Power Scheme

About migrating Power Scheme
No manual solution-specific migration steps are required. The solution-specific
data is migrated when you migrate the product data according to the process that
is defined in the Migrating Symantec Management Platform chapter.

You should verify and validate that the solution data and settings have been
migrated correctly.

See “Migrating from Notification Server 6.x to Symantec Management Platform
7.1” on page 34.

See “About data migration” on page 49.
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Migrating Recovery Solution

This chapter includes the following topics:

■ About migrating Recovery Solution

■ Further information about Recovery Solution

About migrating Recovery Solution
Recovery Solution is not a part of IT Management Suite 7.1.

Do not upgrade from 6.x to IT Management Suite 7.1 if you want to keep the
Recovery Solution features.

Until Recovery Solution 7.1 is released, you must run a dual environment if you
want to use both IT Management Suite 7.1 and Recovery Solution.

Further information about Recovery Solution
For more information about new versions and upgrades, visit the support page
for Recovery Solution.You can also contact the Symantec Business Sales team.
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Migrating Mobile
Management Solution

This chapter includes the following topics:

■ About migrating Mobile Management Solution

■ Further information about Mobile Management Solution

About migrating Mobile Management Solution
Mobile Management Solution is not a part of IT Management Suite 7.1.

Do not upgrade from 6.x to IT Management Suite 7.1 if you want to keep the Mobile
Management Solution features.

Until Mobile Management Solution 7.1 is released, you must run a dual
environment to use both IT Management Suite 7.1 and Mobile Management
Solution.

Further information about Mobile Management
Solution

For more information about new versions and upgrades, visit the support page
for Mobile Management Solution.You can also contact the Symantec Business
Sales team.

20Chapter

http://www.symantec.com/business/support/index?page=landing&key=58302
http://www.symantec.com/business/contact_sales.jsp
http://www.symantec.com/business/contact_sales.jsp


Migrating Mobile Management Solution
Further information about Mobile Management Solution

188



Migrating Wise Connector
Solution

This chapter includes the following topics:

■ About migrating Wise Connector

About migrating Wise Connector
You cannot upgrade from a previous version of Wise Connector. Upgrading is not
supported. You must install and use a clean installation of Wise Connector.

For more information, see Wise Connector User Guide.
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Migrating from Helddesk
Solution

This chapter includes the following topics:

■ About migrating from Helpdesk Solution 6.x

About migrating from Helpdesk Solution 6.x
Symantec ServiceDesk 7.1 replaces the functionality of Helpdesk Solution 6.5 and
earlier. ServiceDesk does not upgrade or install over Helpdesk Solution because
ServiceDesk is installed on a different server and uses different databases. During
the migration process you upgrade Altiris 6.x to Symantec Management Platform
7.1 and install Symantec ServiceDesk 7.1. Helpdesk Solution data can be migrated
with ServiceDesk application software.

For more information, see ServiceDesk Implementation Guide.
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Migrating Virtual Machine
Management Solution

This chapter includes the following topics:

■ About migrating Virtual Machine Management data

About migrating Virtual Machine Management data
Virtual Machine Management is not a component of ITMS 6.x. Deployment Solution
6.9 has a Virtual Machine Management function but it has been taken out of
Deployment Solution in the 7.1 release. This function is therefore not migrated.
Virtual Machine Management replaces this functionality in 7.1.
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